
  
  

 

 Workshop Overview  
Your manual is divided into two sections. Hands on exercises are located in the first section. 
PowerPoint slides of presentations can be found in the second half of the manual. The 
workshop is broken up into five modules. Each module covers a specific topic and may have 
one or more detailed presentations, short lightning talk presentations, demos and hands-on 
independent exercises. The table below references each module, presentation and exercise 
covered in this three-day workshop.  
 

Module Presentation Topic Exercise Type 

Module 1: 

Introduction to GIS 

1-1 - Introduction to GIS 
        Introduction to ArcGIS 

Follow the Instructor 
Exercise 1a - Hands on  

Module 2:  

All about Data 

2-1 - Where to Find Data (Lightning Talk) 
2-2 - Data Types 
2-3 - Understanding Spatial Reference 

Exercise 2a – Hands on 
 
Exercise 2b – Hands on 

Module 3:  

Working with Tables 

3-1 - Introduction to Tables 
3-2 – Working with Tables 
3-3 – Selections & Queries 

Ex 3a - Hands on 
Ex 3b - Hands on 
Ex 3c - Hands on 

Module 4:  

Map Production 

4-1 – Layer Symbology 
4-2 - Adding Text & Graphics 
4-3 - Creating a Cartographic Output 
4-4 - Data Driven Pages (Lightning Talk) 

Ex 4a - Hands On 
Ex 4b - Hands on 
Ex 4c - Hands on 
Reference Exercise 6c 

Module 5:  

Data Manipulation 

5-1 - Georeferencing (Lightning Talk) 
5-2 – Digitizing & Editing 
5-3 - Working with ArcToolbox 

Reference Exercise 6f 
Ex 5a - Hands on 
Ex 5b - Hands on 

Module 6:  

GIS Hodgepodge 

6-1 - Adding XY Coordinates to ArcMap  
6-2 - Mind Over Metadata 
6-3 - Google Earth (KML) 
6-4 - ArcGIS Online 

Reference Exercise 6a 
Reference Exercise 6b 
Reference Exercise 6e 
Reference Exercise 6d 
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Exercise 1a: ArcMap Basics 
This first hands-on exercise is designed to introduce you to ArcMap. You will open and explore 
a premade map document (.mxd), familiarize yourself with the graphical user interface (GUI) 
and interact with toolbars, tools, data layers, data frames and the Table of Contents. We will 
explore much of what you do in more detail in later exercises so don’t get hung up on details. 
 
 

Getting Started: Opening ArcMap 
To start ArcMap, double click on the ArcMap shortcut on the desktop. If there is 
no shortcut, then you can access ArcMap by clicking on Start>All 
Programs>ArcGIS>ArcMap 10.5. It may take ArcMap a minute to open so be 
patient.  

Æ Open a New Map 

When the Getting Started window pops up, click on New Maps under the “Open existing map 
or make new map using a template” heading on the left.  
 
Under My Templates, select 
Blank Map. Click OK at the 
bottom of the window to open 
a blank map in ArcMap. 
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The ArcMap Interface 
The ArcMap Graphical User Interface (GUI) will look something like what you see below. If it 
looks slightly different, it’s because additional functionality (toolbars, etc.) may have been turned 
on or enabled by a previous user. When ArcMap is closed, it “remembers” these settings and 
restores them when it is reopened.  

Æ Exploring the GUI 

As you hold the mouse pointer over a button, a description of its function will appear in a small 
box below it. Take a few minutes to try out this technique. As you mouse over some of the icons 
and buttons, try to familiarize yourself with what each one does.   
 
Some of the major “areas” of the ArcMap interface are labeled below. 
 
 
 
 
 
 
 
 
 
 
 
 
  

Menu Bar 
Map Display Scale 

Title Bar 

Standard 
Toolbar 

Tools Toolbar 

Table of 
Contents 

Display 
Area 

Table of 
Contents 
Display 
Options 

Data 
View Layout 

View 

Refresh 

Note: you may need to maximize 
your ArcMap window so that it 
covers your computer screen. 
There is a lot to the ArcMap GUI. 
Click on the Maximize icon  in 
the upper right corner of ArcMap 
to increase the window size.  
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Æ Working with Toolbars 

Toolbars in ArcMap are sets of tools that perform similar types of functions. The Tools toolbar 
includes tools for navigating around the map display and tools for performing basic query 
functions. All toolbars can be moved around the ArcMap interface and can be “floating” windows 
or docked to the left, right, top or bottom of the GUI. The position of toolbars can be manipulated 
by clicking on the “handle” on its far left side and dragging it to a new location.  
 
- Try moving the Tools toolbar around the ArcMap window. You can even drag it to a 

location on your desktop that’s completely off the ArcMap GUI, just try not to lose it! 
 

 
 

 
 
 

 

Toolbar 
“handle” 
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- After you have finished experimenting with new toolbar locations, move the Tools 
toolbar back to its original position.  
 

- ArcMap has many toolbars that can easily be added or removed from the GUI. To 
add a toolbar, click on the Customize drop-down menu and then move the mouse to 
the Toolbars option. A list of available toolbars will appear. Examine the list and 
locate the toolbar titled Draw. Click on it to add it to the GUI.  

 

 
 

 
 
 

- It will likely be added to the GUI as a floating toolbar. Click on the gray title bar and 
drag it to the bottom left corner of the ArcMap GUI, just above the status bar. This is 
a common docking position for the Draw toolbar.  
 

 

  
 
 

- Repeat the process to add a few other toolbars to the ArcMap GUI. Try moving them 
around the interface and docking them in different positions. To remove a toolbar, 
uncheck the toolbar name under the Customize>Toolbars heading. If the toolbar is 
turned on it will have a check next to it. Once you are satisfied with the process, turn 
off all toolbars except the Standard, Tools and Draw toolbars.  
 

   
  

Tip: You can access a shortcut to 
the toolbar list by right-clicking on 
any toolbar or grey areas of the 
ArcMap GUI. Give it a try! 
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Opening a Previously Created Map Document 
Now that you are familiar with the ArcMap GUI, let’s explore some GIS data. In this step, you 
will open a previously created ArcMap document (.mxd) that references several data sets 
including Connecticut towns and major waterways. Remember, an ArcMap document does not 
contain the data itself, but rather includes layers that point to data sets stored on your computer.  

Æ Open a Project File (.mxd) within ArcMap 

-  In ArcMap, click on the File dropdown menu and select Open from the list of 
choices. This will open a window in which you are able to navigate to any location on 
your computer.  

 
- Navigate to the following folder: 

 
C:\GISEd10\Projects 

 
 
 
 
 

- Select the map file named Connecticut.mxd and click the Open button. Double-
clicking on the file name will also open it. If ArcMap asks you if you would like to save 
changes to your “Untitled” map, select No.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tip: In a pathname, folders are 
separated by backslashes. So to locate 
the project folder, first find your C: drive, 
then locate your GISEd10 folder and 
finally click on the Projects folder.  Drive    Folder     Folder 

Data Frame 

Project Name 

Click in box 
to toggle a 
layer on/off 
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The Map Document contains a single Data Frame named “Connecticut Base Map” that 
includes four data layers – Rivers (lines), Rivers (polygons), Towns, and State Boundary. 
 
You can turn each layer on/off by clicking in the box next to the layer name. When there is a 
check in the box, the layer is turned “on” and will be displayed in the display area.  
 

- Make Rivers (lines) and Rivers (polygons) visible by clicking in the box to the left 
of their names. All four layers should now be visible on the map.  

 
Note that ArcMap draws the layers from the bottom of the Table of Contents to the top. This 
means that the two Rivers layers are drawn on top of the Towns and State Boundary layers. 
You can change the drawing order by dragging a layer up or down to reposition it in the Table 
of Contents.  
 

- Click on the State Boundary layer with the left mouse button and while holding the 
button down, drag the State Boundary layer up to the top of the layer list, just below 
the Connecticut Base Map Data Frame name. When you release the mouse button 
the Display Area will redraw.  
 

What happens to your other three data layers? 

 
 

- Click in the box next to State Boundary to uncheck it and turn it off. The other three 
layers should now be visible. You were unable to see them because the State 
Boundary layer was turned on and positioned above them in the Table of 
Contents. Because the State Boundary layer also has a solid fill, meaning the 
inside of the polygon is a solid color, you could not “see through” the layer so it 
obscured all of the other layers below it. We’ll talk more about fills and colors in 
Module 3. 
 

- Click in the box next 
to State Boundary to 
turn it back on. 

 
- Now drag the State 

Boundary layer back 
to the bottom of the 
Table of Contents 
so that all of the other 
layers will be 
displayed on your 
map. 

 
 
 
 
 
  



Module 1 
Exercise 1a: ArcMap Basics 

 Ex 1a: Page  7 
  

 

Using the Tools Toolbar to Navigate Within Data View 

Æ The Tools Toolbar in Detail 

Let’s start exploring some GIS data! The Tools Toolbar has eight tools to help navigate. It also 
has several other tools to help you with basic functions like selecting and identifying features, 
measuring distance and area, and finding XY coordinates on your map. Each tool is briefly 
described below.  

 

Zoom In - Allows you to zoom in to a geographic window by clicking a point or dragging a box. 

Zoom Out - Allows you to zoom out from a geographic window by clicking a point or dragging a 
box. 

Pan - Allows you to pan the data frame. 

Full Extent - Allows you to zoom to the full extent of your map. 

Fixed Zoom In - Allows you to zoom in on the center of your data frame. 

Fixed Zoom Out - Allows you to zoom out on the center of your data frame. 

Back an Extent - Allows you to go back to the previous extent. 

Forward an Extent - Allows you to go forward to the next extent. 

Select Features - Allows you to select features graphically, by clicking or dragging a box around 
them.  

Clear Selection - Unselects all of the currently selected features in the active data frame. 

Select Elements - Allows you to select, resize, and move text, graphics, and other objects 

Identify - Identifies the geographic feature or place on which you click. 

Hyperlink - Triggers hyperlinks from features. 

HTML pop-up - Triggers HTML pop-ups from features. 

Measure - Measures distances and areas on your map. 

Find - Finds features in the map. 

Find Route - Allows you to calculate point-to-point routes and driving directions. 

Go to XY Location - Allows you to type an x,y location and navigate to it. 

Time Slider - Opens a time slider window for working with time-aware layers and tables. 

Create Viewer Window - Creates a new viewer window by dragging a rectangle. 

N
av

ig
at

io
n 

To
ol

s 
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Take several minutes and try using each of the first 8 navigation tools on the Tools Toolbar to 
see how each one works. If you get stuck or lose your place, you can always click on the Earth 
icon  on the toolbar. This is the Full Extent tool. It will restore the map display to its full 
extent. We’ll get to some of the other tools in a minute.  
 

- Go ahead and zoom way in. You will discover that the town names appear. These 
were set to turn on when the map scale gets to 1:250,000 or larger and to turn off at 
smaller scales. You will learn how to set these type of scale dependencies in another 
exercise. For now, just get used to how they function. 
 

- A map scale is the 
relationship between the 
distance on the map and 
the distance on the ground.  
You can explicitly set the 
display scale of your map 
by typing a value into the 
scale window on the 
Standard Toolbar. Try 
typing in something like “1 
inch = 1000ft.” You can 
also select from a set of 
predefined scales. This set 
of scales can be 
customized to include a 
user defined scale. Give it a try. 

 

Æ Using the Mouse to Pan and Zoom 

If your mouse has a scroll wheel, you can use it to zoom in and out and to pan around the 
display area. Rotate the wheel forward to zoom out and backwards to zoom in. Hold the 
wheel down and then move the mouse to pan around the display area. This can be a real time 
saver! 
 
 
 

 
  

Zoom In 

Hold down 
to pan 

Zoom Out 
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Adding Data to ArcMap 

Æ Adding a Shapefile to ArcMap 

There are a number of ways to add geospatial data to an ArcMap session. In this step you will 
add a major highway layer to the Table of Contents using the Add Data button on the 
Standard Toolbar. The layer you add will reference a shapefile stored on disk. 
 

- Click on the Add Data button on the Standard Toolbar. This will open the Add Data 
window.  

 

 
 

- Use the Look in: area of the window to navigate to the following folder: 
 

 
C:\GISED10\Shapes 

 
 
 
-   Locate the 
ROADS.shp layer and 
click on it.  
 
-  Click Add at the 
bottom of the window 
to add the layer to 
ArcMap.  
  

Note: If this is the first time ArcMap has 
been used on your computer, you will 
need to “map” the local drive. To do this, 

click on the “Connect to Folder”  
icon and select My Computer, Local 
Disk (C:). Once you do this, the C: drive 
will always show up under the Look In 
drop list.  

Drive Folder      Sub-folder 
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The ROADS layer will be added to ArcMap’s Table of Contents. A randomly selected color will 
be assigned to the layer to symbolize the road features. You will learn how to create custom 
colors and symbols in Module 3.  
 

 
 
 
 
  

Tip: You can also access the Add Data window by 
right clicking on the Data Frame name and selecting 
Add Data from the menu that appears. 
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Æ Opening a Feature Attribute Table 

Vector layers consist of points, lines or polygons. Generally, each feature in the layer has a 
corresponding record in a feature attribute table. In this step, you will learn how to access the 
feature attribute table for a vector layer in the Table of Contents.  
 

- Right click on the Towns layer in the Table of Contents and click the Open 
Attribute Table menu item shown below.  

 
 
 
 
 
 
 
 
 

- The Towns attribute table will open in a new window. For now, just take a look at the 
table. Notice it has rows, one for each feature, and fields (columns). Notice at the 
bottom of the table it says Records (0 out of 169 selected). This indicates that there 
are 169 records in the attribute table – one for each feature in the data layer. 
Because this data layer contains all of the towns in Connecticut, there are 169 
records in the table – one for each town.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- Close the attribute table by clicking on the X in the upper right hand corner of the 
window. We are moving on for now, but will spend a lot of time on tables in the next 
module! 

  

Record (or feature) 

Attribute Field  

Selected Records  
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Using Basic Tools in ArcMap 

Æ Using the Identify Tool 

As you saw in the previous step, generally each feature in a data layer has a corresponding 
record in the layer’s attribute table. The table record stores information about the map feature. 
In this step, you will use the Identify Tool, located on the Tools Toolbar, to access attribute 
data for a feature simply by clicking on the feature on the map.  
 

 
- To view a feature’s data record, click on the Identify Tool on the Tools Toolbar. 

When you move your cursor to the map, you will notice it has turned into a small 
Identify icon. Click on a feature on the map. This will open an Identify window. In 
the window, click the Identify From drop down arrow and select the Towns layer. 
There are other options available in this menu, but for now let’s keep it simple.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- Click on any town on the map. Its attribute information will be displayed in the 
Identify results window. These are the same attributes that are stored in the layer’s 
data table.  

 
- Try holding down the Shift key while clicking on multiple towns on the map. Notice 

how you can view more than one feature’s attributes in the Identify window by using 
this technique? Cool, right? 

 
- When you are done exploring this tool, close the Identify window by click on the X in 

the upper right hand corner.  

Feature 

Attribute 
Data 
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Æ Measure Features 

The Measure Tool allows you to measure lines and areas on a map. You can use the tool to 
draw a freehand line or polygon and it will give you its length or area, or you can click directly on 
a map feature and get its measurement information. The Measure Tool is located on the Tools 
Toolbar in ArcMap. 
 

- Click on the Measure Tool  on the Tools Toolbar. This will open the Measure 
dialog window. Take a minute to look over to tools included in the tool. Each tool is 
described below.  

 

 
 

 
 
 

 Measure Line – Single click to complete the line.  

 
Measure an Area - Double-click to complete the polygon. (This is unavailable if your data frame is not using 
a projected coordinate system.) 

 
Measure a Feature - Click a feature to measure its length (line), perimeter and area (polygon or annotation), 
or X,Y location (point features). Polygon feature measurement is unavailable if your data frame is not using 
a projected coordinate system. 

 Show Total - Keep a sum of consecutive measurements. 

 
Choose Units - Set the distance and area measurement units. The measurement units are set to the map 
units by default. 

 Clear and Reset Results - Clear and reset the measurement results. 

 
Choose Measurement Type - Set the measurement type for measuring line distances. Planar is the default 
when working in a projected coordinate system. Geodesic is the default when working in a geographic 
coordinate system. 
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- Click on the Full Extent icon on the Tools Toolbar to zoom to the full extent of the 
State Boundary dataset in the Display Area. 
 

- Make sure your two Rivers layers are turned on and displayed on the map.  
 

- Click on the Measure Line icon on the far left and try measuring some distances in 
the Data View. After the first click which starts a line, each subsequent click marks 
the end of a line segment. Notice the line measurement for the segment and length 
change as you increase the length of your line. To end a line, double click. The 
segment and length values will remain in the Measure window until you clear the 
dialog using the clear dialog button.  

 
What is the distance in feet along the coast of Connecticut from the Greenwich/NY border to the 
Stonington/RI border?  

 
 
What is the distance in feet along the Connecticut River from Massachusetts to Long Island 
Sound?  

 
 
 

- You can change the units of measure using the Choose Units button. Click on the 
icon in the Measure window and hover over Distance. A dropdown list appears 
where you can select a different unit of measure. Select Miles. 

 
 

What is the mileage of the Connecticut 
coastline?  

 
 
What is the mileage of the Connecticut River?  

 
 
Which tool is most appropriate to use to 
measure the area of your hometown? 

 
 

-  When you are finished, close the Measure 
window.  
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Æ Spatial Bookmarks 

Spatial Bookmarks are references to specific geographic areas on your map. They can be 
accessed through the Bookmarks heading on the Main Menu in ArcMap. Bookmarks are 
created and saved in individual Map Documents so if you create a bookmark in 
Connecticut.mxd it will not be available in another Map Document. In this step, you will use 
Spatial Bookmarks that have been saved in the Connecticut.mxd Map Document to redraw 
the Display Area to the geographic extent of the bookmarks.  
 

- Click on the Full Extent icon  on the Tools Toolbar to display the entire state in 
the Display Area. 
 

- Click on the Bookmarks drop-down menu. Notice 
there are two pre-created bookmarks listed here. 
Click on Haddam. The data frame will redraw to the 
geographic extent of the Haddam bookmark.  

 
 
 
 
 
 

- Repeat the step above, however this time select the 
Hartford bookmark. This will redraw the map to the 
geographic extent of downtown Hartford.  

 
 
 
 
 
 
   
 
 
 
 
 
 
  

More on Bookmarks: You can easily create your 
own bookmarks. First, navigate to an area of interest. 
From the Bookmarks menu, click Create… Enter 
“my first bookmark” as the name for the bookmark 
and click OK. Now pan to another area on the map. 
Return to the Bookmarks menu and click on the 
bookmark you just created. The Display Area will 
redraw to the saved geographic extent.  
 
Spatial Bookmarks can also be saved as an ArcGIS 
Place file (.dat) and loaded into other Map 
Documents. To save or load a bookmark to/from a 
Place file, click on the Bookmarks heading and select 
Manage. In the Bookmarks Manager you can use the 
Load… and Save functions to use Bookmarks across 
multiple Map Documents.  
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Layer Properties and Data Frame Properties 
Layers in an ArcMap Document are stored within a Data Frame. You can have multiple Data 
Frames in an ArcMap Document and many layers with each Data Frame. Both Data Frames 
and individual Data Layers have Properties. In this section, you will familiarize yourself with both 
Layer Properties and Data Frame Properties.  

Æ Layer Properties 

Layers are stored within one or more Data Frames in the Table of Contents. Each layer has 
properties associated with it that are controlled through the Layer Properties dialog window. All 
aspects of the layer’s appearance and behavior can be controlled through these Properties. 
For example, you can define properties that include: 
 

▪ How to draw the layer 
▪ What data source the layer is based on 
▪ Whether or not to label the layer and what those labels looks like 
▪ Whether to specify scale-dependent display for the layer 
▪ Attribute field properties 

 
The Layer Properties dialog box will look different for different types of geographic data. For 
example, defining the symbology (how the data is drawn on your map) for vector data (a 
shapefile or feature class) will be different from a raster dataset. Below is a brief description of 
the tabs in the Layer Properties dialog box for vector data layers.  

General Used to record a layer description, set credits, and specify scale-dependent drawing properties. 

Source Allows you to view the extent of your data. You can view and change the source of your data. 

Selection Allows you to set how features in a specific layer are highlighted when they are selected. Selection 
property changes in a specific layer override the default Selection Options settings. 

Display Controls how your data is displayed as you move in the view. Options include making a layer 
transparent, adding MapTips and hyperlinks, and restoring excluded features. 

Symbology 
Provides options for assigning map symbols and rendering your data. Options include drawing all 
features with one symbol; using proportional symbols; using categories based on attribute values; the 
use of quantities, color ramps, or charts based on attributes; or the use of representation rules and 
symbols. 

Fields Used to set characteristics about attribute fields. You can also create field aliases, format numbers, 
and make fields invisible.  

Definition 
Query Allows you to specify that a subset of your features will be used in the layer. 

Labels Allows you to turn on a layer's labels, build label expressions, manage label classes, and set up the 
labeling options for label placement and symbology.  

Joins and 
Relates Allows you to join or relate attribute tables to the layer's feature attribute table. 

Time Used to specify the time properties of time aware layers.  

HTML 
Popup Used to specify how pop-ups are generated when you click a feature to display information about it. 
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- In ArcMap, move your mouse over the Towns layer in the Table of Contents and 
right click. A menu of options will open. Click on the Properties menu item at the 
bottom of the list. This will open the Layer Properties window for the Towns layer. 
 

- Click through the various tabs to see what type of information is available in each. 
Refer to the table on the previous page for more information about what functions 
each tab controls. 
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- Click the General tab and change the Layer Name: from “Towns” to “Connecticut 
Towns” and click OK at the bottom of the Layer Properties window. You will notice 
that the layer name in the Table of Contents has been updated.  

 

 
 
 
 
 
 
 
 
 
 
 
 
   
 
 
 
 
 
There are many other items that can be changed through the Layer Properties that you will be 
introduced to in future exercises.  
 
  

Tip: For a shortcut to the Layer 
Properties window, try double 
clicking on the layer name in the 
Table of Contents. 
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Æ Data Frames and Data Frame Properties 

A Data Frame is a container for Data Layers. As we have learned, the Data Layers in a Data 
Frame are drawn in the order in which they are displayed, for example, the layer on the top of 
the list will be drawn above all others while the layer at the bottom of the list will be drawn below 
or under other layers above it. The drawing order can be changed by clicking on a Data Layer 
and dragging it to a new position in the Data Frame.  
 
A Map Document can contain one or more Data Frames, however in Data View only one Data 
Frame can be “active” at a time. In Layout View, one Data Frame will be “active” however all of 
the Data Frames in the Map Document will be visible.  
 
Like layers, Data Frames also have Properties. The Data Frame Properties window contains 
options for defining the content for displaying and working with the data the Data Frame 
contains.  
 
 
  

Data Frame 
1 (active) 

Data Frame 2 
(inactive) 

Data View 

Layout View 

Both Data Frames are 
visible in Layout View 
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- In ArcMap, right click on the 

Data Frame name, 
“Connecticut Base Map” and 
select Properties from the 
menu that appears. This will 
open the Data Frame 
Properties window.  
 

- Take a minute to review the 
content found on each tab in the 
Data Frame Properties 
window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- One of the most important tabs is the 
Coordinate System. Typically the 
coordinate system of the Data Frame 
is determined by the first data set that 
is added to your map. You can review 
and set the Data Frame’s coordinate 
system from the Data Frame 
Properties. This is an important 
function and one that we’ll talk about 
in detail in another module. For now, 
just take a minute to explore some of 
these tabs.  
 
 

- When you are done exploring, close 
the Data Frame Properties window.  
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Æ Insert a New Data Frame 

In this step, you will add a second Data Frame to the Connecticut.mxd Map Document and add 
data to it from a geodatabase. You’ll work more with geodatabases in the next exercise so try 
not to get hung up on the details of the file structure.  
 

- In ArcMap, click on the Insert 
menu on the Main Menu and 
select Data Frame. This will 
create a new, empty Data Frame 
in the Table of Contents.  
 
 
 
 
 
 
 
 
 
 
 

Notice its name, “New Data Frame” is in BOLD and your original Data Frame, “Connecticut 
Base Map” is no longer bold. Also notice that there is no longer map data being displayed in the 
Display Area. This is because by default, when you add a Data Frame to a Map Document it 
automatically becomes the “active” Data Frame. In Data View, only the contents of the “active” 
Data Frame will be displayed in the Display Area. In this case, our Data Frame is empty 
therefore the Display Area is also empty.  
  

Empty Display Area 
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- Click on the Add Data  button on the Standard Toolbar.  
 

- In the Add Data window, use the Look In: portion of the window to navigate to your 
C:\GISEd10 folder.  

 
- In the GISEd10 folder, locate the item titled Marlborough.gdb and double click on it. 

This will open the “Marlborough” geodatabase and allow you to view its contents. 
 

- Find the file titled “parcelzoning” and double-click on it to add it to the New Data 
Frame. You will now see the parcels data displayed in the Display Area. 
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- Right-click on New Data Frame and select Properties to open the Data Frame 
Properties window. 
 

- In the Data Frame Properties window, click on the General tab and change the 
name from “New Data Frame” to “Marlborough” and click OK to close the window. 
You should see the name of the Data Frame is updated in the Table of Contents.   

 
- Explore a little by clicking through some of the tabs in the Data Frame Properties 

window.  
 

Save Your Work! 

Æ Save Your Map Project (.mxd) 

Any time you make a significant change to your Map Document, you should save it. 
Unfortunately, ArcMap does not “auto save” and while it has improved greatly over previous 
releases of the software, it has been known to crash without warning. So, you’d be wise to 
follow the mantra “save early and often” when working on important projects!  
 

- To save the changes you have made to the Connecticut.mxd Map Document, click 
on File on the Main Menu and select Save from the menu that appears. 
Alternatively, you can also save the Map Document by clicking on the Save icon  
on the Standard Toolbar.  
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Finding Help 
ArcMap includes an extensive desktop and online help system. It really pays to get comfortable 
using it because even power users utilize ArcGIS Help on a regular basis. Below is an outline of 
three methods for finding help for ArcGIS topics.  
 

 
 

Æ  ArcGIS Desktop Help 

Within ArcMap, you can access the desktop help library by clicking on Help from the Main Menu 
and selecting ArcGIS Desktop Help. This help library is installed with ArcGIS and is not 
updated regularly. 

Æ ArcGIS Desktop Web Help 

Esri has created an online web resource for documentation of it’s ArcGIS applications. The Web 
Help is the most complete, up to date and accessible source for help topics, demos and 
examples and discussion forums related to ArcGIS10.5. It can be accessed by clicking on Help 
from the Main Menu and selecting ArcGIS Desktop Web Help. The Web Help is an online tool 
and requires an internet connection.  
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Let’s Review! 
Congratulations on completing Exercise 1! This exercise was designed to introduce you to the 
ArcMap interface. A number of features were discussed including:  
 

✓ Toolbars: all toolbars can be moved and arranged in the GUI. Toolbars can “float” as 
stand-alone windows, or can be docked within the ArcMap interface. All toolbars can be 
added or removed from the ArcMap GUI.  

✓ Opening a map document: Map documents can be opened within ArcMap by clicking on 
the File drop-down menu.  All ArcMap projects have an .mxd file extension.  

✓ Navigating within the data view: spatial data can be navigated in the data view using the 
navigation tools on the Tools Toolbar.  

✓ Adding geospatial data: the Add Data button allows you to navigate to folders where your 
geospatial data is located. Once you select a dataset, it will be added to the Table of 
Contents. 

✓ Exploring feature attributes: All features in a layer have associated records within an 
attribute table. To open the attribute table for a layer, right click on a dataset in the Table of 
Contents and select open attribute table. 

✓ Identifying Features: the Identify tool on the Tools Toolbar allows you to click on a feature 
and view its associated record in the attribute table.  

✓ Spatial Bookmarks: a specific geographic area is referenced when you create a 
bookmark. Each time you click on the bookmark, the display will redraw to the specific 
geographic extent. Bookmarks are created under the View dropdown menu.  

✓ Measuring Features: the measure tool on the Tools Toolbar lets you measure distances 
and areas of features.  

✓ Examining Layer Properties: every layer in the Table of Contents has properties 
associated with it. These properties can be viewed and modified. To open the properties for 
a layer, right click on the layer in the Table of Contents and select Layer Properties.  

✓ Work with Data Frames: every Data Frame in the Table of Contents has properties 
associated with it. Your project can have one or more Data Frames. Only one Data Frame 
can be “active” at a time. 

✓ ArcGIS HELP: ArcMap includes an extensive Help system which can be accessed from the 
main menu.  

 

This concludes Exercise 1a. 
 
If you have finished and the class is still working on the exercise, go back and try of the tasks 
you just learned on your own. Explore and experiment, don’t worry, you won’t break it.  
 
When you are done, close ArcMap by clicking on the red X in the top right corner of ArcMap. 
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  Exercise 1a Answers 
What happens to your other three data layers? 
 
The other three data layers disappear on the map. This is because the State data layer has a 
solid color fill. The order in which layers are listed in the Table of Contents determines drawing 
order. Layers on the top will be drawn first and layers on the bottom will be drawn last. When 
the State data layer was moved from the bottom to the top, it was redrawn on top of the other 
layers, blocking them from being seen.  
 
What is the distance in feet along the coast of Connecticut from the Greenwich/NY border to the 
Stonington/RI border?  
 
Roughly 636,000 feet. Your answer should be in this ballpark, but may vary depending on how 
many clicks you made along the coastline.  
 
What is the distance in feet along the Connecticut River from Massachusetts to Long Island 
Sound?  
 
Roughly 310,000 feet. Your answer should be in the ballpark, but may vary depending on how 
many clicks you made along the river.  

 
What is the mileage of the Connecticut coastline?  
 
Roughly 122 miles.  
 
What is the mileage of the Connecticut River?  
 
Roughly 60 miles.  
 
Which tool is most appropriate to use to measure the area of your hometown? 
 
The measure a feature tool. This will allow you to click on your hometown and generate 
statistics including area. It is the most accurate method for calculating area using the measure 
tool.   
 
What happens to your data frame when you change the background color? 
 
The space behind your data, within the data frame will be changed to the color you specify. 

 
What happens when you change the active data frame in Data View? 
 
The data in the Display Area will change. Only one data frame can be active at a time. In Data 
View, the contents of the active data frame are drawn in the Display Area.  
 
What happens when you click on the Layout View icon? 
 
ArcMap switches over to Layout View. Layout View is where you format your map for printing 
and add cartographic elements like scale bars, legends and north arrows. 



 Ex. 2a: Page 27  
 

Exercise 2a: Working with Data 
This exercise is designed to introduce you to different types of geospatial data including 
shapefiles, geodatabase files, raster datasets and more. You will become more familiar with 
ArcCatalog, an application within ArcGIS designed to help you organize and maintain your GIS 
data. Additionally, you will learn where to access some of Connecticut’s public domain 
geospatial datasets and how to add an internet map service to a map document in ArcMap.  
 

Getting Started: Opening ArcCatalog 
To start ArcCatalog, double click on the ArcCatalog shortcut on the desktop. If 
there is no shortcut, then you can access ArcCatalog by clicking on Start>All 
Programs>ArcGIS>ArcCatalog 10.5.  

Æ Exploring the ArcCatalog Interface 

The ArcCatalog GUI will look something like what you see below. If it looks slightly different, it’s 
because ArcCatalog “remembers” what windows, folders and toolbars were open the last time it 
was used and will return to that setup the next time it is opened. You’ve already seen this in the 
first Follow the Instructor hands-on so we won’t spend much time on this now. Keep this for 
reference.  

 

   

Catalog 
Tree 

Display 
Area 

Catalog Items 
include: Folder 
Connections, 

Toolboxes, GIS 
Servers and more 

 Contents 
Tab 

Main Menu 

Standard Toolbar 
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ArcCatalog organizes content into a tree 
view called the Catalog Tree. You can 
access and organize your GIS datasets 
and map documents through the Catalog 
Tree. You can also search and find 
datasets as well as manage items (cut, 
copy, paste, delete, etc).  
 
 
 
 
 
 
 
 
 
 
 
 

- As with ArcMap, when you mouse over tool icons in the ArcCatalog GUI, a small box 
will appear that explains what the tool does. Spend a few minutes exploring the 
interface.  
 

 
 
 
 
 
 
 
 
 
 
 

Right-clicking on a folder, 
database or dataset in the 
Catalog Tree will allow you 
to access a shortcut menu. 
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Navigating the Catalog Tree 

Æ Locate the ArcGIS10 Folder 

- Locate the Folder Connections folder in the 
Catalog Tree. This folder contains and displays 
all of your major drives on your computer. Click 
on the + symbol next to the Folder 
Connections folder to expand it and view its 
contents.  
 

- You should see each of your hard drives 
displayed below. Note the image below has 
LOTS of drive connections. You will likely only 
have one – your C:\ drive. Click on the + symbol 
next to C:\ drive folder to expand its contents.  

 
- You will see a number of different folders stored 

on your C:\ drive. Find the GISEd10 folder and 
expand it by clicking on the + symbol. 

 
 
 

-   You should now see all of the contents of the GISEd10 
folder in the Catalog Tree.  
 
-    Go ahead and take a peek inside some of the other 
folders in the GISEd10 folder. Just click on the + symbol to 
expand and contract each folder.  

 
 
 

 
- Locate the CT_Data.gdb 

item in the GISEd10 folder. 
This is a File 
Geodatabase. Click on the 
+ symbol to the left of its 
name to view the contents 
of the geodatabase.  
 

- Click on the name of the 
geodatabase in the 
Catalog Tree to highlight it. 
Notice that its contents are 
now also displayed on the 
Contents Tab in the 
Display Area.  

 
  

Display Area 

List of datasets stored 
in CT_Data.gdb 
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- Click on the HYDROZ feature class in the CT_Data.gdb geodatabase. The 
Contents Tab will give you an overview of the type of data the file is, add additional 
details about its size and modified data (these can be set up under the 
Customize>ArcCatalog Options tab).  
 

 
 

- Next click on the Preview Tab. This tab allows you to visualize the spatial data and 
preview the feature attributes. You can use the tools on the Geography Toolbar to 
explore the spatial data. The attribute Table is accessible from the Preview menu at 
the bottom of the window. Take a minute to explore the dataset.  

  
 
- Click on the Description Tab. 

Here you can read, review and 
edit the Metadata for the 
HYDROZ layer. Metadata 
provides more information about 
a dataset to ensure that it is 
used appropriately.   
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Modifying the Catalog Tree 

Æ Connecting to a Folder 

You can make it easy on yourself and avoid having to always navigate to folders containing 
geospatial data by creating a shortcut to the folder or folders and saving the shortcut as an entry 
in the Catalog Tree. By having these folders in the “top tier” of the Catalog Tree you will be able 
to quickly access them when accessing or saving data in ArcMap.  
 

- Click on the Connect to Folder button on the 
Standard Toolbar. This will open the Connect to 
Folder window where you can navigate to any 
folder on the computer or network.  
 

- In the Connect to Folder window, navigate to 
your C:\GISEd10 folder. (You may have to 
expand your Local Disk (C:) folder to find the 
GISEd10 folder). 

 
- Once you find it, click on it and be sure it says 

C:\GISEd10 in the Folder: box at the bottom of 
the screen. Click OK.  
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You will now be able see the GISEd10 folder displayed in the Catalog Tree under Folder 
Connections. To view only the top level of the Catalog Tree, scroll to the top of the window 
and collapse the C:\ drive folder by clicking on the – symbol to the left of the drive name.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- Repeat this process to add a folder connection 
to your C:\GISEd10\Results folder. This is 
where you will be storing the new datasets you 
create in this course so it will be helpful to be 
able to access the folder quickly in ArcMap and 
ArcCatalog.  

 
 
 
 
 
 
 

Æ Launch ArcMap 

 
- From the Standard Toolbar in 

ArcCatalog, click on the Launch 
ArcMap icon. This will open 
ArcMap from within ArcCatalog.  
 

- When the ArcMap – Getting 
Started window appears, click 
on the Connecticut Map 
Document under Recent and 
click Open. This will open your 
Connecticut.mxd project from 
Exercise 1a.  
 

 
 
 

Click here to 
collapse the 
C drive folder 

Catalog 
Folder 
Connections 
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Æ Folder Connections in ArcMap 

- Let’s see how folder connections affect how you browse for data in ArcMap. Click on 
the Add Data button on the Standard Toolbar. 
 

- The Add Data window will open. Click on the down arrow next to the Look In: option 
and select Folder Connections.  

 

 
 

- The Folder Connections shows all of the folders that are present in the top level of 
your Catalog Tree in ArcCatalog, including the ones you just added. You should see 
your GISEd10 folder and your Results folder. Cool shortcut, right?! Right! 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- Click Cancel in the Add Data window to close it without adding any new content to 
the map. 
 
 

Tip: Did you notice the “Home” folder in your Add Data 
window? This is new at ArcGIS 10. The Home folder is 
automatically set by ArcMap. It is the folder where the 
current Map Document is stored. For this Map 
Document and all of the project files you will create in 
this course, the Home folder will be your 
GISEd10\Projects folder. Another great shortcut!  
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Exploring Data Types 
There are many different types of data, spatial and non-spatial, that can be used in ArcGIS 
applications. In this step, you will use ArcCatalog to explore several different data types that will 
be used in this course.  

Æ The File Geodatabase 

- If you closed ArcCatalog in a previous step, open it again by clicking on the desktop 
icon or accessing the program through the Start Menu. 
 

- In ArcCatalog, expand your C:\GISEd10 folder in the Catalog Tree. 
 

- Earlier in this exercise you explored a geodatabase Feature Class, HYDROZ, using 
the Contents, Preview and Description tab. Feature Classes are vector datasets 
stored within an ArcGIS geodatabase. Take a minute to check out some of the other 
feature classes in the CT_Data.gdb geodatabase in the GISEd10 folder. Be sure to 
click on the Feature Class name in the Catalog Tree before clicking on the Preview 
or Description tabs.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
At its most basic level, a geodatabase is a container for geographic datasets of various 
types (feature classes, tables, rasters, etc.) and is used primarily for storing, editing, 
and data management. There are different types of geodatabases, each varying in size 
and function. They can range from single user databases to larger workgroup or 
enterprise geodatabases that are accessed by many users. The type of geodatabase 
we will work with in this course is a File Geodatabase.  A file geodatabase stores 
datasets in a folder of files on your computer. Each dataset is held as a file and can be 
up to 1 TB in size. File geodatabases can be used across all platforms and can be 
compressed and encrypted for read-only, secure use. See the ArcGIS Help for more 
information on different types of geodatabases.  

Geodatabase 

Feature Class 
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Æ Working with Shapefiles 

Like geodatabase feature classes, shapefiles are a vector data format for storing the geometric 
location and attribute information of geographic features. Unlike feature classes, however, 
shapefiles are not stored within a specific structure like a geodatabase. Shapefiles can be 
stored in any folder on your computer or network. Shapefiles are made up of several 
components which are stored in separate files. In order for a shapefile to function correctly, at 
least three files must exist (.shp, .dbf, .shx) and all of the component files must be stored in the 
same folder or workspace. Note that each component file must have the same prefix. 
 

 
 
 
 
 
 
 
 
 

 
 
The three required component files are the .shp file which stores the feature geometry, the .dbf 
file which stores attribute information and the .shx file which stores an index of the feature 
geometry. Additional files are ancillary and include components like coordinate system 
information (.prj) and metadata (.xml). These files are helpful, but not required to use and view 
a particular shapefile.  
 

- In the Catalog Tree, locate the C:\GISEd10\Shapes folder. Click on the + symbol to 
the left of the folder to expand its contents. You will see a number of shapefiles 
stored in this folder. They all have the .shp file extension. Click on one of them in the 
Catalog Tree and preview the file in the Preview Tab. Notice that a shapefile looks 
and feels very similar to a feature class. That’s because they are very similar, the 
biggest difference is the fact that feature classes are stored in geodatabases and 
shapefiles are stored directly in folders.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

GISEd10/Shapes 

Note: When browsing shapefiles in Windows 
Explore, all associated file extensions will be visible 
as seen in the screenshot above. When browsing 
shapefiles in ArcCatalog, only the .shp extension is 
visible. ArcCatalog maintains the other associated 
file extension for you. This is helpful when moving, 
copying or changing the name of a shapefile.  
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Æ Layer Files 

A layer file contains information about how a data set will be displayed in ArcMap. This includes 
the layer’s symbology, labeling and display properties – all of the settings that can accessed 
through the Layer Properties window in ArcMap. You can create multiple layer files for a single 
data source (for example, ROADS.shp) – one only displaying major highways and others 
displaying only local roads or state roads. The layer files don’t contain any actual geographic 
data, they simple “point to” or reference a particular dataset.  
 
 
 
   
 
 
 
 
 
 
 
 
 
 
 

- In ArcCatalog, locate the C:\GISEd10\Layers folder. Click on the + icon to the left of 
the Layers folder to expand its contents. Notice there are a number of files in the 
folder with the .lyr file extension. These are ArcGIS layer files. Each one contains 
information about how a dataset should be displayed within ArcMap. Each one 
references a source dataset stored on disk. Take a minute to explore some of these 
layer files. You can preview thumbnails of the datasets from the Contents tab or you 
can click on a layer file in the Catalog Tree and preview it from the Preview Tab. 
We’ll work more with layer files in a later exercise. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Source data – 
ROADS.shp 

Layer File – 
Connecticut Roads.lyr 
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Æ Tabular Data 

Tabular information is essential and is the backbone of geographic information, allowing you to 
visualize, query and analyze your data. Tabular data can be associated with a geographic 
dataset, such as a geodatabase feature class or shapefile, or it can be a stand-alone table, 
created in programs like Microsoft Excel or Access. Stand-alone tables can be joined to feature 
attribute tables using a common field. For example, if you have a GIS dataset of all 169 towns in 
Connecticut and a stand-alone table with information about each of those towns, you can 
append them using a common field, like town name. We will spend a lot of time on tables in the 
next exercise.  
 

- Earlier in this exercise, you saw how you can preview the attribute table for a GIS 
dataset using the Preview Tab in ArcCatalog. You can use this technique to 
preview stand-alone tables as well. From the Catalog Tree, locate your 
C:\GISEd10\Tables folder and click on it to highlight it - if you are not already on it, 
click on the Contents tab to see the contents of the folder in the Display Area. 
Notice there are several files in this folder. Each are stand-alone tables of varying 
formats. The folder includes an Excel table (.xlsx), a dBASE table (.dbf) and two 
comma separated values files – one in text file (.txt) format and one in CSV (.csv).  

 
 

- Take a minute to click on each table type in the Catalog Tree and preview its 
contents using the Preview Tab. To view the table for the ElectionResults.xlsx file, 
first expand the file’s contents by clicking the + symbol next to the file name and then 
select the electiondata2012 or electiondata2016 worksheet before previewing it 
from the Preview Tab.  

 
 
 
 

Text File   Excel table            CSV File 

dBASE tables 



 Ex. 2a: Page 38  
 

Æ Raster Data 

Unlike vector data (geodatabase feature classes and shapefiles), raster data is stored in a 
matrix of cells (or pixels) organized into rows and columns, where each cell contains a value 
representing information such as land cover type or temperature. Examples of raster datasets 
include aerial photographs, satellite imagery, digital pictures and scanned maps. Raster data 
can be thematic data, meaning each pixel represents a category of data such as land use or soil 
type, or raster data can be continuous data representing phenomena such as elevation, 
temperature or spectral data like satellite imagery.  
 
    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 

Cell 
Land Cover – Thematic Raster Data 

Elevation – Continuous Raster Data Imagery – Continuous Raster Data 

Scanned Map 
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- Let’s explore some raster data in ArcCatalog. Locate the C:\GISEd10\Images folder 
and click on the + symbol to the left of the folder to expand it. You should see a 
subfolder titled RS (for Remote Sensing) and several other raster files. Click on the 
Sub_Division.jpg and click on the Preview Tab. You should see the scanned 
subdivision map in the Display Area - use the navigation tools on the Geography 
Toolbar to pan and zoom in on the map. Notice when you zoom all the way in, the 
image becomes “pixelated”? Remember, rasters are files made up of lots of tiny cells 
or pixels.  

  
- Expand the RS folder in the Catalog Tree. Click through each of the raster files 

inside the file and preview each one from the Preview tab.  
 
 
 
 
 
 
 
 
 
 
 
 
Is the lake.tif file a continuous raster or a thematic raster?  

 
How about the landcover.img file? 
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Æ CAD Data 

Computer-Aided Design (CAD) drawing files are digital representations of man-made designs or 
real world objects. They are primarily used by technical professionals that include engineering, 
architecture, surveying and construction disciplines. ArcGIS supports AutoCAD .dwg and .dxf 
files and MicroStation .dgn files. All of these file types are stored in file-based vector formats 
and organized into a geodatabase schema that includes five generic feature classes: 
annotation, multipatch, point, polygon and polyline. Let’s take a look! 
 

- In the Catalog Tree, locate the Marlborough.gdb geodatabase in your C:\GISEd10 
folder. Click on the + symbol to expand the geodatabase and view its contents.  
 

- Within the geodatabase, locate the Marl_CAD feature dataset. A geodatabase 
feature dataset is a collection of related feature classes that share a common 
coordinate system. The CAD files do not have to be in a feature dataset or even a 
geodatabase for that matter, however feature datasets are a good method for storing 
CAD data or similar datasets within a geodatabase.  

 
- Expand the Marl_CAD feature dataset by clicking on the + symbol. You will see a 

number of CAD files that have been imported to the Marlborough geodatabase. Click 
through each and preview their contents from on the Preview tab.  

 

 
 
 
 
We won’t spend too much time working with CAD data in this course. If you are interested in 
learning more about how to effectively work with CAD data in ArcGIS, check out the ArcGIS for 
Desktop online help guide for more information. You can get to the Web Help from ArcMap or 
ArcCatalog directly from the Help dropdown menu.  
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Working with File Geodatabases 
As you have seen in previous steps in this exercise, a geodatabase is simply a sophisticated 
container for storing data. A file geodatabase stores the data it contains within a system of files 
and can be used simultaneously by several users, however only one user can edit a database 
at a time. All of the various data components in a file geodatabase are stored within a single 
folder, ending with the .gdb extension. This makes a geodatabase an effective way to share 
and distribute geospatial data. In this step of the exercise, you will learn how to create a new file 
geodatabase and import data into it from shapefiles.  

Æ Creating a File Geodatabase 

- From the Catalog Tree, locate your 
C:\GISEd10\Results folder. Right click on the 
Results folder and select New>File 
Geodatabase. A file geodatabase titled, “New 
File Geodatabase.gdb” will be added to your 
Results folder.  

 
 
 
 

 
 
 
 
 

- By default the name of the geodatabase will be editable text (highlighted in blue), 
however if you clicked off of the geodatabase name, it will no longer be highlighted. If 
necessary, left-click on the geodatabase name once (name, not folder!) to highlight it 
in blue. Click on it again, you should now be able to edit the name of the 
geodatabase. Rename it to CT_Results. 

 
     
 
 
 
 
 
 
 
This geodatabase will serve as a repository for new and changed data that you will create 
during this course. In the next step, you will add data to the geodatabase by importing data from 
two shapefiles. 
 
 
 
 
 
 
 

Click once on geodatabase name Type in new name Geodatabase name will be changed 



 Ex. 2a: Page 42  
 

Æ Importing Data into a Geodatabase 

 
- Right-click on CT_Results.gdb and select Import > Feature Class (multiple). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- In the window that appears, 
click on the yellow folder icon 
under Input Features. This is 
where you will select what 
files you would like to import.  
 
 
 
 
 
 
 

 
 
-   After you click on the folder, a 
window titled Input Features will 
appear. Using the browsing tools at 
the top of the window, navigate to 
your C:\GISEd10\Shapes folder.  
 
-    Several shapefiles are stored in 
the Shapes folder. Click on 
TOWNS.shp and click the Add 
button. This will add the shapefile to 
the Feature Class to Geodatabase 
window. 
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- Repeat the process to add a second 

shapefile, ROADS.shp to the 
Feature Class to Geodatabase 
window.  
 

- Once both shapefiles have been 
added under the Input Features 
dialog box, your Feature Class to 
Geodatabase window will look like 
the graphic to the right.  

 
- Click the OK button to import the two 

shapefiles into the CT_Results.gdb.  
 
 
 
 
    
 
 

- The import process may take a minute so be patient if you don’t see the new files in 
the geodatabase right away. As the computer processes your request, you will see a 
“work in progress” message scrolling along the bottom of the ArcCatalog window. 
 

- After the two files are imported, you will see them in the CT_Results.gdb. Expand 
the + symbol next to the geodatabase name to view the contents. You should see 
both ROADS and TOWNS. These are the two new Feature Classes that you 
imported to the geodatabase from shapefiles. Take a minute to explore them. They 
should look very similar to the shapefiles which they were imported from.  
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Connecting to Web Enabled Data 
Geospatial data is available for download from sources all over the Internet. However, very 
often, GIS data is published on the Internet through a GIS server as a map service that can be 
used to connect to data online instead of downloading data files and storing them locally on a 
hard drive or data disk. In this step of the exercise, you will learn how to connect to a GIS 
Server and add data to ArcMap through an Internet connection.  

Æ Adding a Map Service to ArcMap 

There are a number of useful sources of public domain geospatial data in Connecticut. These 
sources were highlighted in the previous Lightning Round Demo (check your slides for web 
links). In this step, you will visit one source (CT ECO) and add a map service to ArcMap.  
 

- Open a web browser from the Start Menu 
(either Internet Explorer or Firefox) and 
enter https://cteco.uconn.edu. This will 
take you to the Connecticut Environmental 
Conditions Online (CT ECO) site.  
 

CT ECO is a partnership between the University 
of Connecticut and the Connecticut Department 
of Energy & Environmental Protection. CT ECO 
is a website where users can browse map 
layers in interactive web maps, read information 
about particular datasets and connect to data 
layers and imagery in ArcMap through Map 
Services.   
 
 
There is a lot of information and things to look at on the CT ECO page and you can 
spend a LOT of time exploring the site. For our purposes, however, let’s just look at a 
few Map Services. Providing you have ArcGIS installed on your computer and an active 
Internet connection, Map Services allow you to connect to data over the web. This is 
particularly helpful for datasets that are very large or updated frequently and takes the 
burden off you to store and manage the data.  

 
- Open ArcMap again by clicking on the desktop icon, launching it from ArcCatalog, 

or opening the program from the Windows Start menu. 



 Ex. 2a: Page 45  
 

 
- In the ArcMap – Getting 

Started window that opens 
after the program launches, 
open a New Blank Map by 
clicking on the New Maps 
link in the left panel and 
selecting Blank Map under 
My Templates.  

 
- Click OK to open a blank, 

untitled map in ArcMap. 
 

 
 
 
 
 
 
 

- Return to your web browser and the CT ECO website. 
 

- In CT ECO, click on the Data heading under the title bar and click on Map and 
Image Services (see image below). This will take you to the Map Services directory 
(https://cteco.uconn.edu/map_services.htm).   

 

 
 

 
The Map Services directory provides links to a number of GIS map services. Each map service 
includes a number of layers.  
 

- Browse the map services by clicking on each topic heading on the left side of the 
window. A list of related map services will appear under the heading. The image on 
the following page shows the layers in the “Base Map” map service.  
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- If ArcMap is minimized on your desktop, maximize it so you can see the interface. 
You will add a CT ECO map service to your ArcMap project. Click on the small 
black arrow on the Add Data button. In the menu that appears, click on “Add Data 
From ArcGIS Online”.  
 

 
 

- In the ArcGIS Online window that 
appears, type CT_ECO into the search 
box. Press Enter. A long list of map 
services (the same one you just explored 
on the CT ECO website!) will be listed. 
Scroll to the bottom and find Base Map 
(Connecticut). Click Add. The Base Map 
service will be added to your Table of 
Contents. Easy, right?! 

 
 

Selected Map Service 

Layers in 
the map 
service 

REST 
Endpoint 
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- To expand the layer list, click in 
the + next to Base Map. You 
should see some map data of the 
state drawn in the Display Area. 
 

- Notice that Base Map has a 
number of sub-layers below it. 
Each one of the sub-layers 
includes additional sub-layers. Try 
expanding some of them so you 
can get an idea of what kind of 
data is included in the Base Map 
layer.  

 
- Turn layers on/off. Do you notice 

that some of the layers are greyed 
out and the check boxes are 
inactive? This indicates that the 
layer has a scale threshold. You 
will need to zoom in on an area on 
the map in order to view that layer.  

 
 
 
 
 
 
 

- Pretty cool, right? Take some time to explore the Base Map map service and other 
map services available through CT ECO. Remember, to find a map service, return to 
Add Data button and select Add Data From ArcGIS Online and search for 
CT_ECO.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Zoom in to display these layers 

Hurricane Surge Inundation Protected Open Space 

Aerial 
Imagery 
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Adding Content from ArcGIS Online  

Æ What is ArcGIS Online? 

Esri, the company that developed the ArcGIS 
desktop software used in this training, has 
recently developed an online mapping and 
resource website called ArcGIS Online (also 
referred to as ArcGIS.com). Here you will find an 
extensive public map gallery, data and imagery 
services, content groups and mapping tools. If 
you’re interested in learning more about ArcGIS 
Online, ask about CLEAR’s training course! 
 

Æ Adding a Base Map from ArcGIS Online 

 
- In ArcMap, remove any left-over CT ECO map services 

you may have in your Table of Contents. To remove a 
map service or layer, right-click on the layer or map 
service name in the Table of Contents and select 
Remove. You should now have an empty Layers Data 
Frame. 

 
- Click on the small black 

down arrow to the right of 
the Add Data symbol. Click 
on the Add Basemap item.  

 
 
 

- In the Add Basemap 
window that appears, select 
an Esri basemap and click Add.  

 
- You may see a window pop up warning 

you that the basemap data source is in a 
different coordinate system than other 
layers in your map. Click Close to ignore 
the warning. If prompted, select NO to 
Hardware Acceleration.  

 
- You will see a new basemap layer added 

to your Table of Contents. 
 

- Take a minute to check out the map.  
 

- If you have time to spare, explore some of 
the different Basemaps accessible from 
the Add Data button. Remember, you are connection to these basemaps over the 
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Internet so an Internet connection is required. Also, because the entire class is 
connecting to Map Services through a single wireless connection, the Map Services 
may be slow to load and draw so please be patient.  

 

Æ Adding Additional Data from ArcGIS Online 

 
- As you saw in a previous step, there is a third option available to you from the Add 

Data dropdown list called Add Data From ArcGIS Online. Click on it. ArcGIS 
Online makes data available to ArcMap users in the form of online Map Services. 
These data range from the basemaps you added in the previous step to data 
submitted by various users all over the globe (including the CT ECO data you added 
in the previous step). If you or your “organization” have an ArcGIS Online account, 
you can also pull data into your map from your online account. Of course, ArcGIS 
Online requires an Internet connection. We’ll talk more about ArcGIS Online in the 
Lightning Round.  
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Add Data from a REST Endpoint 
A common way to publish GIS data online is through an ArcGIS Server REST Services 
Directory. This is a fancy name for a webpage that provides access to users to connect to a 
dataset or group of datasets in a desktop GIS, web map, or mobile application using an Internet 
connection, web browser and URL. In this step of the exercise, you will add a GIS server to the 
Add Data directory in ArcMap and add GIS data layers from a REST endpoint.  

Æ Explore a REST URL 

The State of Connecticut Bureau of Enterprise Systems and Technology (BEST) has published 
some of the state’s public domain spatial data through a REST Services Directory. Let’s take a 
look at the BEST REST.  
  

- Return to your web browser. Open a new tab and type in the following web URL:  
https://www.ctgismaps2.ct.gov/arcgis/rest/services. Be sure you do not make a 
typo.    
 

- The web address will take you the ArcGIS REST Services Directory for CT BEST. 
It may not look like much, but this directory provides access to a ton of spatial data. 
Let’s take a look.  
 

- Map Services are shown in the 
Directory in both stand-alone 
services and grouped within 
folders, often based on the agency 
responsible for the data. Notice you 
can click on folders and services to 
view and access additional layers. 
Map services often include multiple 
feature layers and tables.  
 

 
 
 
  

Double click 
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Æ Add a Server URL to ArcMap 

In this step of the exercise, you will add a map service from the BEST GIS server to ArcMap.  
 

- In ArcMap, click on the Add Data button. From the Look in text box at the top, click 
the down arrow and choose GIS 
Servers.  
 

- In the list, click Add ArcGIS Server and 
click the Add button.  

 
 

 
- In the window that appears, choose the “Use GIS Services” option.  

 
 

- Type in the BEST REST Services Directory URL: 
https://www.ctgismaps2.ct.gov/arcgis/rest/services and click Finish. 
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- You will see the BEST GIS Server added to the list of GIS Servers your computer 
can now connect to.  

 
- Double-click on the server URL. You should see a list of folders and Map Services 

appear. These are the same items that you explored through the REST URL in your 
web browser.  

   
 

- Double-click on the DOT folder. Scroll through the available map services until you 
see CTDOTTrafficCameras. Double-click on it. The DOT Traffic Camera layer will 
be added to your Table of Contents. If you want to see real time images from the 
DOT traffic cameras, try using the Identify or HTML tool to click on a camera point. 
The images are available as hyperlinks stored in the TrafficLink field. The image will 
open in a web browser.  
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If you finished well ahead of your classmates, feel free to explore other map services that are 
available from the CT BEST GIS server. You may also try searching Google for other GIS REST 
Service Directories that you can add to ArcMap. A few others are listed below, but there are 
many more out there! 
 
The USGS National Map Service Endpoints: https://viewer.nationalmap.gov/services/  
 
The NOAA National Weather Service Endpoints: https://www.nws.noaa.gov/gis/services.html  
 
Esri’s ArcGIS Online Service Endpoints: https://services.arcgisonline.com/arcgis/rest/services  
 
Various Federal Datasets: https://maps1.arcgisonline.com/ArcGIS/rest/services  
 
 
 

Save Your Work!  

Æ Save Your Map Project (.mxd) 

 
Any time you make a significant change to your Map Document, you should save it. 
Unfortunately, ArcMap does not “auto save” and while it has improved greatly over previous 
releases of the software, it has been known to crash without warning. So, you’d be wise to 
follow the mantra “save early and often” when working on important projects!  
 

- Now we’re ready to save our map! To save the changes you have made, click on 
File on the Main Menu and select Save As.. from the menu that appears. In the 
Save in: window, navigate to your C:/GISEd10/Projects folder. Name the file 
Exercise2a.mxd and click Save.  

 

 

  

https://viewer.nationalmap.gov/services/
https://www.nws.noaa.gov/gis/services.html
https://services.arcgisonline.com/arcgis/rest/services
https://maps1.arcgisonline.com/ArcGIS/rest/services


 Ex. 2a: Page 54  
 

Let’s Review! 
Phew! Congratulations on completing Exercise 1b! This exercise was designed to introduce you 
to the ArcCatalog interface and gave you the chance to explore lots of different data types.   
 

✓ ArcCatalog: ArcCatalog includes tools to browse and find geographic data; preview 
spatial data and attributes; to copy, delete, rename and move spatial datasets; to 
create, define, import and export geodatabase data models; and to create and view 
metadata. 

✓ Previewing geospatial datasets: In ArcCatalog, the Preview tab gives you the option 
to view the geography or attribute table for any dataset. This allows you to browse 
through your datasets in an efficient manner. 

✓ Create direct connections to folders: Creating a folder connection allows you to 
access file-based GIS data. You can connect to any folder, including folders on network 
drives. Once you’ve connected to a folder, you can browse the contents of the folder 
and any subfolders it may contain. Adding a folder connection to ArcCatalog can greatly 
increase the speed and efficiency of searching for data or adding a dataset to an 
ArcGIS application. 

✓ Using the Catalog tab in ArcMap: the Catalog tab is available in ArcMap as a means 
of using and accessing ArcCatalog within the ArcMap application.  

✓ Exploring data types: ArcGIS can processes a number of different types of data 
including shapefiles, file geodatabases, layer files, tabular data, raster data and CAD 
data. You will use all of these data types in this course. 

✓ CT’s Public Domain Data: there are many sources for accessing geospatial data for 
Connecticut. Some of the best sources are the CT DEEP, UCONN MAGIC, UCONN 
CLEAR and CT ECO. 

✓ Connecting to Map Services in ArcMap: You can connect to online map services in 
ArcMap. This method is useful because it allows you to access the most up-to-date 
data without having to download large datasets to your computer. CT ECO is the 
primary source for geospatial map services in CT. 

✓ Connecting to ArcGIS Online Basemaps and Data: ESRI’s ArcGIS.com provides 
basemaps and data layers in the form of map services. These map services can be 
added to ArcMap from the Add Data button. All map services require an internet 
connection.  

✓ Connecting to Data through a REST Endpoint: Many organizations publish public 
domain GIS data through a GIS server and make access to those data sets available 
through a REST URL. You can add a connection to a GIS Server through the Add Data 
button in ArcMap.  

 
This concludes Exercise 2a. 

 
If you have finished and the class is still working on the exercise, go back and try of the tasks 
you just learned on your own. Explore and experiment!  
 
When you are done, close ArcMap by clicking on the red X in the top right corner of ArcMap. 
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Exercise 2b: Understanding Spatial Reference 
This exercise is designed to the concepts of projections and spatial references within your GIS 
application.  You will open a premade ArcMap document (.mxd), modify the spatial reference 
values for the layout view, define the spatial reference for a feature, and optionally modify the 
spatial reference for a feature.  In each case noting how this affects display.  This should go 
quick, about five minutes per section. 
 
Getting Started:   

 
- Open ArcMap.  For detailed instructions, refer to Exercise 1a.   

 

Æ Open an Existing Map 

 
When the Getting Started window pops up, click on Existing Maps under the “Open existing 
map or make new map using a template” heading on the left, then click on Browse for 
more… *Note: If the document was previously opened the following may be found under the 
“Recent” link. 
 
In the Open ArcMap Document window, navigate to the following folder C:\GISEd10\Projects\ 
and open the file Projections_GTP.mxd.   
 

 
 
Once open, the ArcMap GUI will look something like what you see below. If it looks slightly 
different, it’s because additional functionality (toolbars, etc.) may have been turned on or 
enabled by a previous user. When ArcMap is closed, it “remembers” these settings and restores 
them when it is reopened.  
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Changing the Spatial Reference of the Data Frame 
If the project opened properly the image should display the world as a rectangular box.  This is 
typical of how a map would look when displaying geographic coordinates in latitude and 
longitude directly onto a flat surface.  To change the display to match a spatial reference of your 
choice you adjust the coordinate system for the Data Frame.   For this exercise you will modify 
the data frames spatial reference to use the UTM Zone 18N coordinate system. 
 

- Right-click on Layers in the Table of Contents and select Properties… from the 
dropdown list.  This will open the Data Frame Properties dialog. 
 

             
 
- In the Data Frame Properties 
dialog select the Coordinate Systems 
tab 
 
- From the displayed list click the (+) 
sign next to Projected Coordinate 
Systems to expand (open) this sub-
list. 
 
- Navigate down the list and click the 
(+) sign next to the UTM “folder” 
 
- Navigate down this list and click the 
(+) sign next to NAD 1983 
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- Finally, navigate this list and select (left-click) NAD 1983 UTM Zone 18N.   Zone 18N 
is the spatial reference that best represents UTM coordinates for Connecticut.  
Rhode Island uses Zone 19N.   (Tip) BEFORE selecting OK in the next step, click 
the Favorites button  on the Coordinate System Dialog Window.  Clicking this 
button will add the reference to you favorites list.  Do this for any spatial reference 
you want quick access to in the future.  
 

- Click OK.  You may see a Warning dialog asking you to use Transformations.  Just 
click YES to close this dialog (not NO, which would make more sense).  This 
happens when two features have different datums.  Transformation accuracy is not 
an issue for this demonstration, but it is important when editing data. 

 
The data view should now match your selected coordinate system.  If you selected the UTM 
Zone 18N your image should look like the map below.  The feature layers, if they have defined 
projections, should adjust accordingly.  Keep in mind changing the spatial reference for a data 
frame does not change anything within the underlying data, only how it is displayed. 
 

        
 
With the data frame (view) in UTM Zone 18 move on to the next section - defining projections. 

Define a Features Spatial Reference (Define Projection) 
 
After you adjusted the map to a new spatial reference, if some of the layers do not show 
properly they may not have a spatial reference defined or their definition could be incorrect.  In 
this section you will use the Define Projection tool to tell ArcMap what a features spatial 
reference is supposed to be (not to be confused with the Project tool where you are changing 
the projection values).  When complete the feature should display in the proper location. 
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In the Table of Contents there is a feature called CT Towns.  Prior to the class we deliberately 
removed its spatial reference, right now ArcGIS does not know where it should properly be 
located on the map.  You are going to fix this. 
 

To verify there is no projection, or see what it might be, do the following: 
 
- Right-click on the CT Towns feature and select Properties… from the droplist. 

 
- Select the Source tab on the Layer Properties dialog.  The text within the Data 

Source box has a field called Coordinate System: - it should say <undefined>. 
* If it does show a coordinate system note what it is and let us know.  I’ll blame Cary. 
 

 
 

- Click OK to close the Layer Properties dialog 
 

Now let’s see where ArcGIS thinks the feature should be: 
 
- Turn on the CT Towns feature by clicking the check box next to it.  You may see it 

appear on the map, or maybe not. 
 

- Right-click on the CT Towns feature and select Zoom to Layer from the list. It 
should now zoom to the Towns feature.   
 

- At the top of the ArcMap interface there should be a text box for changing the Map 
Scale.  Type in the number 60,000,000 and hit Enter.     

                                                                           
This should give you a good scale to see where the feature actually is.  Is the 
location correct?  Or has has CT gone South? 

 
Now define the projection to put the feature into its proper location: 
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- Select the Geoprocessing menu item at the top of the ArcMap interface, then select 
Search for Tools from the droplist.  This opens a Search dialog (we’ll explain more 
about tools in the next talk). 
 

     
 

- In the Textbox type the words “Define Projection” and select Enter (or search). 
 

- A list of options should be returned, select the choice called Define Projection (Data 
Management).  A Define Projection dialog box should appear (it may take a few 
seconds to load).  There are two text boxes.   
 

          
 

- In the Input Dataset or Feature Class textbox select the arrow at the right, then 
select CT Towns from the list.  
  

- Next, click the small icon next to the Coordinate System text box.  This will bring up 
a Spatial Reference Properties dialog. 
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- Where it says “Type here to search” in the Spatial Reference Properties dialog, 
type Connecticut, then hit enter or click the search button.  This reduces the 
selection list to spatial references recommended for CT. 
 

- From the list below, open the following directory tree by clicking their plus (+) signs.  
Projected Coordinate Systems ->State Plane ->NAD 1983 (US Feet) 
 

- Finally, select NAD 1983 StatePlane Connecticut FIPS 0600 (US Feet) 
 

- Click-OK to close the Spatial Reference Properties dialog 
 

- Click-OK on the Define Projection dialog to start the process.  This can take a 
minute.  When the tool is finished CT Towns will snap into its proper location.  To 
verify, right-click on CT Towns in the Table of Contents and select Zoom to Layer 
from the droplist.  The map should zoom into the towns and be at its proper location 
in the United States. 
 

You now have CT Towns in one coordinate system and the Data Frame in another with all of 
the features displaying in their proper locations. 

Optional:  Change a Features Spatial Reference (Project) 
 
Occasionally you will need to actually convert a data feature from one spatial reference to 
another.  Not all GIS software can make use of spatial reference data to match one feature to 
the others, for example the old ArcView 3.0 and some free software.  Also, working with multiple 
datasets together is always more accurate, and can display faster, if all features in a data frame 
are referenced to the same datum and coordinate system.  To match these datasets you 
actually convert the data using the Project tool (not to be confused with Define Projection). 
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In theory, if you properly defined the projection in the previous section, the spatial 
reference for CT Towns is now set to CT State Plane Feet.  Your goal in this section is to 
re-project these towns to a new feature set with a UTM Zone 18N coordinate system: 
 
- Just like with define projection, select the Geoprocessing menu item at the top of 

the ArcMap interface, then select Search for Tools from the droplist. 
 

- This time in the Textbox type the word “Project” and select Enter (or search). 
 

- A list of options should be returned, select the choice called Project (Data 
Management).  
 

- A Project dialog box should appear.  There are more text boxes and more options in 
this dialog than just the two when defining a projection.  In the Input Dataset or 
Feature Class text box select the arrow at the right, then select CT Towns from the 
list.  The second box, Input Coordinate System, should populate itself with the 
State Plane coordinate system you defined before, in this case 
NAD_1983_StatePlane_Connecticut_FIPS_0600_Feet.  If it does not check with 
one of us before proceeding. 
  

- Another box is for the Output Dataset or Feature Class.  Select the folder next to 
this text box and navigate to C:\GISEd10\Results, then type the new name for your 
feature – in this case CTTowns_UTM18.shp, and click OK.  This is what your new 
feature will be called.  Tip: Adding a short piece of the coordinate system text to the 
filename can help later if you need to guess what the features spatial reference is 
when moving files around.   
 

   
 

- Now click on the button to the right of the Output Coordinate System text box.  As 
with define projection this will bring up a Spatial Reference Properties dialog. 
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- Where it says “Type here to search” in the Spatial Reference Properties dialog, 
type UTM, then hit enter or click the search button.  This reduces the selection list to 
spatial references with UTM coordinates. 
 

- From the list below, open the following directory tree by clicking their plus (+) signs.  
Projected Coordinate Systems ->UTM ->NAD 1983 
 

- Finally, select NAD 1983 UTM Zone 18N 
 

- Click-OK to close the Spatial Reference Properties dialog. 
 

- Note:  You can ignore the Geographic Transformation textbox, in this case both 
features are going to use the same datum (NAD1983) so no transformation is 
required.   
 

- Click-OK on the Project dialog to start the process.  This can take a minute.  When 
the tool is finished CTTowns_UTM18 should show up in the Table of Contents and 
draw on the map.  Visually not much should change, ArcMap will simply redraw the 
feature into the correct location in the same spatial reference as the Data Frame.  
Behind the scenes however, you now have a new feature with physical coordinates 
(X, Y) in UTM Zone 18 meters.  This could now be sent to someone who has a GIS 
software that cannot handle projections, displaying properly if their data is also in 
UTM Zone 18. 

 

Bonus: Change the Spatial Reference of the Data Frame 
Repeat section one, this time pick any projection(s) you want.  To zoom to the full extent after 
adjusting the map right-click on world30 in the Table of Contents and select Zoom To Layer. 
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Exercise 3a: Introduction to Tables 
 
This exercise will introduce you to attribute tables and selections.  Tabular information is the 
foundation of a GIS.  It allows you to visualize, query, and analyze your data.  It is important to 
remember that feature attribute tables contain data that are directly attached to map features.  
Tables are critically important in making geospatial data useful.  In this exercise, you will 
explore:  
 

- Table Field properties in both Layer Properties and Table Properties 
- The Attribute Table including sorting rows and table layout 
- Selections 

 

 Getting Started 
- Open ArcMap.  For detailed instructions, refer to Exercise 1a.   
- Open a New Map.  Remember, to click on New Maps and then a Blank Map.  

 

Æ Add a Layer to ArcMap 

In this step you will add the towns layer to the Table of Contents using the Add Data button. 
The towns layer is a feature class inside the CT_Data geodatabase.   
 

- Click on the Add Data button on the Standard Toolbar. This will open the Add Data 
window.  

 

 
 

- Use the Look in: area of the window to navigate to the following folder:    
C:\GISEd10\Results 
 

  

TIP: Remember that 
geodatabases are containers 
for layers.   Layers inside a 
geodatabase are called 
Feature Classes, not 
shapefiles.   
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Notice that the geodatabases have a different 
icon than the folders that contain data.   
 

- Double-click on CT_Results.gdb.  
This is the geodatabase that you 
created in an earlier exercise. 

- Locate the TOWNS layer and click 
on it.  

- Click Add at the bottom of the 
window to add the layer to ArcMap.  
 

The TOWNS layer will be added to ArcMap’s 
Table of Contents. A randomly selected color 
will be assigned to the layer to symbolize the 
towns.  
 

Field Properties 
Field Properties contain options for how each field (column) is displayed in the table.   

Æ Field Properties via Layer Properties 

 
First you will look at the Field 
Properties that can be changed in the 
Layer Properties box.   
 

- Right-click over TOWNS 
in the Table of Contents 
and select Properties. 
 

- Click on the Fields tab.  
Notice that all fields have 
a checkmark meaning that 
they are visible (turned 
on).   
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- Un-check COAST_AREA to hide this field. 
- Click on PLAN_ORG in the left column. It should be highlighted.  
- On the right side, click in the Alias field and type in Planning Org. Hit the ENTER 

key on your keyboard.  Notice that the name changes on the left side. 

- If you like, use the arrows to rearrange the order of the fields in your 
table.   
 

 
 

- Click on TOWN. 
- On the right, change Highlight to Yes.   
- Click OK to close Layer Properties.   

 

Æ Field Properties via Table Properties 

To open the Attribute Table of the TOWNS layer,  
 

- Right-click over TOWNS and select Open Attribute Table.   
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The table should look like the graphic on the following page.  Notice that the changes you just 
made in Layer Properties are evident.  The TOWN field is highlighted in yellow, the Planning 
Organizations field says Planning Org and not PLAN_ORG and the COAST_AREA field is not 
visible.   
 

 
 
These settings and others can also be changed within the Field Properties inside the table. 
 

- Right-click over the yellow TOWN field and select Properties.  Uncheck Highlight 
field.  Notice that you could change the Field Alias and turn the field off (hide it) if 
you wanted.   



 Ex. 3a: Page 67  
 

 
- Click OK to close the Field Properties 

window.  The town field is no longer yellow. 
 

 
 

Explore the Attribute Table  
The attribute table is similar to a spreadsheet in layout, but not function.  It consists of rows, 
called records (usually with one record per layer feature), and columns.  Each column contains 
values for a single data field.  The field name (column) is in bold at the top of the column.   
 
You will now locate and explore the various menus and options 
available inside a table.   

Æ Row Box Menu  

- Right-click over the row box next to a record at the 
very left of the table. 

- Click on Flash.  The record over which you right-
clicked should flash in the map display.  

- Try using Zoom To, Pan To and Identify to see how 
it changes your map display.   
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Æ Field Menu 

SORT ON A SINGLE FIELD 
- Right-click over the TOWN field name to 

display the field options.   
 

 
 
 

- Choose Sort Ascending.   
 

How does Sort Ascending change the field? What happens to the other fields? 

 
 

SORT ON MULTIPLE FIELDS 
- Right click on the TOWNS field again. This 

time choose Advanced Sorting.  
- In the first Sort by field, choose County.   
- In the second Sort by field, choose 

TOTAL_SQMI. 
- Click OK. 

 
- Notice in the table that the records are first 

sorted by county and then the total sq.mi. 
 

What is the largest town in square miles in Hartford 
County? 

 
What is the smallest town in square miles in Middlesex County? 

 
 

TIP: The Field Options 
menu contains operations 
that work on the column or 
field ONLY.  
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STATISTICS 
- Right-click over the TOTAL_SQMI field and choose Statistics.  Descriptive statistics 

for the field values will be displayed, including sum (or total area of all towns), 
minimum and maximum values for total square miles, and mean.  

 

 
 
According to this dataset, what is the total area of Connecticut? 

 
According to this dataset, what is the mean town size? 

 
 

- Close the TOWN Statistics window when you are done. 
 
We won’t use these options now, just note that the field menu also 
includes 

- Summarize  
- Field Calculator and Calculate Geometry (we’ll use these 

later) 
- Turn Field Off 
- Freeze/Unfreeze Column 
- Delete Field (don’t do this!) 

 

Selections 
There are many uses for and reasons to select features, including: 

- To retrieve and examine attribute data 
- To answer simple questions 

TIP: Sorting, especially when used with selecting (coming up), can be a powerful and 
simple way to answer questions using your GIS data.     
 
NOTE: Sorting a table does not permanently rearrange the records.  If you were to 
close the table, remove the layer and then add it back into ArcMap and open the table, 
it would no longer be sorted.   
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- To create summary statistics 
- To create a new feature class or shapefile 
- To focus an analysis on appropriate features 
- To select features based on spatial relationships with other layers 

 
You will now explore a variety of ways to select features.   
 

 
 

Æ Select Records in a Table 

- Open the attribute table for TOWNS by right-clicking over the layer in the Table of 
Contents and selecting Open Attribute Table. 

- Move the table so that you can see the TOWNS layer in your map.  
 
ROW BOX 

- Left-click over a row box to select a record. If you cannot see the selected record 
on your map, click on the Zoom to Full Extent  icon on your Tools Toolbar.  
 

    
 

- Left-click and drag to select multiple consecutive records. 
 

    
 

- Hold down the control key and left click to select multiple, non-consecutive 
records. 
 

REMEMBER: Attribute tables and features are connected.  A selected 
feature is selected in BOTH the table and the map. 
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   ROW BOX MENU 

- Right-click over any row box to access the menu.   
- Select or unselect a record or records using this menu.   
- Try the Flash tool. 
- Try the Zoom to tool. 
- Try the Pan To tool. 
- Select a few records and try the Zoom to Selected.   
- When you are finished choose Clear Selected.  

 
TABLE SELECTION TOOLS 
Table Selection Tools can be accessed through the icons at the top of 
the table or through the Table Options Menu.  Note that Select All is 
only available on the Menu and Zoom to Selection is only available on 
the toolbar. 

 
 
 

 
 
 
 
 
- If you don’t have any records selected, select a few.  Click and 

drag over the row boxes or use another selection method that 
you’ve learned. 

- Click Switch Selection from either the icon on the toolbar or 
the menu.   

- Notice how the records flip from selected to not selected and 
vice versa. 

- Click Zoom to Selected on the toolbar.  The map should zoom 
to show the extent of only the selected records.   

- Clear the selection using either the icon on the toolbar or the 
menu.   

 
 

Select by 
Attributes 

Switch 
Selection 

Zoom To 
Selected 

Clear 
Selection 
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- Close the table.   
 
 

Save Your Work!  

Æ Save Your Map Project (.mxd) 

 
- To save the changes you have made, click on File on the Main Menu and select 

Save from the menu that appears.  Name it Exercise3.mxd and be sure to save it in 
the Projects folder. You will use it for the next exercise so it is important that you 
remember to save the project! 

 

Let’s Review! 
Congratulations on completing Exercise 3a! This exercise covered all of the basics of using 
feature attribute tables and stand alone tables in ArcMap. A number of important concepts were 
covered including: 
 

✓ Understanding feature attribute tables: Feature attribute tables are tables that 
are directly linked to map features. Any changes made to the feature attribute 
table will also be reflected in the map.   

✓ Modifying table properties: Table properties such as field name aliases, 
arrangement of fields, and visibility of fields (you can make a field “hidden”) can 
be modified to make a table more “user-friendly”. 

✓ Selections:.There are basic tools to easily select records in a table.   
 

This concludes Exercise 3a. 
 
If you have finished and the class is still working on the exercise, move 
on to the extra credit below.  
 

Extra Credit 
Be sure your Exercise3.mxd is still open.  If not, open it. 
 
Try using the table to find  
 

- The biggest town in Connecticut.  ________________________ 
 

- The smallest town in Connecticut.  _______________________ 

NOTE:  The Select By Attributes option is available on both the toolbar and the 
menu within the table.  We will use Select By Attributes soon.  
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- The biggest town in each county  
 
- and the smallest town in each county. 

 
 

County Biggest Smallest 
   
   
   
   
   
   
   

 
 

Exercise 3a Answers 
 
How does Sort Ascending change the field? What happens to the other fields? 
The records are re-ordered occurring to alphabetical order of town name.  All other fields are 
rearranged along with the town field. 
 
What is the largest town in Hartford County? 
Glastonbury, 52.5 sq. miles. 
 
What is the smallest town in Middlesex County? 
Essex, 12.2 sq. miles. 
 
According to this dataset, what is the total area of Connecticut? 
5008.2 sq miles.  Find this using Statistics for the TOWN field and looking at the Sum. 
 
According to this dataset, what is the average town size? 
29.6 sq. miles.  Find this using Statistics for the TOWN field and looking at the Mean 
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Exercise 3b: Working with Tables 
 
Exercise 3b takes moves beyond working on the table as a whole and introduces you to ways to 
add and change data in your table.  It also shows you how to bring two tables together so that 
the information can be used together.  In this exercise you will learn how to: 
 

- Add a table field 
- Calculate area in the new field 
- Join tables 
- Use the field calculator 
- Create a new file with the joined information 

 
Getting Started 

- Open ArcMap.  For detailed instructions, refer to Exercise 1a.   
 

Æ Open an Existing Map (.mxd) 

- Exercise3.mxd will likely appear as a Recent document.  If so, click on it to select it 
and click Open.   

- If the Exercise3.mxd does not appear, in ArcMap, click on the File dropdown menu 
and select Open from the list of choices.  This will open a window in which you are 
able to navigate to any location on your computer.    

 
- Navigate to the following folder: 

 
C:\GISEd10\Projects\ 

 
- Select the map file named Exercise3.mxd and click the Open button. Double-

clicking on the file name will also open it.  
 
Open the TOWNS table if it is not still open from the previous exercise.  
 

- Right-click over TOWNS in the Table of Contents and select Open Attribute Table.   
 

Æ Table Options 

The Table Options menu is opened by clicking on the 
Table Options icon  in the top left of the table 
window.   
 

TURN ALL FIELDS ON 
- Click on the Table Options icon and select Turn All Fields On.   

 

TIP: The Table Options 
menu contains operations 
that work on the ENTIRE 
table.  
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ADD FIELD 
- Click on the Table Options icon and select Add 

Field. 
- Type acres as the field name and choose Float as 

the type. Below is a table describing the different 
types of fields that can be added to a table.   

- Click OK.   Notice that a new field, called acres, has 
been added to your table.  Because this is a feature 
class table inside a geodatabase, the default values 
say <Null>.   

 
 
Numeric Table Field Types 
Field Type Appropriate Use Data Storage Size Allowable Range 
Short Integer Whole numbers 2 bytes -32,768 to 32,767 
Long Integer Whole numbers, especially large 

numbers 
4 bytes -2,147,483,648 to 

2,147,483,647 
Float Single precision numbers with decimals 4 bytes Approx. -3.4E38 to 

1.2E38 
Double Double precision numbers with 

decimals 
8 bytes Approx. -2.2E308 to 

1.8E308 
 
Other Table Field Types 
Field Type Appropriate Use 
Text A text field represents a series of alphanumeric symbols. This can include street names, 

attribute properties, or other textual descriptions 
Date The date data type can store dates, times, or dates and times. The default format in which the 

information is presented is mm/dd/yyyy hh:mm:ss and a specification of AM or PM. When you 
enter date fields in the table, they will be converted to this format 
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CALCULATE GEOMETRY 

You will now calculate area, in acres, in the column.  Remember, each row in the table is 
associated with one feature.  Here, the features are individual towns.  The Calculate Geometry 
tool will do the calculation for each town.  The Calculate Geometry function can be used to 
calculate Area, Perimeter, X Coordinate of Centroid or Y Coordinate of Centroid.   
 

- Right-click over the new acres column and select Calculate Geometry. 
- A warning box will show.  It is telling you that you will be making an edit to the table 

outside of an edit session and you CANNOT UNDO your edits.  Click Yes.  
 

 
 

 
- Choose Area under Property.   

 
- Select Use coordinate system of 

the data source.  
 
- Specify Acres US [ac] as the 

Units.  
 

- Click OK.  
 
The acres field in your table should now be 
populated.  For easier viewing of the town 
name and acres column together, it is helpful 
to freeze the field. 
 
 
 
 
 
 
 
 

TIP: If it doesn’t seem to have worked, check to 
see if any records are selected.  If any records 
ARE selected, the calculation ONLY works on 
the selected ones.   
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FREEZE/UNFREEZE COLUMN 
- Right-click over TOWN and choose 

Freeze/Unfreeze.   
- Use the bottom scroll bar to move the acres 

column closer to the frozen TOWN column so 
you can see both fields near each other in the 
table. 

 
According to this dataset, what is the biggest town in 
Connecticut? The smallest? 

 
 

Æ Add a Table to ArcMap and Open the Table 

Leave the TOWNS table open for now. You will add the towndata table to your ArcMap 
document.  The towndata table contains population information.   
 

- Click on the Add Data button.   
- Navigate to C:\GISEd10 
- Double-click on CT_Data.gdb. 
- Click on towndata and then 

click Add. 
 
 
 
 
 
 
 
 
 
 
 
 
 
After adding the table in ArcMap, the Table of 
Contents will switch from List By Drawing 
Order to List By Data Source.   
 

- Right-click over towndata and 
select Open.  

 
- Because the TOWNS attribute table 

is already open, the towndata table 
is added to the Table Window as a 
tab at the bottom of the window.  If 
your TOWNS attribute table isn’t 
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open, right-click over TOWNS in the Table of Contents and choose Open Attribute 
Table. 

 
 

- Take a minute to explore the table.  It includes a TOWN field and various population 
fields.  Notice how the TOWN field in towndata matches the TOWN field in the 
TOWNS feature class that you have been working with. 

Æ Arranging the Table Window 

If more than one table is opened, they can be arranged using tabs, side-by-side or top and 
bottom.   

         
 

- Click on the towndata tab, hold the click and drag your mouse to the center of the 
table.  A blue graphic (below) will appear. 
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- While you are still left clicking (don’t let go), move your mouse over one of the 

triangles and release your mouse. 
- The towndata table will be arranged based on which triangle you selected.   

 
- Close your tables. 

 

Table Joins 
In ArcMap you can join two tables together based on the values in a common field.  When the 
common field values are equal, records are joined together. In this step you are going to join the 
towndata table to the TOWNS attribute table based on the values stored in the town name field 
which exists in both tables. Joins are useful when there is a one-to-one relationship between a 
layer attribute table and another table (i.e. there is one record for each town in each table) or 
when there is a many-to-one relationship. An example of a many-to-one relationship would be 
joining a town attribute table to a planning region database. There are 169 towns and each town 
is in only one planning region. Thus many towns will have the same value for their planning 
region.  
 

Æ Join Two Tables 

- Right-click over TOWNS in the Table of Contents and choose Joins and Relates 
and then Join. 

 

 
 
Fill out the Join Data box as follows: 

TIP:  For a one-to-many 
relationship, a relate is more 
appropriate than a join.    
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- Choose to Join attributes from a 

table 
 

- 1. Click on the down arrow to the 
right of the first field and select the 
field named TOWN. 

 
- 2. Since there is only one data table 

in the Table of Contents, towndata 
will be entered automatically as the 
name of the table that will be joined. 
Note that you could click the open 
folder icon to specify a table that is 
located on disk and not already in 
the ArcMap project. 

 
- 3. Since towndata has a field – 

TOWN – that’s the same as the field 
specified in step 1, it automatically 
is entered into the form field in step 
3. Otherwise, you would select the 
field from the drop-down list of 
fields. 

 
- Choose to Keep all records. 

 
- Click OK.   

 
- If the Create Index box pops, click Yes. This will create an index so that ArcMap can 

sort through the table faster.  
 

 
 

 
 

Tip: You can access the Joins on the Table Options menu inside a table or 
through the Layer Properties box on the Joins and Relates tab.  
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Æ Examine Joined Tables 

After you have joined the towndata table to the TOWNS attribute table, the fields and data from 
towndata will appear as part of the TOWNS attribute table. 
 

- If you still have the Table window open, click on the TOWNS tab at the bottom to 
explore the joined table. If you closed the table, right-click over TOWNS in the Table 
of Contents and select Open Attribute Table. 

- Explore the table. 
 

TOWNS Attribute Table Fields    towndata table fields 
 

 
 

Æ Field Calculator 

Earlier in this exercise, you added a field and then used the Calculate Geometry tool to 
calculate area in acres.  Calculate Geometry is extremely useful when you want to calculate 
area, perimeter or centroids.  However, there will be many times where you want to do other 
calculations.  The Field Calculator is the tool. 
 
You will be adding a new field and using the Field Calculator to populate the field with 
population density.   
 

- Be sure your TOWNS table is open.  It should include 
the results of the join from the previous step, meaning 
that it contains both the TOWN attributes and the 
towndata table fields.  If it is not open, open it now.  If it 
does not contain all the fields, ask an instructor for help.   

- On the Table Options menu, choose Add Field.   
- Name the new field PopDens2000.   
- Select Float for the data type.  Remember that Float 

fields are for single precision numbers with decimals. 
- Give the field an alias called Population Density.   
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- Click OK.   
- The field should be added to the very right-hand side of 

the table.   
 
Now it is time for the Field Calculator. 
 

- Right-click over your new Population Density field and 
select Field Calculator.  If you get a warning box, click 
yes to continue. 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

TIP:  Remember, to rearrange the 
order of the fields in a table, go to 
Layer Properties and choose the 
Fields tab.     

On the top left is the 
Fields: box which 
lists all the fields in 
the table.   

 
On the top right is 
the Functions box 
which lists simple 
functions like 
addition and 
mulipllication as well 
as more advanced 
functions.  
 

At the bottom is a white box where 
you will create your formula.  

Shown here: 
Field Aliases  

Tip: You can specify 
whether you want to see 
Field Names or Field 
Aliases by right-clicking in 
the Fields box.  
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- Notice that the first part of your equation, TOWNS.PopDens2000= is present based 

on the field over which you right-clicked.   
 

 
 

- In the Fields: list, double-click on Pop_2000 (or towndata.POP_2000 if 
you did not change your fields to show aliases).  It will be added to the formula box 
and will probably be written as towndata.POP_2000.   

- Click on the divide by button.  
- In the Fields: box, double-click on acres. 
 

 
 

- Your formula should look like this: 
 

  
 

- Click OK and wait for ArcMap to perform the calculation.  The Population Density 
field should now be populated with a number representing people per acre.   

-  
If it doesn’t appear to work, make sure no records are selected.  If records are selected, the 
field calculator ONLY does the calculation on those fields!  

TIP:  The period in TOWNS.PopDens2000 indicates that the PopDens2000 
field is joined to TOWNS.  If you were doing a calculation in a table that did not 
have a join, there would be no dot.     
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- Use the information to answer the following questions.  Remember to use table tools 

you have already learned, such as sorting and statistics. 

   
 
What town in Connecticut has the highest population density? 

 
 
What town in Connecticut has the lowest population density? 

 
 
What is the mean population density for all towns in Connecticut? 

 
 
How many towns have a population density over 10 people/acres? What are they? 

 
 

Add an Excel File of Election Results 

 
You are going to start by joining an Excel table containing results from the 2016 Presidential 
election to your town layer that already contains town population information.  You will then use 
all this data to answer some questions.   
 
In this step you will add an Excel table to the Table of Contents using the Add Data button. 
The TOWNS layer is referencing a feature class inside the CT_Data geodatabase.   
 

- Click on the Add Data button on the Standard Toolbar. This will open the Add Data 
window.  

 

 
 

- Use the Look in: area of the window to navigate to the following folder: 

CAUTION:  You can right-click and use the Field Calculator over any 
field, but it will OVERWRITE whatever is there and you cannot get it 
back. 
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C:\GISEd10\Tables 
 

 
 

- All excel files have an .xlsx file extension.  Locate ElectionResults.xlsx.   
- Double-click on ElectionResults.xlsx.   

 
 
- Click on election2016 and click Add.   
- The Table of Contents will switch to the List by Source view if it’s not already on it.  

You should see election2016 in the Table of Contents. 
 

- Right-click over election2016 and select Open. 
- Explore the election results.  Notice there is a Town attribute along with attributes for 

Clinton, Trump, Stein, Johnson and TotalVote. 
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- Close the election2016 table. 
 

 
 

Æ Join Excel File to a Feature Class 

- In the Table of Contents, right-click over TOWNS, select Joins and Relates and 
select Join. 

 

 
  

TIP: 
- Field names must start with a letter.  
- Field names must contain only letters, numbers, and underscores.  
- Field names must not exceed 64 characters. 
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- Complete the Join Data box so that you are 

 
- Joining attributes from a table 

 
- 1. Based on the field TOWN 

 
- 2. The table to be joined is election2016$ 

 
- 3. And the field in the table to base the join 

on is Town.  
 

- Choose to keep all records. 
 
- Click OK. 
 
- Right-click over TOWNS in the Table of Contents 

and select Open Attribute Table. 
 
- Explore the table and notice how there are 

attributes from TOWNS, towndata and 
election2016. The table on the following page 
organizes the fields by source. 

 
 
 
 
 

ATTRIBUTES 
original TOWN layer Towndata table 2016 Election Results table 
TOWN TOWN TOWN 
TOWN_NO POP_1950 CLINTON 
TOTAL_SQMI POP_1960 TRUMP 
LAND_SQMI POP_1970 STEIN 
COUNTY POP_1980 JOHNSON 
PLAN_ORG POP_1990  
DEP_DIST POP_2000  
COAST_AREA PERCAPINC  
Acres CRIMERAT98  

 
 

 
 

- Close the Table. 
 

TIP: One HUGE advantage of a join is the ability to maintain updated data. The 
tables that are joined to a feature class or shapefile can be updated outside of 
ArcMap.  Each time the ArcMap project is opened, the join is refreshed and the new 
information will be in both the joined table AND the map. 
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Æ Export as Feature Class 

Although joins have their benefits, there are many times when it is advantageous for the 
attributes from a join to become a permanent part of the feature class or shapefile.  This is 
accomplished using Export.   
 

- Right-click over TOWNS and select Data and then Export Data. 
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                               

 
 

- Choose to Export All Features and to use the coordinate system of the layer’s data 
source.  

- For the Output features class, click on the yellow folder icon and navigate to  
 

C:\GISEd10\Results\ 
 

- Change the Save as Type option to File and Personal Geodatabase feature 
classes.  

- Double-click on CT_Results.gdb. 
- Type towns_election into the Name field. 
- Click Save.  
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- Click OK in the Export Data box.   
 
The export will run and then ArcMap will ask you if you want to add the exported data to the 
map as a layer.   
 

- Click Yes.   
- A new layer, called towns_election will be added to the Table of Contents.   
- Open its attribute table by right-clicking over towns_election and selecting Open 

Attribute Table. 
- Verify that the table contains attributes from the original TOWNS file as well as the 

joined towndata table and the joined 2016 Election Results table.   
- Close the table.   

 

 
 
  

NOTE: You may have noticed some other changes.  In a single attribute table, each field must have 
a unique name.  When you exported, there were multiple fields with the name TOWN.   ArcMap 
adds underscores and numbers to these duplicate columns, such as TOWNS_12. 
 
Because the new towns_election file is a feature class (meaning it’s in a geodatabase), ArcMap adds 
and updates the Shape_Length field and Shape_Area field.  Both of these are recorded in the unit 
of the coordinate system that has been assigned to the layer.  To check the coordinate system, go to 
Layer Properties (right-click over the layer, select Layer Properties) and view the Source tab.  All of 
the data used here is in Connecticut State Plane Feet and therefore the Shape_Length and 
Shape_Area fields are in feet.   
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Save Your Work!  

Æ Save Your Map Project (.mxd) 

 
- To save the changes you have made, click on File on the Main Menu and select 

Save from the menu that appears.  It should already be called Exercise3.mxd. You 
will use it for the next exercise so it is important that you remember to save the 
project! 

Let’s Review! 
Congratulations on completing Exercise 3b! This exercise covered adding or changing 
information in a table. A number of important concepts were covered including: 

✓ Add and Delete a Field.  
✓ Calculate Geometry: The calculate geometry tool provides shortcuts to 

calculating area, perimeter and x and y coordinates of the centroid in the table 
attributes.    

✓ Field Calculator: The Field Calculator is a powerful tool for populating table 
fields with any type of information including mathematical equations.  . 

✓ Table Joins: As long as a common attribute exists, two or more tables can be 
jointed together and the resulting attribute information is available for display or 
use in other analyses 

Exercise 3b Answers 
 
How does Sort Ascending change the field? What happens to the other fields? 
The records are re-ordered occurring to alphabetical order of town name.  All other fields are 
rearranged along with the town field. 
 
What is the largest town in Hartford County? 
Glastonbury, 52.5 sq. miles. 
 
What is the smallest town in Middlesex County? 
Essex, 12.2 sq. miles. 
 
According to this dataset, what is the total area of Connecticut? 
5008.2 sq miles.  Find this using Statistics for the TOWN field and looking at the Sum. 
 
According to this dataset, what is the average town size? 
29.6 sq. miles.  Find this using Statistics for the TOTAL_SQMI field and looking at the Mean 
 
According to this dataset, what is the biggest town in Connecticut? The smallest? 
The biggest is New Milford at 40,883.67 acres.  The smallest is Derby at 3471.81 acres.   
 
What town in Connecticut has the highest population density? What is the density? 
Bridgeport with 13.23 people per acre.   
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What town in Connecticut has the lowest population density? What is the density? 
Union with .036 people per acre. 
 
What is the mean population density for all towns in Connecticut? 
1.37 people per acre. 
 
How many towns have a population density over 10? What are they? 
3 towns – Bridgeport, Hartford, New Haven 
 
 

This concludes Exercise 3b. 
 
If you have finished and the class is still working on the exercise, move 
on to the extra credit below.  
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Extra Credit 
Be sure your Exercise3.mxd is still open.  If not, open it. 
 
 

Æ Advanced Calculations 

Question: How does the population density in 1950 compare to the population density in 
2000 for Connecticut’s towns? 
 
Which towns have changed the most? 

 
 
Which towns have changed the least? 

 
  
How much have they changed? 

 
 
Do you see a geographic reason for the differences? 

 
 
A suggested approach:  

- Add a double field to your table to hold a 1950 Population density calculation. 
- Use the Field Calculator to populate the field. 
- Add another new field in your table that will hold the change in population density. 
- Use the Field calculator to calculate change.  This will be a subtraction, such as  

2000 Population Density – 1950 Population Density. 
- Negative values indicate a decrease in population density and positive values 

indicate an increase.   
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Exercise 3c: Selections and Queries 
 
Exercise 3c is designed to teach you how to conduct simple to complex queries of geospatial 
data.  ArcMap provides a variety of methods to facilitate this process from clicking on a feature 
and retrieving attribute data to constructing complex logical questions that retrieve only a subset 
of data that meet specific search criteria. In this exercise you will learn how to: 
 

- Select features using interactive selection tools, by attributes using queries, and by 
location 

- Explore selectable layers and selection options 
- Work with a definition query 
- Create new feature classes by saving selected features 

 
A point to remember as you work through this exercise is that operations performed on the 
cartographic data in the data frame also are reflected in the attribute table(s) of the layers you 
are working with. Whenever you select a layer feature you also are selecting its corresponding 
record in its attribute table. Remember the BIG PICTURE. In a GIS, many things are 
interconnected and there are often many ways to accomplish the same task. 
 
 
Getting Started 

- Open ArcMap.  For detailed instructions, refer to Exercise 1a.   
- Open Exercise3.mxd that you saved in the last exercise.   

 

Æ Selectable Layers  

The selectable layers settings and selection options will influence the interactive selection and 
other methods that you will use next.   
 
Only features in layers that are selectable can be selected.  We want to be sure that 
towns_election is the only layer whose features can be 
selected.   

- In the Table of Contents, choose List by 

Selection .   
- Click this icon , called Click to toggle 

selected, to move layers from the Selectable list 
to the Not Selectable list and vice versa.  For the 
purpose of this exercise, be sure towns_election 
is the only selectable layer.   
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Æ Selection Options 

- Click on the Selection menu on the 
Main Menu at the top of the ArcMap 
interface and choose Selection 
Options. 

- The Selection Option box contains 
a number of settings that influence 
how selection works and looks.  
Study the box for a moment.  If you 
are so moved, change the selection 
color. 

- Close the selection options box.   
 
 
 
 
 

 

 

 

 

 

 

Æ Interactive Features Selection 

- Set up your ArcMap interface. Be sure you can see 
- the map of towns_election 
- the Table of Contents as List By Selection 
- the attribute table for towns_election  

 
SELECT FEATURES TOOL 

- Click on the Select Features icon on the Tools Toolbar .   
 

 
 

- Click anywhere on the map.   
- Notice  

- how a town (or two) becomes selected 
- that the selected town is listed under “selected” in the Table of Contents 
- that the selected town is selected in the table (to see only selected features click on 

the  icon at the bottom of the table) 
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INTERACTIVE SELECTION METHOD 
By default, the selection method is set to Create New Selection.  This means that each time you 
clicked on a new town, a new selection was performed and whatever was previously selected 
was unselected.  The Interactive Selection Method lets you choose between: 

- Create New Selection 
- Add to Current Selection 
- Remove From Current Selection 
- Select From Current Selection 

 
- From the Main Menu’s Selection dropdown, hover your mouse over Interactive 

Selection Method and select Add to Current Selection.   

 
 

- Click on the Select Features icon .   
- Click on the map.   
- Notice  

- how towns are added to the selection each time you click 
- that the selected towns are listed under “selected” in the Table of Contents 
- that the number, here 8, in the Table of Contents shows how many features are 

selected  
- in the attribute table, that the towns are selected 
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- in the attribute table, it shows how many records are selected

. 
- At the bottom of the table is the Show Selected Records button. Click it and notice 

that only the selected records are listed.  Non-selected records are hidden from view.   
 

 
 
 
 
 

- Click Show all records to show all records. 
- If you have time, experiment with the other two interactive selection methods -  

Remove from Current Selection and Select from Current Selection.    

Æ Clear Selected Features 

There are many ways and places to clear the selected features.   
- Choose one of the methods below to clear the selected features.   

- In the table, click the Clear Selection icon 
- In the table, on the Table Options menu, choose Clear Selection 
- In the table, in the Row Box menu (right-click to open), choose Clear 

Selection 
- In the Table of Contents, click on the Click to Clear Layer Display icon 
- In the Table of Contents, right-click over the layer name and choose Clear 

Selected Features 
- On the tools toolbar, click the Clear Selected Features icon 
- On the selection menu, choose Clear Selected Features 
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Æ Select by Attributes Query Builder 

Features can be found and selected based on their attribute values.  For example, you can 
construct a question such as “Select all towns that had a 2000 population over 50,000.”  You 
can also build compound queries such as “Select all towns that had a 
2000 population of over 50,000 and a 1998 crime rate of less than 50 per 
1,000 people.”  
 
When you create a compound query you can use AND, NOT, OR and 
LIKE. 
 

- On the Selection menu, choose Select By Attributes.   
 
You will construct a query that first finds all 
the towns with a 2000 population greater 
than 50,000.  Then we will add a second 
part that finds, of those towns, which had a 
crime rate in 1998 that was lower than 
50/1000 people. 
 
- Fill out the Select By Attributes box so 

that  
- (1) towns_election is the layer 

that is being queried.   
 

- (2) You are creating a new 
selection.  This is another place 
where you can change the 
Interactive Selection Method. 

 
- (3) Double-click on POP_2000 to 

add it to the query box below.   
 

- (4) Click on the > sign.  
 

- (5) In the box, type 50000. 
 
- Click Apply.   
 
You should have 17 towns selected and the map should look like this. 

 

1  
2 

5 

3 

4 
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- Open the attribute table (right-click over towns_election in the Table of Contents 

and choose Open Attribute Table) if it’s not already open. 
- Verify that 17 records are selected.   
- Click on the Show Selected Records button at the bottom of the table.   
- Right-click over the POP_2000 field and select Sort Descending.   

 
Which town has the greatest population in 2000? 

 
 

- Go back to the Select By 
Attributes window.  It should still be 
open.  If not, open it.   

- 1. Click the And button to add “And” 
to the query. 

- 2. Scroll down the field list and 
double click on CRIMERAT98 to 
add it to the query. 

- 3. Click the < button 
- 4. Type in 50.  
- Click OK.   

 
Seven towns should be selected.  
 
Of the big towns in Connecticut (more than 
50,000 people), which 7 have the lowest crime 
rate?  

 
 
 
 

 
 
Let’s try another. We want to know: Which towns had over 80% of the voters vote for Hillary 
Clinton in the 2016 election? 
 

2 

1 

4 

3 
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We could do this work in the attribute table by adding a new field and using the field calculator 
to populate the data.  For now, we just want to show them on a map so a query is the perfect 
method.   
 

- Clear your selection.   
- From the Selection menu, choose Select By Attributes. 
- If a query is still in the query box at the bottom, click the Clear button. 
- Be sure you are still working on the towns_election layer and you are creating a 

new selection. 
- Double-click CLINTON to add it to the query. 
- Type in the divide symbol / . 
- Double-click the TotalVote filed to add it to the query. 
- Click the > button.   
- Finally, type in 0.8.   

 

Your query should look like this:   
 

- Click Apply.  
 

How many towns had more than 80% of the votes for Clinton? What towns were they? 

 
 
 
 
If you have time, try asking and answering a similar question: 
Which towns had over 60% of the voters vote for Trump? 

 
 
 
 

 
 

- Clear any selected features. 
- Close any windows or tables that might be open. 

 

TIP:  The Select By Attributes window also includes buttons to Save... and Load... 
expressions. If you have a particularly complex expression or one that you might want 
to use repeatedly or in another ArcMap document, then saving and loading the 
expression would be a useful technique to employ. Also, when you save an expression 
it is saved as a file with an exp extension. This file could be used by another user, e-
mailed to a colleague or shared in other ways. 
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Æ Creating a Definition Query 

So far, we have displayed our selection on the map but we have not used the map to make a 
selection.  In this step, you will add the roads to your map, set a definition query so that only the 
major highways are visible, and use a highway to select towns around it.   
 
ADD ROADS 

- Click on the Add Data button. 
- Use the Look in: area of the window to navigate to the following folder: 

 
C:\GISEd10\ 
 

- Double-click on the CT_Data.gdb. 
- Click on ROADS. 
- Click Add. 
- The ROADS layer will be added to the Table of Contents and will be drawn in a 

default color in the Display Area.  
 
By default, all the roads are visible.  We are only interested in the major highways.  
There are several ways to “hide” the other roads.  One handy way is to use a 
Definition Query.   
 

 
 

- If your Table of Contents is still displaying “List by 
Selection”, change the view option to “List by Drawing 
Order”. 
  

- Right click over ROADS and select Properties.   
- Click on the Definition Query tab in the Layer Properties 

window.   
 

 
 

- Click on the Query Builder button.   
 
You will use the ROUTECLASS attribute to select only interstate highways for display.   
 

TIP:  Creating a definition query allows you to display only a subset of the 
features in a layer based on the layer’s attributes. 
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- (1) Double-click on 
ROUTECLASS to add it to 
the query at the bottom of the 
Query Builder window.   
 

- (2) Click the = sign. 
 

- (3) Click Get Unique Values.  
This will list all the values that 
exist in the ROUTECLASS 
attribute in the table. 

 
- (4) Double-click Interstate to 

add it to the query.   
 
- Click OK. 

 
 
 
 
 

 
 

- Click OK to close the Layer Properties window. 
 

Æ Select by Location 

- Only the interstates should now be visible in your 
map.   

 
In the next Module, you will learn how to change the color and 
symbols, called symbology.  Now we want to find all the towns 
that have an interstate.   
 

- From the Selection menu on the Main Menu, choose Select By Location. 
 

- Choose to  
o select features from 
o towns_election 
o with the Source layer ROADS 
o Use the default Spatial selection method of 

Target layer(s) features intersect the Source 
layer feature. 

- Click OK. 
 

 

CAUTION: Although you may be tempted to type the query as it 
appears in the graphic, you may make an error in the syntax or 
punctuation.  Use the steps above to ensure that your query will work. 

1  

2 
4 

3 
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Notice how all the towns that contain an interstate are selected.  If you have time, experiment 
with other selection methods.   
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Æ Export Selected Features 

It is often beneficial to create a new layer that consists only of a subset of features.  Here, we 
want to create a layer than contains only towns that have a major interstate. 
 

- If necessary, in the Table of Contents, go back to 
List By Drawing Order. 
 

- Right-click over towns_election and select Data then select Export Data. 
 

 
 

- Choose to Export: Selected features 
- Click on the yellow folder to set the Output feature class.  
- Choose to save the file as a File and Personal Geodatabase feature class in the 

CT_Results.gdb. Name the dataset towns_with_interstates.  
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- When ArcMap asks if you want to add the 

exported data to the map as a layer, select 
Yes.   

 
- Your new layer, towns_with_interstates, 

is added to the display.  Try turning off all 
the other layers. 
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Tips on constructing query expressions 
 
When using Select By Attributes it is important to be able to build correct expressions.  The 
following is a list and a brief definition of the operators that you can use in selection 
expressions. 
 

= equals 
> greater than 
< less than 
<> not equal to 
>= greater than or equal to 
<= less than or equal to 
( ) parentheses to enclose parts of expressions; these are evaluated first 
and both expressions MUST be true 
or only one of the expressions needs to be true 
not excludes 
like use with wildcards to perform partial string searches  
_ one character wildcard for coverages and shapefiles 
% any number of wildcard characters for coverages or shapefiles 
? one character wildcard for geodatabases 
* any number of wildcard characters for geodatabases  

 
Field names for shapefiles are always enclosed in double quotes “  “.   
Field names for geodatabases are enclosed in square brackets [ ]. 
Text strings are always enclosed in single quotes ‘  ‘. 
 
Examples of some typical expressions for the TOWNS shapefile: 
 
“County” = ‘Hartford’        finds all towns in Hartford County 
 
“County” = ‘Hartford’ or “County” = ‘New London’    finds all the towns in both Hartford and  
         New London Counties  
 
“County” LIKE ‘New%’    finds all towns in New Haven and New  
       London Counties 
 
"COUNTY" = 'Hartford' AND "TOTAL_SQMI" > 25    finds all towns in Hartford County that  
       are larger than 25 square miles in area 
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Save Your Work!  

Æ Save Your Map Project (.mxd) 

 
- To save the changes you have made, click on File on the Main Menu and select 

Save from the menu that appears.   

Let’s Review! 
Congratulations on completing Exercise 3c! In this exercise you learned how to create both 
simple and complex queries of geospatial data. Queries are used to answer questions about 
your data and to select out desired features of a dataset based on attributes or location. In this 
exercise you learned how to:  
 

✓ Change selection options: Selectable Layers and Selection Options influence which 
layers can be selected and how. 

✓ Select features based on attributes: Layer features can be found and selected based 
on their attribute values. Simple or compound queries can be created using one or more 
attribute values. The Query Builder allows you to construct a query without any 
knowledge of SQL (Structured Query Language). 

✓ Create a definition query: Definition queries allow you to work with a subset of a 
dataset without having to create a new data layer or without having to permanently 
delete features. When a definition query is established for a layer, ArcMap will only 
display features with attributes that apply to the defined query expression, however all 
attributes will be retained in the underlying data. 

✓ Select features based on location: Layer features can be found and selected based 
on their spatial relationships to all or selected features in another layer. 

✓ Create a new feature class or shapefile: Once you have selected features using any 
of the techniques covered in this exercise, you can export them to a new shapefile. If 
you select Export Selected Features only when you export the data, only the features 
that are currently selected will get exported to the new dataset. 
 

This concludes Exercise 3c.  
 
If you have finished and the class is still working on the exercise, move on to the extra credit 
below.  

Extra Credit 
 
Be sure your Exercise3.mxd is still open.  If not, open it. 
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Æ Select By Location Using Selected Features 

SET SELECTABLE LAYERS 
- In the Table of Contents, click to view List By Selection.   
- Be sure no features are selected (Clear selection if necessary). 
- Click on the Click to toggle selected icon next to towns_election to make it not 

selectable.  Only ROADS should be selectable.   
 

 
 
SELECT AN INTERSTATE 

- Click on the Select Features icon .   
- Click on Interstate 91.  It is the north-

south highway cutting through the middle 
of the state.  In the Table of Contents, 
notice that one record is selected. 

 
SELECT BY LOCATION DIALOG 

- On the Selection menu, choose Select By 
Location. 

 
- Choose to  

o select features from 
o towns_election 
o with the Source layer ROADS 
o be sure Use selected features is checked 
o Use the default Spatial selection method of Target layer(s) features 

intersect the Source layer feature. 
- Click Apply. 
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- Notice how the map changes.  Experiment with different Spatial selection methods.   
 

Æ Select By Graphics 

- Open the Drawing toolbar. 
- Choose to draw a shape, such as a 

rectangle or circle, or a line on your map. 
- Be sure the graphic is selected.  

Selected graphics have small squares on 
the edges.  Below, the circle graphic is 
selected and the square graphic is not.  

- On the Selection menu, choose Select By 
Graphics.   

- Experiment with Select By Graphics.   
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Exercise 3c Answers 
 
Which town has the greatest population in 2000? 
Bridgeport with 139,529 people 
 
Of the big towns in Connecticut (more than 50,000 people), which 7 have the lowest crime rate?  
Greenwich, Bristol, West Hartford, Fairfield, Hamden, Stamford, Milford 
 
How many towns had more than 80% of the votes for Clinton? What towns were they? 
4 towns – Bloomfield, Bridgeport, Hartford, New Haven 
 
Which towns had over 60% of the voters vote for Trump? 
12 towns – Beacon Falls, Bethlehem, Hartland, Harwinton, Oxford, Plymouth, Prospect, 
Sterling, Thomaston, Voluntown, Watertown, Wolcott 
 
 
 

Æ Create Graph 

- Open the attribute table of TOWNS. 
- On the table menu, select Create Graph. 
- Explore the graphing options and create a graph that successfully and clearly shows 

something about the data in the table.    
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Exercise 4a: Symbology 
 
Most of the time, you will want to modify the default colors and styles that ArcMap uses to 
display cartographic data. This exercise is designed to provide a basic introduction to 
symbolization operations. In this session you will work with Layer Properties to learn how to 
create a variety of symbols and how to save this information as a layer file. Layer files store 
symbols assigned to features and/or feature classes. The techniques learned in this exercise 
also will facilitate the preparation of data for printing or publication.  In this exercise, you will: 
 

- Set the Map Document Properties 
- Change single symbols for points, lines and polygons 
- Make thematic maps of points (wells), lines (roads) and polygons (towns) 
- Classify numeric data to show voting trends 
- Create and open a layer (.lyr) file 

 

Getting Started: Opening ArcMap 
- Open ArcMap.  For detailed instructions, refer to Exercise 1a.   
- Open a New Map.  Remember, to click on New Maps and then a Blank Map.  

 
 

Set Up Your Map Document 

Æ Save Your Map 

- On the File menu, select Save As OR click the Save icon .   
- Name the file Exercise4a and save it in the Projects folder.   
- Click Save. 

Æ Set Map Document Properties 

Click on the File drop-down menu and click Map Document Properties.  A window will open in 
which you can enter information about the map document that you are about to create.  You can 
use the Map Document Properties box below as a guide. 
 



 Ex. 4a: Page 112  
 

 
 

- Fill out the text fields in the window including Title, Summary, Description, Author 
and Credits.  

- Set the Default Geodatabase.  Click on the folder icon and navigate to the Results 
folder and the CT_Results.gdb.   

- Click Add.  
- For now, don’t bother clicking Make Thumbnail.  Make Thumbnail will take a static 

snapshot of the map at that moment.  Because it is still an empty map, there is no 
point in creating a thumbnail.   

- Click OK. 
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Æ Add Layers to ArcMap 

- Click on the Add Data button  on the Standard Toolbar. This will open the Add 
Data window. 

- Click on the Go to Default geodatabase  icon. This will take you straight inside 
CT_Results.gdb because you set it as the default geodatabase in the last section. . 
 

 
 

- Double click on the towns_election layer to add it to 
your map.  If you don’t have this layer, talk to an 
instructor.  To refresh your memory, this layer 
originated as just towns, then you joined population data (towndata.dbf) and election 
data (2008_Election_Results.xls) to it, then exported it as a new feature class called 
towns_election in the CT_Results.gdb. 

- Click Add at the bottom of the window to add the layer to ArcMap.  
The towns_election layer will be added to ArcMap’s Table of Contents. A randomly selected 
color will be assigned to the layer to symbolize the towns.  
 
You will now add roads and wells to your document. 

- Click on the Add Data button. 

Default Geodatabase:  
The default geodatabase is simply the geodatabase that you'll be working with the most as you 
work with the mxd.  There are several advantages to specifying a default geodatabase: 

- It is easy to get to.  Simply click the Go To Default Geodatabase button  in any 
dialog in which you access or save data, or at the top of the Catalog window.  

- In certain dialogs, the default geodatabase is shown with this icon .  In 
the Catalog window's tree the default geodatabase's name is also shown in bold. 

Later we will talk about geoprocessing tools that require certain settings.  If a default 
geodatabase has been set, some settings are done automatically.     

Store relative path names:  
If this box is checked, pathnames are stored as incomplete paths that are relative to the 
current location of this document on disk. This setting makes it easier to share or move the 
map document and its data because ArcGIS will resolve the paths to the data relative to the 
document's current location in the file system, rather than by full paths that include a drive letter or 
machine name.  

Store full path names:  
If this box is not checked, pathnames are stored in the document as full pathnames (also called 
'absolute' or 'complete' pathnames). The paths will contain a disk letter or machine name. This is 
the default option. 

TIP: Remember that 
geodatabases are containers 
for layers.   Layers inside a 
geodatabase are called 
Feature Classes.   
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- Use the Look in: area of the window to navigate to C:\GISEd10\Shapes. 
- Double-click on the APAWELL.shp file.   
- It should be added to the Table of Contents in your map document.    

 
- Click on the Add Data button. 
- Use the Look in: area of the window to navigate to C:\GISEd10\Shapes. 
- Click on the ROADS.shp file.  Hold down the CTRL key and then click on 

STATE.shp.     
- Click Add. 
- Both should be added to your map document.    

 

 
 

- Order your layers in the Table of Contents so that APAWELL is on the top of the 
list followed by ROADS, towns_election, and STATE. 
 

Each layer is added using single a symbol with a default color. Beautiful! Yours will probably 
look different from the map below because your default colors may vary. Now, we will work with 
each layer to change the symbols so they are clear and meaningful.   
 

 
  

TIP: There are several ways you can add data to a map document. 
1. Use the Add Data button. 
2. Right click on the Data Frame name and select Add Data. 
3. Use the File menu and select Add Data. 
4. Drag the datasets, one at a time or as a set, from ArcCatalog into ArcMap.  
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Changing a Layer’s Symbol 
To change the color and/or pattern of all features within a layer, click on the layer’s symbol that 
is beneath the layer name in the Table of Contents.   
 

Æ Line Symbol Selector 

Change the ROADS layer to fat red lines.   
 

- Click on the symbol below the layer ROADS in the Table 
of Contents.   

- A Symbol Selector window will open that displays many 
different line patterns and colors.  Click on the fat red line, 
labeled Highway, and then click OK.  
 

 
The ROADS layer will redraw using 
the line symbol you selected.  WOW.  
Repeat the process and try different 
predefined symbols.  
 
 

 
 
 
 
 
 

Æ Polygon Symbol Selector 

Use the same steps above to change the color and pattern of polygons in 
your town election layer.   
 

- Click on the towns_election layer’s symbol to open the Symbol 
Selector.   
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Note that when you click on the fill or outline color buttons that a 
window opens providing you with many predefined colors.  
However, at the bottom is the More Colors… choice.  Clicking it 
will open a Color Selector window that gives you complete 
control over the color to use.   

 
RGB stands for Red, Green, Blue.  
The RBG values are added together 
to create any color of the rainbow.  
You can use the slider bars or type 
in a known RGB value to get an 
exact color. 
 
 
 
 

 
- Click on the small arrow next to RGB and select HSV.  HSV stands for 

Hue, Saturation and Value.  HSV is the easiest to use to adjust 
colors.   

 
  

- You can use one of 
the many predefined 
symbols for polygons.  
OR,  
o access many 

additional colors 
to fill polygons   

o specify a width for 
polygon outlines 
as well as choose 

o a color for the 
outlines.   

- Experiment with the 
Symbol Selector and 
create your own fill 
and outline colors and 
outline widths.   
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New Color Starting Color 
 

- After you have selected a color, click OK to return to the Symbol Selector. 
- Click OK on the Symbol Selector to apply the changes to the towns_election layer.   

 

Æ Point Symbol Selector 

Change the symbols for the APAWELLS layer. 
 

- Click on the symbol below APAWELLS.   
- On the Symbol Selector click the button named Style 

References.  This will open a list symbol groups that can be 
checked on and used.   

- Scroll down and check the box next to Environmental.   
- Click OK.   

 

TIP: Hue is the gradation of color that allows it to be called red, yellow, 
green, etc.  Saturation is a measure of the vividness of the color.  As a color 
becomes less saturated, it tends towards gray.  Value is measure of how 
much light is reflected from an object relative to white. 

With the Color Selector you can adjust colors to be 
whatever you need.  You can type in values from 0 to 
360 for Hue and 0 to 100 for Saturation and Value. 
 
The slider bars have colors above them to indicate 
the resulting color that will be created as you 
reposition the pointer beneath any of the three sliders.   
 
You also can click within the rainbow box of colors at 
the bottom to get close to a specific color and then 
adjust it with the sliders.   
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Notice that the new category, called Environmental, is visible along with the symbols it 
contains.  Symbol Reference groups are listed in alphabetical order. 
 

- Many of the symbols have large sizes so you may want to set the Size to 8 points; 
otherwise the display may become cluttered with symbols that are too large.   

- You also can change the symbol Color as you did above.   
- When done selecting and setting the symbol, click OK.   

 
 
By now you should have a feel for how you can use the Symbol Selector to modify all features 
in a layer. However, uniformly changing the symbolization may make a more attractive display 
but it doesn’t tell you anything about the underlying data.  And, let’s face it, that’s the power of 
the GIS.  That’s what you will look at next. 
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Making Thematic Maps 
Thematic maps use different symbols to visually differentiate ranges of attribute values or 
among attribute classes. In this step you will symbolize the APAWELLS, towns_election, 
STATE and ROADS layers to highlight different feature classes. 
 

- Turn off (uncheck) the towns_election and ROADS layers. 
 

- Change the STATE layer symbol to a light yellow. This will serve as the background 
for the APAWELLS layer. Do this simply by clicking on the symbol beneath STATE 
and changing the Fill Color. 

- Open the APAWELLS attribute table by right clicking on the APAWELLS layer name 
and selecting Open Attribute Table. 

- Inspect the column named WELLSTATUS and note that there are two values – 
Active and Inactive.  

You will assign different symbols to visually discriminate between the two classes.  You will use 
a unique value classification which is appropriate when the number of classes is relatively small 
- say 10 or fewer. 

- Close the APAWELLS attribute table. 
- Right click on the APAWELLS layer and select Properties.   Alternatively, you can 

double click on the layer name to open the Layer Properties window. 
- Click the Symbology tab. 

 
By default, ArcMap assigns a Single symbol to all features in each layer. 
 

 
 
Note that other options exist for assigning symbols – Categories, Quantities, Charts and 
Multiple Attributes. Since the APAWELLS layer has only two classes for wells, you will use 
the Unique values choice under the Categories option. 
 
 
 

Æ Symbolizing Point Categories 

- Click on Categories on the left side of the Symbology window. 
- Select WELLSTATUS from the list called Value Field (see image on following page 

for reference). 
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- Click the Add All Values button. 
- Change the Label fields under the WELLSTATUS heading to Active Wells and 

Inactive Wells by typing them.  What is entered here will appear in the ArcMap 
Table of Contents as well as the legend in a layout (next exercise). 

- Since all wells are assigned to either the active or inactive class, there will not be any 
other values.  Uncheck the box next to <all other values> so it will not appear in 
the legend in the Table of Contents.   
 

- Double-click on the symbol next to ACTIVE to open the Symbol Selector.   
- Choose a symbol to represent active wells.  You may want to add more predefined 

symbols by clicking on the Style References.. button and then checking on more 
categories. You can also use the Search window at the top of the Symbol Selector 
to search for a keyword such as “well.” 

- Double-click on the symbol next to INACTIVE to open the Symbol Selector.   
- Choose a symbol to represent inactive wells.   
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- Before applying the 

symbols, change the 
name of the layer from 
APAWELLS to Public 
Wells by clicking on the 
General tab and entering 
the new layer name. 

 
- Click OK to apply the new 

symbols and layer name.   
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Æ Symbolizing Line Categories 

- Turn on the ROADS layer by checking the box next to the layer name in the Table of 
Contents. 

- Right click on the ROADS layer and select Properties.   Alternatively, you can 
double click on the layer name to open the Layer Properties window. 

- Click the Symbology tab. 
- Click on Categories. 
- Select ROUTECLASS from the list called Value Field. 
- Click the Add All Values button. 

 
Notice that four values exist in the ROUTECLASS attribute: Connector, Interstate, State 
Route and US Route.   
 

- Click on the colored line next to 
Interstate.   

- Select a predefined symbol or 
create your own symbol to 
represent Interstates.  You may 
want to turn off Style 
References, such as 
Environmental, or add Style 
References, such as 
Transportation. 

- Click OK to close the Symbol 
Selector box. 

- Click on a colored line next to another road type (Connector, State Route or US 
Route) and pick a symbol for that road type. 

- Uncheck the <all other values> class. 
- Repeat for all road classes until you have a properly symbolized road layer.   
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Æ Symbolizing Polygon Categories 

Another example of a unique value classification is to use symbols to create a county or 
planning region map from the towns layer. You will recall that the TOWNS layer, which was the 
origin of the towns_election data you are using here, has attributes that define the county that 
each town belongs to. 
 
To make a county map: 

- Turn off all layers except the towns_election layer.  
- Double click on towns_election to open its Layer Properties window.  
- Click the Symbology tab.  
- Click on Categories then click on Unique Values.  
- In the Value Field select COUNTY. 
- Click the Add All Values button. This will add all the unique values in the field 

COUNTY. (Note: if there are misspelled county names they will be listed as unique 
values. This is a common problem with attribute data.) 

- If you desire, change the Color Ramp by clicking on the current Color Ramp and 
choosing a different one from the list.   

- Click OK to apply the symbols. 
 
View the resulting map. Notice that the eight counties are each displayed using a unique color 
and that each town is outlined. If you want to display just the counties you would have to turn 
the outlines off for the towns.   
 

 
 
 
 
 
 
 

TIP: To get rid of the outlines for all the 
towns while keeping county colors:  
- Open the Layer Properties 
- Right-click over one of the colors 

and select Properties for All 
Symbols 

- Change the Outline Color to No 
Color.   

- Click OK.   
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Classifying Numeric Data 
In the previous step you symbolized categorical data. The APAWELLS points had just two 
values for WELLSTATUS; the ROADS lines had four values for ROUTECLASS and the 
towns_election polygons had eight values for counties. In all cases, the values described 
unique, non-overlapping categories or groups. They did not represent a measured value that 
could be grouped, ranked, etc. 
 
In this step you will classify and symbolize numeric data – data that measure some variable 
such as population, per capita income, percent of people completing high school, number of 
registered voters, square footage of buildings, assessed value of residential buildings, etc. 
While these data are unique, they are too numerous to be displayed in a meaningful way until 
they have been grouped and the group is assigned a symbol. 
 

- In your map document, turn off all layers.   
- Click on the Add Data button and then the Go to Default geodatabase icon .  

This will take you straight inside CT_Results.gdb because you set it as the default 
geodatabase in the last section. . 

- Double-click on towns_election to add it to your project.   
 

Yes, you already had a towns_election layer in your map but we don’t want to lose the 
symbology you already created.  Adding another copy of the same shapefile or feature class 
allows there to be more than one way to symbolize the same source data in the same data 
frame.   
 

Extra Credit:  
How would you symbolize the towns_election data so that is a single-symbol statewide 
layer, similar to the STATE layer that you used as a background for the wells in the 
Symbolizing Point Categories section? 
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- Right click on the newly added towns_election layer and select Properties.   
Alternatively, you can double click on the layer name to open the Layer Properties 
window. 

- Click the Symbology tab. 
- On the left side of the window, click on Quantities and select Graduated colors. 
- Select Clinton in the Value Field and TotalVote as the Normalization Field. When 

you normalize data, you divide it by the Normalization: field. Using these settings 
will create a map that displays the fraction – as a decimal value – of the percent of 
the voters that voted for Clinton in each town. 
 

 
 

By default ArcMap will create five classes using Natural Breaks as the Classification Method. 
This method groups data such that the differences between groups are great while the 
differences within groups are small or at least smaller. 
 

 
 

- Click the Classify button to open the Classification window.  
- Change the Classification Method to Equal Interval.    
- Change the Break Values so they occur at 0.5, 0.6, 0.7, 0.8 and 1.0.  You can drag 

the blue lines or type the values in under Break Values (see image on following 
page).  Notice how the Classification Method changes from Equal Interval to 
Manual when you make these changes.    

TIP: Normalization is the process of dividing one numeric attribute value by another in order 
to minimize differences in values.  Normalizing the values in your classification field can show 
how your data relates to the values of another field which can make the data easier to read 
and understand. 
 
The following options are available: 

- Normalize by any attribute in the table.  Usually attributes that contain totals or total 
area are used. 

- <None> - No normalization will be applied 
- <PERCENT OF TOTAL> - Normalize the Value field by its percentage of the total. 
- <LOG> - Normalize the Value field by its log value. 
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- Click OK to close the Classification window.   
- On the Layer Properties Symbology tab, click on the color ramp to choose a new 

color ramp.   
- Change the Labels to be more meaningful.  The decimal values represent percent 

so change the labels to read percent.  
 

 

Other 
Classifications 

To change class breaks 
- Drag the blue dividers or  
- Type numbers in the Break 

Values box  
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- Click on the General Tab in Layer Properties. 
- Change the Layer Name: to CT Town Election Results.  
- Click OK to close the Layer Properties.   

 
 

 
 
 
What does the new layer symbology tell you about the 2016 election results? 

 

 
 

Save Symbology in a Layer (.lyr) File 
Setting up symbols can be a time consuming process.  Fortunately, ArcMap allows you to save 
and reuse symbols that you have created for a layer.  Symbology is saved in a special “layer” 
file (not to be confused with a geospatial data layer in the Table of Contents) that contains 
instructions to ArcMap about how to display features in the dataset.  Layer files also include the 
pathname to the geospatial dataset that is to be symbolized.  The value of layer files is twofold – 
they conveniently store symbology information and they can be used to add symbolized 
geospatial data to ArcMap. 
 
You will create a Layer File of the towns_election layer displayed so that it shows how much of 
the total vote was for Clinton.   

TIP: Change the Text in the Table of Contents by clicking once on the text to select it and a 
second time to make it editable.  Note: Changing the layer name in the Table of Contents 
also changes it in the General tab of Layer Properties.  Changing the labels next to the color 
swatches in the Table of Contents also changes the labels on the Symbology tab of Layer 
Properties.     
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- Right-click on the CT Town Election 

Results (see TIP box above for notes on 
how to rename layer) layer in the Table of 
Contents.  It doesn’t matter what the layer 
name is.    

- Select Save As Layer File… 
- In the Save Layer window, navigate to 

C:\GISEd10\Results folder and save the 
layer file as ClintonVote2016.lyr.  Click 
Save.  

 
Let’s take a look at how the Layer file works. 

- In the Table of Contents, right-click over 
CT Town Election Results and select 
Remove to remove the data layer from the 
project. 
 

 
 

- Click on the Add Data button.  
- Navigate to the C:\GISEd10\Results folder and select the layer file 

ClintonVote2016.lyr.  
- Click Add to add it to the Table of Contents. 
- The towns_election dataset will be added to the project, but instead of default 

symbology, each town will be drawn based on the symbology you defined and saved 
to the .lyr file.   

 
 
 

REMEMBER! The .lyr file does NOT contain the data itself! It simply points 
to the dataset, in this case, the towns_election feature class, and contains 
instructions for how the features in that dataset should be displayed on the 
map.  A .lyr file will not function without an associated dataset (.shp or 
geodatabase feature class). 

 
 

 

TIP: Layer files cannot be saved inside geodatabases. Bummer. 

.lyr files always have to point 
back to the “source” dataset!  
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Save Your Work!  

Æ Save Your Map Project (.mxd) 

 
- To save the changes you have made, click on File on the Main Menu and select 

Save from the menu that appears.  Save it as Exercise4a.mxd in the Projects 
folder. Since we already saved it once, you can overwrite the existing 
Exercise3a.mxd.    

 

Let’s Review! 
Congratulations on completing Exercise 4a! This exercise was designed to introduce you to 
tables in ArcMap. A number of topics were discussed including. 
 
This exercise covered all of the basics of symbology in ArcMap. A number of important 
concepts were covered including: 
 

✓ Single symbols: When your data is symbolized with a single symbol, all features are 
drawn with the same symbology properties. The symbol selector can be used to change 
features such as size, color, pattern, or symbol. 

✓ Categorical symbols: Categorical data have values that describe unique non- 
overlapping groups of attributes. Different symbols can be used to display a set of 
features with the same attribute value in a layer. 

✓ Numeric symbols: When data is represented as a measured amount that can be 
grouped or ranked, you can symbolize it using a quantitative measure. There are several 
methods for doing this: graduated colors, graduated symbols, proportional symbols, dot 
densities, and charts. 

✓ Layer files: Symbology for a layer, including labels, can be saved in a layer file. Layer 
files contain instructions about how to display features in a dataset. They include the 
pathname to the geospatial dataset that is to be symbolized, they do not include the data 
itself. 

 
 

This concludes Exercise 4a. You can 
keep the exercise open, you will use 

it in Exercise 4b. 
 
 
If you have finished and the class is still working on the exercise, move on to the extra credit 
below.  
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Extra Credit 
- Your Exercisera.mxd project file should still be open, if not, open it in ArcMap.  
- Resave the project to your C:/GISEd10/Projects folder as Ex4a_EC.mxd.  

 

Æ Choose Your Own Adventure 

Pick one or more of the following processes to experiment with additional symbology tasks. You 
will be using the towns_election layer for most of the symbology experiments.  It is beneficial to 
have multiple copies of this layer in your mxd so that it can be displayed many different ways.  
Choose one: 

- Click on the Add Data button and then the Go to Default geodatabase icon .  . 
- Double-click on towns_election to add it to your project.   

 
OR 
 

- Right-click over towns_election (which is likely called CT Town Election Results) 
in the Table of Contents and select Copy.   

- On the Edit menu, select Paste.  A second layer, with the same symbology, will be 
added to the Table of Contents.  You can now change the symbology of the copy.   

 
- Repeat so you have several copies in the Table of Contents.   

Categories: Unique Values, Many Fields  
Try using the Counties and Coastal Area attributes of towns_election.  
Or experiment with two other attributes that have discrete data values.   
 
What does Unique Values, Many Fields do? How might you color the 
classes to make them useful?  

 

Quantities: Graduated Symbols 
Try using one of the population attributes of towns_election.   
 
Try changing  

- the Symbols and their colors  
- the Background  
- Normalization field 

 
Quantities: Proportional Symbols 
 Try using one of the population attributes of towns_election.   
 
How are Graduated Symbols and Proportional Symbols different? 

 
 
Try changing  

- the Symbol Background 
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- the min and max values 
- the Appearance Compensation 
- Normalization field.   

 

Quantities: Dot Density 
Try comparing two attributes of the towns_election layer.  Comparisons 
could be: 

- Clinton Vote and Trump Vote 
- 1950 Population and 2000 Population 
- Total Vote and Population 2000 

 
How does a dot density map help display information? 

 
 
 

Charts: Pies, Bar/Column, Stacked 
Use the attributes from the town_election file to experiment with the three types of chart 
symbols – pie, bar/column and stacked.   
 

  
 
What is the most useful combination of chart type and input data that you can come up with 
given the attributes in town_election? 

 
  

Try changing  
- the input fields 
- the Symbols 
- Color Scheme 
- Normalization 
- chart Properties 



 Ex. 4a: Page 132  
 

  Exercise 4a Answers 
 
How could you symbolize the towns_election data so that is was a single-symbol statewide 
layer, such as the STATE layer that you used as a background for the wells in the Symbolizing 
Point Categories section? 
One way is to display all towns as a single symbol AND make sure that symbols does not have 
an outline.  If an outline is visible, it will outline every town (each record in the table) and not just 
the state.   
 
If you are interested in an outline of just the state border, a geoprocessing tool called Dissolve is 
the way to go.  You will learn about it in the ArcTools section of this class.   

 
 
What does the display tell you? 
 

 
 

- More towns in Connecticut fell in the 51-60% category than any other category. 
- The big cities (New Haven, Bridgeport, Hartford, New London) heavily favored 

Clinton.   
- Towns in the Housatonic River Valley were less favorable for Clinton, and therefore, 

likely favored Trump. 
This is just a sampling.  There are many more interesting observations. 
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What does Unique Values, Many Fields do? How might you color the classes to make them 
useful?  
It allows you to symbolize first on one attribute 
then further categorize the first attribute by a 
second.  There are many potential combinations 
where this could be used.  This example shows the 
Counties symbolized first, then the Coastal Area.  
The same fill color was used for each county, 
whether it was inside or outside the Coastal Area.  
A different outline was used for the Coastal Areas 
to separate them from the inland areas.   
 
 
 
 
 
How are Graduated Symbols and Proportional Symbols different? 
With graduated symbols, the quantitative values for a field are grouped into ordered classes.  
Within a class, all features are drawn with the same symbol.   
 
With proportional symbols, data is not classified.  Each symbols is sized to portray the value of 
the selected attribute.   
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Exercise 4b: Labels, Graphics and Annotation 
In the last exercise you were exposed to some of the basic techniques on how to customize 
map symbols and make thematic displays of attribute data.  This exercise will focus on how you 
can use text to add valuable information to a map display.  You will learn how to create labels 
from attribute data, how to place labels relative to map features, how to add freeform text to a 
map display and how to convert labels into geodatabase annotation. 
 

Getting Started: Label Basics 

Æ Set Up Your Map 

- You will start this exercise where you left off in Exercise 4a. If you have closed the 
exercise, start a new ArcMap session and open your Exercise4a.mxd.  
 

- Make sure the CT Town Election Results layer is turned on in your Table of 
Contents. This is the layer that you symbolized in Exercise 4a to show the percent 
of the total voting population that voted for Clinton in the 2016 election. If you 
removed this layer from your map, you can add it from your C:\GISEd10\Results 
folder.  

 
- Remove the Public Wells and STATE layers from the 

Table of Contents by right-clicking on the layer name 
and selecting Remove. The only layers you should 
have in the Table of Contents are ROADS and CT 
Town Election Results. If you have others, remove 
them. Save  your map as Exercise4a.mxd in your 
C:/GISEd10/Projects folder. 
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Æ The Labels Tab 

Labels are properties of a layer and can be formatted through the Layer Properties tab. In this 
step, you will set up basic labels for each of the 169 towns in the CT Town Election Results 
layer.  

- Right click on the CT Town Election Results layer and select Properties from the 
menu that appears to open the Layer Properties window. 
 

- Click on the Labels tab. This is where you will define the labels for the layer.  
 
- On the Labels tab, check the box next to “Label features in this layer.” Leave the 

Method set to “Label all the features the same way”. This will ensure that all of 
your town labels are formatted the same.  

 
- Under Text String, be sure the Label Field is set to TOWN. This is the field in the 

attribute table that will determine the label text. Whatever appears in the TOWN field 
for a record (in this case, it will be the town name) is what you will see on your map.  

 
- Leave the Text Symbol properties as the default Arial, size 8. Under Other Options, 

click Placement Properties…  
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- In the Placement Properties window, change the settings so that the polygon labels 
are Always horizontal and check the box next to “Only place label inside 
polygon.” Under Duplicate Labels, select Place one label per feature to ensure 
that towns are only labeled once. Click OK to return to the Layer Properties 
window.  

 
-  Click OK in the Layer Properties window to  
apply the labels.  
 
 
 
 
 
 
What happened? Did all of the towns get 
labeled? What happens when you zoom in or out 
on your map?  
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Æ Setting a Scale Range 

You can specify the range of map scales at which labels will be drawn on your map. If you are 
zoomed out beyond the minimum scale, the labels will not appear on your map until you zoom 
in farther.  

- Double click on CT Town Election Results to open its Layer Properties. 
- Click on the Labels tab again. 
- Click on the Scale Range button at the bottom of the window under Other Options. 
- A window titled Scale Range will open. Click on the radio button next to: “Don’t 

show labels when zoomed:”  
- Click on the down arrow next to Out beyond: and select 1:500,000 as your minimum 

scale. 

 
 

- Click OK to close the Scale Range window. Click OK to apply the change and close 
the Layer Properties window.  

- Click the Zoom to Full Extent  icon on the Tools Toolbar. Notice your labels 
disappear. 

- Click on the Fixed Zoom In  button on the Tools Toolbar several times until 
your labels appear. What is the scale now? _________________________ 

- When you have finished, return to the Layer Properties for CT Town Election 
Results. Click on the Labels tab and click on the Scale Range button at the bottom 
of the window.  

- When the Scale Range window opens, click the radio button next to “Use the same 
scale range as the feature layer” to return to your original scale range. Click OK to 
close the window. Click OK to close the Layer Properties.   
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Æ Using a Label Expression 

Label Expressions allow you to label your features with values from more than one field in the 
layer’s attribute table. In this step, you will label each town with the town name and the total 
number of votes for Hillary Clinton using a label expression. 
 

- Double click on CT Town Election Results in the Table of Contents to open the 
Labels tab under Layer Properties window again.  

- Click on the Expression button in the Text String box.  

 
 

- In the Fields box in the Label Expression window, scroll down until you find the 
CLINTON field. Click on it to highlight the field and then click the Append button. This 
should add it to the Expression box at the bottom of the window.  

 

 
 

- Click OK in the Label Expression window and OK in the Layer Properties window 
to apply the changes to your map.  
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You should now see two values in 
the text string for each town, the 
first part is from the TOWN (town 
name) field and the second is the 
value stored in the Clinton field 
(total votes for Clinton).  
Interesting, but probably only 
slightly helpful. If someone was 
reading your map, how would 
they know what the numbers 
represent? What if you wanted to 
create two lines of text rather than 
have both fields side by side? 
Glad you asked, let’s find out how 
to clean up these labels! 
 

Æ Formatting a Label Expression 

In this step, you will create a “stacked label” so that text appears on two lines and you will add 
text to the label expression to add context to the labels.  
  

- Open the CT Town Election Results, Layer Properties window again and return to 
the Labels tab.  

- Click on the Expression button to open the Label Expression window. You should 
see the label expression as it was set up in the previous step of this exercise.  

- In the Expression, add the text “vbnewline &” in between the first ampersand (&) 
and the first set of quotations. It should look like the image below. 
 

 
 

- In between the double quotes, add this line of text: “Total votes for Clinton: “. Be 
sure to include a space after the semicolon. The final expression should look like 
this:  
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- After you have completed your expression, 
click the Verify button. This will check your 
expression to be sure you entered is valid. It 
will also show you a sample of the label. If you 
get an error, go back to the expression and 
check for typos.  

 
 
 
 
 
 
 
 
 
 
 
 

- Click OK to close the Expression Verification window. Click OK again in the Label 
Expression window to return to the Layer Properties. Before we apply these labels, 
let’s make a final adjustment to our Placement Properties. 
 

- Click on the Placement Properties button in the Layer Properties. When the 
Placement Properties window opens, uncheck the box next to “Only place label 
inside polygon.” This will allow the labels to spill over the sides of the town 
boundaries when zoomed out to larger extents.  

 
- Click OK to close the Placement Properties window and OK again to close the 

Layer Properties window.  
 
Zoom to the Full Extent of your map so you can see the entire state.  
 
What do your labels look like now? How about the map, is it legible? What happens when you 
zoom in? 
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Æ Applying a Reference Scale 

When you create labels and apply them to a map, they will stay the same size when you zoom 
in/out, which as you saw in the preview step, can cause problems. To avoid this, you can set a 
Reference Scale. Reference Scales are properties of Data Frames. If you have multiple Data 
Frames in your project, each can have a different Reference Scale. Think of the Reference 
Scale as the data view’s display scale at which the text is appropriately sized relative to the 
cartographic features.  After the Reference Scale has been set you can zoom in/out and the text 
in the data view will scale up/down along with the cartographic features.  
 

- The easiest way to set a Reference Scale is to zoom in on your map to a scale in 
which your labels are appropriately sized and then set the Reference Scale. Use 
your zoom tools to zoom in on a portion of the state. As you zoom in, your labels will 
begin to fit within the town boundaries.  
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- When you have found a scale where the labels fit correctly within the towns they are 
labeling, right click on the data frame Layers and mouse over Reference Scale and 
then click on Set Reference Scale on the pop-up menu. 
 

- Now zoom in or out and note 
that the text changes size 
along with the features. 

- To return the display to the 
reference scale, right click on 
the data frame Layers and 
mouse over Reference 
Scale and then click on 
Zoom to Reference Scale 
on the pop-up menu. 

- You also can clear the 
reference scale and then 
reset it to a different scale if 
needed. 

 
 
Advanced Labels: Label Classes 
Label Classes allow you to specify different labeling properties for features within the same 
layer. For example, in a layer of city points, you may want to label the cities with larger 
populations with a larger font size than smaller cities. In addition, features in different label 
classes can be symbolized differently. For example, in this step of the exercise, you will create 

Data Frame 

Map Scale 
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label classes for the ROADS layer. Each road type (highway, state route, US route) will be 
symbolized differently and will be labeled with a different highway shield to represent the route 
type.  
 
 

- Clear the Reference Scale. Right-click on the Layers data frame name and hover 
your mouse over Reference Scale and select Clear Reference Scale.  
 

- Turn off the CT Town Election Results layer in the Table of Contents. 
 
- Click the Add Data button on the Standard Toolbar and navigate to your 

C:/GISEd10/Layers folder and add Connecticut Towns to your map.  
 
- Turn on the ROADS layer in your Table of Contents and zoom to Full Extent. You 

should see all 169 towns in the state on your map and all of the major roads in 
Connecticut as you symbolized them in Exercise3a.  

 
- If you would like to change the symbology for any of the route classes, do so now.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Æ Create a Label Class 

 
- In the Table of Contents, double click on ROADS to open its Layer Properties 

window. Click the Labels tab.  

Your map might look 
different depending on 
how you decided to 
symbolize the route 
classes in your ROADS 
layer.  



 Ex. 4b: Page 145  
 

 
- Check the box in the upper left hand corner next to “Label features in this layer”.  

 
- Change the Method to “Define classes of features and label each class 

differently.”  
 

 
 

- Under Class, click the Add… button.  
 

- In the window that opens, name the new class Interstates and click OK.  
 

 
 

- Notice that Interstates is now the active class. You can change the active class by 
clicking on the black dropdown arrow. Click on the arrow and select Default - with 
Default as your active class, click on the 
Delete button. This will delete the Default 
class. Interstates should now be the only 
class available from the dropdown list.  

 
 
 

- Click on the SQL Query button. Here you will define the SQL Query to identify the 
Interstate route class for your new Interstates label class.  

 

 
 
 

- In the SQL Query window, double click on “ROUTECLASS.” This will add it to the 
query box at the bottom of the window.  

 
- Next click on the Get Unique Values button. The unique ROUTECLASS values will 

be added to the box in the middle of the window. 
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- Click on the “=” button to add it to the query box. 

 
- Finally, double click on “Interstate” value to add it to the query box.  

 
- Your SQL Query should read, “ROUTECLASS” = ‘Interstate’ and the SQL Query 

window should look like the graphic below.  
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- Click Verify to make sure you have no typos in your SQL Query. If you get an error, 
go back and recreate your statement. If your expression was successfully verified, 
click OK to return to the Layer Properties window.  

 
 
- In the Layer Properties window, change the Label Field to ROUTENO.  

 

Step 1: Double click 
ROUTECLASS 

Step 3: Click on = 
Step 2: Click on Get 
Unique Values 

Step 4: Double 
click on ‘Interstate’ 

Step 5: Verify 
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- Click on the Symbol button under Text 
Symbol. This will open the Symbol Selector. 
 

- Scroll all the way down to the bottom of the 
Symbol Selector until you find the U.S. 
Interstate HWY symbol. It will look like the 
red, white and blue highway shield we are 
all familiar with. Click on it and then click OK 
at the bottom of the window.  

 
 
 
 
 
 
 
 
 

- The last thing we want to do before applying 
the Label Class is to specify the Placement 
Properties. Click on the Placement 
Properties button under Other Options.  
 

- In the Placement Properties window, set 
the Orientation to Horizontal. At the bottom 
of the window, under Duplicate Labels, 
select the radio button next to Place one 
label per feature.  

 
- Click OK to close the Placement Properties 

window. 
 
- Click Apply in the Layer Properties window 

to apply the new label class. Move the 
Layer Properties window aside so you can 
see the changes to your map. You should 
see highway shields on all of the major 
interstate highways. Cool! Now let’s create 
label classes for the other routes.  

 
- You are going to repeat the process and create two additional Label Classes, one 

title “State Routes” and another called “US Routes”. Refer to the previous steps to 
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create and define these two labels classes. Be sure to use the SQL Statement, 
“ROUTECLASS” = ‘State Route’ for your State Routes Label Class and 
“ROUTECLASS” = ‘US Route’ for your US Routes Label Class. The Label Field 
for both should be ROUTENO. You will find appropriate highway shield symbols in 
the Symbol Selector for both Label Classes. If you have questions or find yourself 
stuck, refer back to the previous pages or ask an instructor for help.  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 1: Create a 
new Label Class 

Step 2: Define the class 
using a SQL Query 

Step 3: Specify the 
Label Field 

Step 4: Change the 
Text Symbol 

Step 5: Specify the 
Placement Properties Step 6: (Optional) Specify the 

Scale Range 

Note that at Full Extent, the labels 
are quite crowded. To fix this, you 
can specify a scale range for one or 
more of your label classes. For this 
map, you might want to create a 
scale range for the State Routes so 
that they turn off when you zoom 
out beyond a 1:500,000 scale. See 
instructions on following page.  
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Æ Specify a Label Scale Range 

 
- You may find that with all of your ROADS features labeled and your map zoomed to 

Full Extent, things look a bit crowded on your map. You can address this by 
specifying a Scale Range for one or more of your Label Classes.  
 

- Double click on the ROADS layer in the Table of Contents to open the Layer 
Properties window again. Click on the Labels tab.  

 
- Change the Class to State Routes and click on the Scale Range button at the 

bottom of the window.  
 

 
 

- Change the Scale Range so that 
the Label Class doesn’t draw when 
zoomed Out beyond 1:500,000.  
Click OK. Click OK again in the 
Layer Properties window to apply 
the changes.  
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- Click the Zoom to Full Extent icon on your Tools Toolbar to zoom to the full extent 

of your map data.  
 

 
 
 
What happens to the State Route labels at Full Extent? 

 
 
 
Zoom in on your map. At what map scale do the State Route labels turn back on? 

 
 
 
 
 
 

- This is a good point to save any changes you have made to the map. Remember, 
save early and often to avoid disasters! 
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Geodatabase Annotation 
Annotation is a special type of feature class stored in a geodatabase. The “features” are the text 
strings themselves. Each text string has its own properties and XY location that can be edited in 
the same way that other geographic features are edited in ArcMap. The benefit of annotation 
over labels is that annotation provides more flexibility in how the labels are formatted and placed 
on your map features. Because annotation is stored in a geodatabase, it is easy to share and 
reuse. Labels are a property of layers and can only be stored as a feature of the map document 
or in a layer file. In this step, you will create a geodatabase annotation class to label streets in 
the town of Marlborough.  
 

Æ Adding Additional Data Frames  

You can add multiple data frames to an ArcMap project. This can be helpful to separate different 
types of data and as you’ll see in the next exercise, it is particularly helpful when creating map 
layouts. In this step you will create a new data frame and add data to it for the town of 
Marlborough. 
 

- Click on the Insert dropdown menu and select Data Frame.  A data frame titled New 
Data Frame will be added to the Table of Contents.  
 

 
 

 
- You will also notice it is now the active data 

frame and is displayed in bold text. Note that 
your other data frame, Layers is still in the 
Table of Contents, however it is inactive. In 
Data View, you can only have one active data 
frame at a time. The contents of the active data 
frame will be displayed in the Display Area. 
Because your new data frame does not 
contain any data yet, nothing will be displayed in 
the Display Area.  
 

- You can click on the minus sign (–) next to the 
Layers data frame to collapse it if you wish. 
We will not be using it for now.  

 

 
 
 
 

New (active) 
Data Frame 

Original Data Frame 
is now inactive 
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- Double click on the New Data Frame name to open its Properties window.  

 
- Click on the General tab and change the Name to “Marlborough.” Click OK to close 

the Data Frame Properties window. You will notice the data frame name has 
changed in the Table of Contents.  

 
- Click the Add Data button on the Standard toolbar. Navigate to your 

C:/GISEd10/Layers folder and add the following layer files to your Marlborough 
Data Frame: Marl Town.lyr, Marlborough Streets.lyr, and Marlborough Water 
Features.lyr. You can add all three at the same time by holding down the Ctrl key 
on your keyboard while clicking on each.  

 

 
 
 

- When the data layers are added as a group to ArcMap, they will remain highlighted 
or selected in blue in the Table of Contents. Click anywhere in the white space in 
the Table of Contents to unselect them. 

 
 

 
 

Note, these are Layer (.lyr) files. They do NOT include the actual data, they simply point to 
the data, which for all three of these layer files is stored in the Marlborough.gdb. These layer 
files do however, store information about how the layer should be displayed in ArcMap, 
including symbology and labels.  
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The first thing you will notice is that the layers are already symbolized. This is the beauty of 
using layer files. 
 

 
 

- Right-click on the Marlborough Streets layer and click on Label Features. You 
should see the pre-formatted labels appear on the streets layer. Because labels are 
a property of a layer, they too are saved in a layer (.lyr) file.  
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Æ Create a Geodatabase Annotation Class 

The simplest method for creating annotation is to set up labels for a layer and then convert them 
to annotation that is stored as a feature class in a geodatabase. In this step, you will convert the 
labels for Marlborough Streets into geodatabase annotation.  
 

- Zoom in to the large lake.  
 

- With the labels turned on, right-click on 
the Marlborough Streets layer in the 
Table of Contents and select Convert 
Labels to Annotation in the menu that 
appears.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

- A Convert Labels to 
Annotation window will open. 
Take a look at the setting 
options. Make sure that (1) the 
annotation is set to be stored 
In a database; (2) that you are 
creating annotation for All 
features; and (3) that your 
annotation destination is the 
Marlborough.gdb. Your new 
annotation class will be called 
Marlborough_StreetsAnno.  
 

- Click Convert to create the 
annotation.   
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Æ Exploring Annotation 

- When the process is complete, you will have a new layer in 
your Table of Contents titled Marlborough_StreetsAnno. 
Click in the check box next to the layer to turn it on/off. Notice 
the layer is just made up of street labels.  
 

- Double click on the Marlborough_StreetsAnno layer to open 
its Layer Properties. Click on the Source tab. Note the Data 
Source properties. Here you can see where the layer is stored 
and what type of feature class and feature type it is. Close the 
Layer Properties window. 

 
- Turn both street layers on. Right click on 

Marlborough_StreetsAnno and select Open Attribute Table. 
Scroll through the attribute table (note, scroll down to the end of the table to view 
non-“Null” value features). Notice that each label in the annotation layer is its own 
feature and has a record in the attribute table. Close the table when you are done. 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Editing Annotation 

Because annotation is stored in 
a feature class, must be edited 
like other layers using the 
Editing tools. We’ll cover editing 
in one of the next modules! 
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Adding Graphics to a Map 
In addition to text and annotation, you can also add graphics to your map. Graphics are basics 
shapes and text elements that can be added to a map or layout that have properties, but are not 
linked to layers in the Table of Contents.  

Æ The Draw Toolbar 

- If it isn’t already turned on in ArcMap, turn on the Draw toolbar. Click on the 
Customize menu item in the Main Menu, hover over Toolbars and make sure there 
is a check next to Draw. If not, click on it. The Draw toolbar will be added to your 
interface. Dock it down in the lower left hand corner of ArcMap.  

 

 
 
 
 
 
 
 

Graphic Tools 
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- Use the Zoom tools to zoom in on Lake Terramuggus.  
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Æ Add a Graphic Shape to Your Map 

 
- Click on the small black arrow next to the 

square on the Draw toolbar. This will open a 
menu with various options for graphic shapes 
that can be added to your map. Click on the 
Marker icon.  
 

- Click in a location on the northwestern side of the lake (it doesn’t have to be exact). 
You should see a marker point placed on the location where you click.  
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- ArcMap will use a default green circle to symbolize 

the point. Let’s change the marker symbology to 
something a little more exciting. 

 
 
 
 
 
 
 
 
 

- Right-click on the circle marker and select 
Properties in the menu that appears to open the 
marker property window.  
 

- Click on Change Symbol.  
 

- In the top of the Symbol Selector, type in 
“beach” in the keyword box and press Enter. 
ArcMap will load all of the symbols with the word 
beach in their title. Choose one of the icons 
(don’t choose the Beach Pine icon – we want it 
to be a sandy beach, not a tree!).  

 
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- You can play with the 
symbol’s properties (color, 
background, size) by 
clicking on the Edit Symbol 
button in the Symbol 
Selector.  
 

- When you are satisfied with 
your symbol properties, click 
OK to close the Symbol 
Selector. Your marker point 
should be updated to reflect 
your changes.  
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Æ Add a Text Element to Your Map 

- Click on the little black arrow next to the 
Text Tool on the Draw toolbar. This will 
open a menu with various options for text 
elements that can be added to your map. 
Click on the Callout icon.  
 

- Hover your mouse over the beach marker 
you just created and click. In the text box 
window that appears, type “Beach 
Access” and press Enter.  

 
 

            
 

- After you press Enter, the text element should be highlighted. Click on it and while 
holding down your left mouse button, drag the text box to the side of the beach 
marker. Try the upper left corner (see graphic). Notice too that the Callout element 
has a “tail” that you can use to point to the feature you are labeling. Click and drag 
the callout tail so that it’s pointing to the beach marker.  
 

- If you wish to change any of the properties of the text element, you can double click 
on it to open its Properties window.  

 
 

New Marker Symbology 
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Turn off all of the layers in your Table of Contents. What happens to the graphics? Why did that 
happen? 

 
 

Æ Deleting a Graphic or Text Element 

- Using your Select Elements tool  click on one of the graphics you just added to 
your map. This will select the graphic. Right-click and select Delete from the menu 
options. This will delete your graphic. 
 

- You can undo the delete by clicking the Undo icon   on the Standard toolbar.  
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Save Your Work!  

Æ Save Your Map Project (.mxd) 

- To save the changes you have made, click on File on the Main Menu and select 
Save from the menu that appears.  Save it as Exercise4b.mxd in the Projects 
folder. Since we already saved it once, you can overwrite the existing 
Exercise3b.mxd.    

 

Let’s Review! 
Congratulations on completing Exercise 3b! This exercise was designed to introduce you to 
labels, annotation and graphics in ArcMap. We covered a number of important concepts in this 
exercise including: 
 

✓ Dynamic labels: Labels are a property of a layer. Dynamic labels can be added to 
provide context to features on your map. Labels pull their text string from a field or fields 
in the layers attribute table.  

✓ Label Classes: Label classes allow you to specify different label properties for features 
within a single data layer. Each label class can have different symbology and text.  

✓ Geodatabase Annotation: Labels can be converted to geodatabase annotation. 
Annotation allows for more flexibility when it comes to labeling feature on a map 
because each label is stored as a feature in a geodatabase feature class and has it’s 
own properties and XY location.  

✓ Graphics: Graphic shapes and text elements can be added to your map using the tools 
available from the Draw Toolbar. Graphics are not dynamic and are not linked to any 
layer in the Table of Contents.  

 
 

This concludes Exercise 4b. You can 
keep the exercise open, you will use 

it in Exercise 4c. 
 
 
If you have finished and the class is still working on the exercise, play around with labels and 
annotation. Try adding a few more graphics to your map. Explore and experiment!! 
 
Exercise 4b Answers  
Label Placement Properties 
What happens when you click “Only place label inside polygon”? Did all of the towns get 
labeled? What happens when you zoom in or out on your map?  
 
If you have this option checked, a label will only be placed in a polygon if it fits within the 
polygon’s boundaries. When you zoom in on your map, more towns will be labeled. When you 
zoom out, fewer towns will be labeled because ArcMap can’t fit them within the town’s 
boundaries.  
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Formatting a Label Expression 
What do your labels look like now? How about the map, is it legible? What happens when you 
zoom in? 
The resulting label will be stacked (have two lines of text) and will provide more context to the 
map readers than just the attribute value alone. At full extent the map still looks less cluttered 
because few labels are drawn. As you zoom in, additional labels appear once the scale 
threshold is met.  
 
Label Display Scales 
What happens to the State Route labels at Full Extent? 
 
They are not visible because we placed a scale threshold on them.  
 
Zoom in on your map. At what map scale do the State Route labels turn back on? 
 
1:500,000 
 
Graphics 
Turn off all of the layers in your Table of Contents. What happens to the graphics? Why did that 
happen? 
 
 The graphics remain on the map even when all of the layers in the Table of Contents are turned 
off. This is because graphics are not feature-linked but rather are stand-alone static features. 
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Exercise 4c: Map Layouts 
This final part of Module 4 will tie together everything you have learned about map production. 
You will learn how to create a map layout in ArcMap and prepare the map for printing or export 
to an image or PDF file. You will work with multiple data frames and map elements in order to 
create a cohesive and clear map displaying features in the town of Marlborough. If you have 
additional time when you finish, you can also explore data driven pages by completing the “extra 
credit” portion of this exercise.  
 

Getting Started: Layout Basics 

Æ Set up Your Map  

- You will start this exercise where you left off in Exercise 3b. If you have closed the 
exercise, start a new ArcMap session and open your Exercise4b.mxd.  
 

- Before we get started on our layout, let’s prepare our Marlborough Data Frame for 
this exercise.  

 
- In the last step of Exercise 4b, you added two graphics to your map displaying the 

location of a beach access point. You may or may not have deleted them from your 
map. If they are still on your map, select each graphic and delete it. We will not be 
using them for this exercise.  

 
- Zoom to the full extent of the Marlborough Data Frame. You should be able to see 

the entire town on your map. 
 
- Click the Add Data button on the 

Standard Toolbar. Navigate to 
your C:/GISEd10/Layers folder 
and add Marl Parcels.lyr and Marl 
Zoning.lyr to your map. 

 
- In the Table of Contents turn off 

the following layers: 
Marlborough_StreetsAnno, 
Marlborough Streets, and 
Marlborough Boundary.  

 
- Reorder the layers so that Zoning 

is on the bottom, Marlborough 
Water Features is in the middle 
and Parcels is on the top.  

 
 
- Save your map as 

Exercise4c.mxd in your 
C:/GISEd10/Projects folder.  
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Æ Working in Layout View 

Layouts are the ArcMap equivalent of a desktop publishing system.  You can switch back and 
forth between Data View and Layout View by clicking the appropriate icon at the bottom of the 
ArcMap view pane. 
 

- Click the Layout View icon (it looks like a sheet of paper) at the bottom of the 
ArcMap view pane. 

 
Notice that the map display changes. The biggest change you will likely notice is the data being 
displayed on the map. In Layout view, multiple Data Frames are visible. Because you have 
two Data Frames in your map, both will be visible and by default, stacked on top of one another. 
We’ll address that issue in a minute. Also notice there is a dotted outline around the 
Marlborough data that represents the active Data Frame.  There will also be a light gray dotted 
outline around the edge of the Layout that represents that printer’s margins.  ArcMap initially 
uses the settings for the default printer installed on the PC. 
 

- Try toggling back and forth between Data View and Layout View.  End up on 
Layout View. 

Data View icon 

Layout View 
Layout Toolbar 

Multiple Data Frames 

Click the Layout View icon 
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- Expand the “Layers” Data Frame in the Table of Contents.  
 

- Uncheck the ROADS layer.  The road lines should disappear on your layout and you 
should only see a map showing Connecticut Towns in the “Layers” Data Frame. 
Map layers displayed in the Layout View are “connected” to layers in the Table of 
Contents just as they are in Data View. Any changes you make to a layer will be 
reflected on the map in Layout View.  

 

Æ The Layout Toolbar 

When you first open a layout, the Layout toolbar also will be opened and added somewhere on 
the ArcMap display.  This toolbar has controls that help you move around within a layout.   

- Move your mouse over each of the Layout Toolbar controls and note what the 
control does.  On this toolbar, the pan and zoom functions operate on the virtual 
sheet of paper that you are preparing for plotting.  Thus, when you zoom in, you are 
making the “paper” larger and you are NOT changing the scale of the map data on 
the paper. 

 
 
 
 

- To change the scale or extent of the actual data being displayed in the layout use the 
pan and zoom tools on the Tools Toolbar – the one you have been using up to this 
point. 

 
- While in Layout View, zoom in, out and pan using the tools on the Tools Toolbar 

and notice how the Layout View changes. Now toggle back to the Data View by 
clicking the Data View icon and note how the layers are displayed there. 

- Click the Layout View icon and then click the Full Extent button  on the Tools 
Toolbar.  This will restore the Data View and the Layout View to display the entire 
town of Marlborough. 

It’s important that you understand the relationship between Data and Layout Views and between 
the controls on the Layout and Tools Toolbars.  Play around with these until you are comfortable 
with them.  If you are uncertain about what’s happening, ask an instructor to demonstrate and 
explain the relationships. 
 
 

Zoom to entire 
Layout page 

Show the Layout at a scale of 1:1 
– the scale it will actually print at. 
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Æ Data Frames in Layout View 

 
Data Frames automatically appear in the Layout View.  If you have multiple Data Frames in the 
Table of Contents, all will appear in the Layout.  Each Data Frame has properties that control its 
appearance – its border style, background color and pattern and shadowing.   
Data Frames can be manipulated in a variety of ways in Layout View.  They can be copied, cut 
and pasted (within the map document and between map documents); they can be repositioned 
and resized; and they can be deleted.  However, never (or rarely) delete a Data Frame. 
Deleting a Data Frame in the Layout also deletes it from the Data View and removes it from the 
Table of Contents.  Of course, you can always use the Undo button to restore a deleted Data 
Frame. 

- Click on the Select Elements  tool on the 
Tools Toolbar to return your cursor to the black 
arrow. Click once in the rectangle containing 
the statewide data to select and activate the 
Layers Data Frame.  

- In the Table of Contents, uncheck all layers 
except for Connecticut Towns. If you can’t see 
the entire state, click the Full Extent button. 

Notice there are now cyan boxes on the edges and 
corners of the Data Frame. These are resizing “handles”. 
You can click on any of them and drag them to resize the 
data frame.  

- Click on one of the corner handles and drag it 
towards the center of the Data Frame. This 
should shrink the entire Data Frame.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

- Shrink the Layers Data Frame until it is just a 
small, thumbnail size image on your layout. 
Position it in the upper right-hand corner of your 
layout by using the four-way arrows that appear 
when you hover over the center of the Data Frame. 
 

- After you reposition it, the data within the Data 
Frame will need to be adjusted. Click on the Zoom 
to Full Extent  icon on the Tools Toolbar. This 
will zoom the map to the full extent and fit it nicely 
within the Data Frame.  
 

- Great! Now that we have our overview map set, 
let’s focus on our Marlborough Data Frame, which 
will be the focus of our map layout.  
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- Click once within the Marlborough Data Frame on the Layout. This will select and 

activate the Marlborough Data Frame on the map and in the Table of Contents.  
- Use the resizing handles to drag and extend the Data Frame so that it fills the 

majority of the layout. Because it will be the focus of the layout, you want it to be 
large and centered. After you reposition the Data Frame, click the Zoom to Full 
Extent  icon again on the Tools Toolbar to redraw the Marlborough data layers 
so that they fill the Data Frame.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Woohoo, it’s starting to look like a printable map! Let’s adjust a few more Data Frame settings to 
clean it up a little more.  

- Right click on the Layers Data Frame name in the Table of Contents and select 
Properties. This will open the Data Frame Properties window. Click on the Frame 
tab in the Data Frame Properties window. 

- Try clicking on the drop-down arrows and changing the Border, Background and 
Drop Shadow settings and click Apply to see how they affect the Data Frame’s 
display.  

- After you are done experimenting with different frame setting, change the Border, 
Background and Drop Shadow to <None>.  Click OK to apply the changes and 
close the window. 

- You will see a dotted grey line surrounding the Layers Data Frame on the layout. 
This will not show up on your printed map, it is just way for you to see where the 
edge of the Data Frame is on your layout.  
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- Right click on the Marlborough Data Frame name in 

the Table of Contents and select Properties. This 
will open the Data Frame Properties window. Click 
on the Frame tab in the Data Frame Properties 
window. 

- Repeat the steps you did previously to set the 
Border, Background and Drop Shadow settings to 
<None> and click OK.  This will give you as much 
space on your layout as possible to add other 
important map features such as the legend, north 
arrow and scale bar.  

 
 

 

Adding Cartographic Elements 
Some cartographic elements are linked to the active data frame including north arrows, scale 
bars, scale text and legends. Other elements such as titles, graphic elements, pictures, neat 
lines, reports and graphs can also be added to a map layout but are not linked directly to a data 
frame. Most cartographic elements can be added to a layout from the Insert menu in Layout 
View. 

Æ Add a Title 

- Click on the Insert dropdown menu on the 
Main Menu in ArcMap and select Title. In 
the window that pops up asking for a title, 
type Marlborough Zoning and click OK.  
 
Note: sometimes the Insert Title window 
doesn’t open. If this happened, you should 
see text titled “Map Production Exercise”. 
Not to worry, just go on to the next step. 
 

- A text box will be added to your map layout. 
Click on it and drag it to the upper left hand 
corner of the layout.  

 
- Open the Properties window by double clicking on the text box. 
 
 
 
 
 
 
 
 

 

Note: The Insert > Title tool will add 
dynamic text that is formatted with a text tag. 
Dynamic text changes automatically based 
on the current properties of the map 
document. The Title tag is linked to the Map 
Properties dialog box.  
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- In the Properties window, replace the dynamic text tag with Marlborough Zoning. 
- Click on the Change Symbol button. In the Symbol Selector, increase the size of 

the text to 28. If you wish to change the color or font of the title, do so. If you change 
the font, you may have to go back and adjust the text size as needed.  

- Click OK to close the Properties window.  
 
 
 
 
 
 
 
 
 
 
  
 

 
 
 
 
 
 
 
 

Æ Add a Legend 

A legend is a very important element for almost every kind of map. It tells a map reader the 
meaning of symbols used to represent features on the map. Legends consist of examples of 
symbols that are found on the map along with labels containing explanatory text. Whether you 
use a single symbol or multiple symbols to represent features in a layer, the layer’s name and/or 
field value used to classify the features are included by default in the legend. This step in the 
exercise will take you through the process of adding a legend to your map using the Legend 
Wizard.  
 

- Make sure the Marlborough Data 
Frame is Active. Remember, the 
active Data Frame will be the one that 
is in a bold heading in the Table of 
Contents. If it is not currently the 
active Data Frame, right click on the 
Data Frame name (Marlborough) in 
the Table of Contents and select 
Activate from the menu that appears.  
 

- Click on the Insert dropdown menu 
item and select Legend. The Legend 
Wizard window will open. 

 
  

Active Data Frame 

Dynamic Text Tag 
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The Legend Wizard makes it very easy to create a custom legend. The wizard allows you to: 
 
o Choose which map layers will be part of the legend 
o Specify the number of columns in the legend 
o Create and symbolize a legend title 
o Create and symbolize a legend border, background and drop shadow 
o Customize the size and shape of the legend patches 
o Set the spacing between legend elements 
o Preview the look of the legend 
 

The first window of the Legend Wizard gives you the option of picking and choosing what 
layers you would like to include in your legend. For this map, we only want to include Parcels 
and Zoning. The box on the left will display all of the Map Layers in the Marlborough Data 
Frame. The box on the right will display the Legend Items - all of the layers that will be 
displayed in the legend on your layout. We want this list to only include Parcels and Zoning.  

 
- To remove Waterbodies from the list, click on it to highlight it and then click on the 

left pointing arrow  to move it from the Legend Items list.  
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

- Repeat the steps above to remove 
Streams from the Legend Items list 
as well. You should now only have 
Parcels and Zoning in the box on 
the right.  
 

- After you have removed the two 
layers from the Legend Items list, 
click the Next> button to go to the 
next window of the Legend Wizard.  
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- The next window in the Legend Wizard is for formatting a Legend Title. Since we 
don’t want our legend to be too large or long, and because most people understand 
intuitively what a legend is, we are not going to include a title. To remove the title, 
simply delete the text (“Legend”) in the box under Legend Title and click the Next> 
button to move on.  
 

- Next you will come to a window that includes settings for 
the Legend Frame. Here you can specify a Border, 
Background and Drop Shadow. Go ahead and 
experiment with a few different colors and settings. If you 
wish to include any of these, remember to keep the colors 
toned down so they do not distract from the actual map 
symbology. When you are done, click the Next > button.  

 
- The next window in the Legend Wizard controls the size 

and shape of the symbol patch used to represent line and 
polygon features in your legend. It isn’t necessary to 
change these, but if you want to “spice up” the look of 
your legend, go for it! Click the Next> button when you 
are ready to move on.  
 
 
 
 
 
 
 
 
 
 
 
 
 

- The final window of the Legend Wizard 
allows you to control the spacing 
between different legend items. You can 
click on each legend item name in the 
window and it will show you the 
corresponding spacing as it will appear 
in the legend. For now, just leave them 
set to the default values.  
 

- If you would like to Preview what your 
legend will look like before exiting the 
Legend Wizard, click the Preview 
button. Your legend will appear on your 
map. You can click the <Back button in 
the Legend Wizard to go back and 
change a setting if you wish.  

 
- Click Finish to close the Wizard.  
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- Your legend will be added to your layout. Like other map elements, you can click on 

it to select it and position and resize it on our layout.  
 
- If you would like to adjust any of the legend properties, double-click on the legend. 

This will open the Legend Properties window where you can access all of the 
properties and settings that were available through the legend wizard.  

 

 
 
 
- You can reorder the Legend Items from the Legend Properties 

window. Click on the Items tab and click on Parcels in the right-
hand window under Legend Items. Click on the down arrow  to 
the right of the Legend Items box. Click OK to close the Legend 
Properties window. This will move the Parcels layer under the 
Zoning layer in your legend.  

 
 
 
 
 
- Note that the legend is directly connected to the layers in your Table of Contents. If 

you turn off Zoning in the Table of Contents, it will disappear from the legend. If 
you rename a layer in the Table of Contents, the layer name in the legend will also 
change.  
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Æ Add a Scale Bar 

- Scale bars are also linked directly to the 
Data Frame that is active when you add the 
scale bar to your map. Because we want our 
scale bar to measure features in 
Marlborough accurately, make sure the 
Marlborough Data Frame is Active. 
 

- Click on the Insert drop down menu on the 
Main Menu and select Scale Bar.  

 
 
 
 
 
 
- In the Scale Bar Selector that opens, choose a scale bar style from the available 

options. Because readers of this particular map may only be interested in general 
distance measurements, you may want to choose one of the Scale Line designs 
over an Alternating Scale design. Make sure the Scale to Fit box on the right side 
of the window is NOT checked.  

 
- Once you choose a scale design, click on the Properties button. There are many 

specific properties you can control relating to a scale bar. Take a minute to look at 
some of the options. The only one that we’ll change right now is the Division Units. 
On the Scale and Units tab, change the Division Units from Feet to Miles. Click 
OK. Click OK again in the Scale Bar Selector to apply your scale bar. 

 
-  It will be added to the center of your Data Frame. Click on in and drag it to the 

bottom of your layout. 
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Æ Add a North Arrow 

Like legends and scale bars, north arrows are also directly linked to a data frame. By default, 
North is always straight up in ArcMap, however you can rotate a data frame by using the Data 
Frame Toolbar. If you change the orientation of a data frame and add a north arrow, the 
orientation of the north arrow will change to reflect the northern orientation of the data frame.  
 

- Click the Insert dropdown menu on 
the Main Menu and select North 
Arrow.  
 

- Choose one of the North Arrow 
symbols from the Symbol Selector.  

 
- If you wish to change the arrow’s 

color or size, click on the Properties 
button.  

 
- When you are satisfied, click OK. A 

north arrow will be added to your 
map.  
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- Like other map elements, you can click on the North Arrow and drag it around your 
map. You can also select it and use the corner “handles” to resize it.  

 

Æ Add a Text Element 

You may want to add a short paragraph or a few lines of text to a map to help the map reader 
understand what the map is portraying or to provide references. You can easily add text and 
graphics to your map layout using the tools on the Draw toolbar. 
 

- If it is not already added to your 
ArcMap interface, add the Draw 
toolbar from the Customize > 
Toolbars menu.  
 

- Click on the Add Text tool on the 
Draw toolbar and select the 
Rectangle Text tool option. This will 
allow you to define a rectangular text 
box on your layout. The text will wrap 
within the extent of the text box. This 
tool can be helpful for defining a 
precise area for text on your map.  

 
- Draw a rectangular box on your layout just under the statewide overview map.  

 
- Double-click on the text box to open the Properties window. Type the following text 

into the text window: This map shows zoning classes for the town of 
Marlborough, CT. It was created by {YOUR NAME HERE} on {DATE}. It does 
not include any authoritative data. 

 
- Click on the Frame tab and change the Border to <None>. Click OK to close the 

Properties window.  
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- You may find that you need to stretch, shrink or otherwise resize the text box in order 
to see all of the text. Remember to use the Zoom In tool on the Layout Toolbar (not 
the Tools Toolbar!) to take a closer look.  

 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 Ex. 4c: Page 179 
 

Æ Add an Image 

The last thing we’ll do to our layout is add a graphic of 
the town seal.  
 

- Click on the Insert dropdown menu on the 
Main Menu and select Picture.  
 

- Navigate to your C:/GISEd10/Images folder 
and select town_seal.jpg and click Open.  

 
- The image will be added to your map. Click 

and drag it to the upper left-hand corner, just 
under the map title.  

 
 
 
 
 

 
 
 
 
 
And there you have it! Your map is looking good. So far we have added: two data frames, a title, 
legend, scale bar, north arrow, text and image. There are a few other items you can add from 
the Insert dropdown menu. If you wish, you can explore some of these other options, but be 
careful not to create a map that is too cluttered.  
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Æ Customize the Overview Map 

We have one last thing to do to our map before we are ready to print and save. Right now, your 
overview map showing the state of Connecticut is not terribly helpful. We want the overview 
map to show where the town of Marlborough is relative to the rest of the towns in the state. To 
do this, we will select the town and change the selection symbology so that the town of 
Marlborough stands out on the map.  
 

- If the Layers Data Frame is collapsed, click on the + symbol to 
expand it so that you can see the contents of the Data Frame.  
 

- Right-click on Connecticut Towns and select Open Attribute 
Table.  

 
- Locate the TOWN field and right-click on it. Select Sort Ascending. This will sort the 

field in alphabetic order. Scroll down the list until you find Marlborough. 
 

 
 
- Click on the Marlborough record in the Attribute Table to select it. Remember, if a 

record is selected in the Table of Contents it will also be selected on your map as 
well. Close the Attribute Table. 

 
- Double click on Connecticut Towns in the Table of Contents to open the Layer 

Properties window.  
 
- Click on the Selection Tab. Change the “Show selected features” option with this 

color and click on the empty box. Choose a bright red color to symbolize the 
selected features. Click OK to close the Layer Properties window.  
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Notice that the town of Marlborough is selected on your overview map and is displayed in bright 
red on your map. You can play with the size of the overview map and the colors of the layer 
(hint: make the town borders thinner) to make the town stand out better.  
 

- Save your project.  
 

  

Tip: Another way to enhance the overview map is to use an Extent Indicator 
which shows the extent of the data in another data frame and automatically 
updates if the extent changes. To set an Extent Indicator, double click on the 
Layers heading in the Table of Contents to open the Data Frame Properties 
window. Select the Extent Indicators tab. Click on Marlborough to highlight it 
and click the > arrow to move the data frame to the right. Click OK. The extent 
will be shown as a box.  
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Creating a PDF Map 

Æ Preparing Your Layout for Export 

You can save your map layout from ArcMap in several different formats (.jpg, .bmp, .gif, .tif, .pdf, 
etc.). Beginning in ArcGIS 9.2, ESRI added functionality so that when you export a map to a 
PDF, the resulting PDF will contain native PDF layer information reflecting the layers in your 
map. Anyone using Adobe Acrobat Reader version 6 or higher will be able to view the PDF and 
turn a layer on or off using the Layers control in Acrobat Reader. This makes PDFs a very 
useful resource for sharing GIS data with others who do not have GIS software or 
understanding of GIS concepts. In ArcGIS 9.3 and ArcGIS10, ESRI furthered the functionality of 
exported PDF maps by adding the ability to use your cursor to identify coordinate locations on 
the map and also the ability to export feature attributes with the layers in your map. (*NOTE: this 
only works with Adobe Reader 9). In this step you will export your layout as a PDF and view it in 
Adobe Reader 9.  
 

- Click on the Add Data button. You are going to add a point dataset to your 
Marlborough map. This dataset is less complex than some of the others in the map 
document so we’ll use it as the example for exporting feature attributes to PDF. 

 
- Navigate to your C:\GISED10\Layers folder and add Marl Public Wells.lyr to your 

map. You will see the public well points on your map and since you added a layer 
file, they will already be symbolized. The symbols may be difficult to see if you still 
have a Reference Scale set on the Data Frame from Exercise 3b. To clear the 
Reference Scale, right-click on the Marlborough Data Frame name and select 
Reference Scale>Clear Reference Scale. Now you should be able to see the well 
symbols without needing to zoom in on your map.  The dataset name and symbol will 
also automatically be added to the legend on your map.  

 
If you plan to take advantage of the ability to embed feature attributes in your PDF 
(available only in ArcGIS 9.3 and 10 using Adobe Reader 9), then it is wise to only 
export values in the layers and fields that you wish to embed. Otherwise, the system will 
get bogged down and your PDF will perform very slowly (or not at all!). In this step, you 
will turn off the visibility of all of the fields in all of the layers except for the ones you wish 
to export for the Marlborough Public Wells layer.  
 
 
- Double-click on the Parcels layer to open 

the Layer Properties.  
- Click on the Fields tab.  
- Click on the Turn all Fields off icon in the 

upper left-hand corner. This will uncheck all 
of the fields in the list, essentially making 
them “invisible”. When you export your map 
to Adobe PDF, the feature attributes stored 
in these fields will be ignored. This will 
improve the performance of your PDF.  

 
- Once all of the fields have been turned off, 

click OK at the bottom of the Layer 
Properties window. 
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- Repeat the process for all of the other layers in the map except for Marlborough 
Public Wells. Marlborough Water Features is a group layer so you will have to turn 
off fields for the Streams and Waterbodies layers separately. Once you are 
finished, the only layer that should have visible fields is Marlborough Public Wells. 
When you export your map, all of the spatial features in your layers will be carried 
over, however only the attribute data stored in visible fields will be exported to the 
PDF. Turning off fields in the layers we don’t need attribute information for will 
GREATLY improve the performance of a PDF! 
 

Æ Export to PDF 

 
- Now you should be ready to export your map to a PDF. Click on the File from the 

Main Menu in ArcMap and select Export Map… 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- In the Export Map window, 
navigate to your 
C:\GISEd10\Results folder. 

 
- In the Save as type: box click the 

down arrow and select PDF 
(*.pdf). 

 
 
- In the File name: box, type in 

Marlborough Zoning. 
 
- Click on the Advanced Options 

Tab at the bottom of the Export 
Map window.  

 
 - On the Advanced Tab, click on 

the dropdown arrow next to Layers 
and Attributes and select Export 
PDF Layers and Feature 
Attributes.  

 
- Make sure Export Map 

Georeference Information is 
checked.  

 
- Take note of the Warning at the 

bottom of the screen (this is why 
you turned off fields). 

 
- Click Save in the Export Map 

Window to export your data to 
PDF.  
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Æ Explore Your PDF 

- Minimize ArcMap.  
 
- Right click on the Windows Start menu, select Explore (or Computer in newer 

Operating Systems). 
 

- Navigate to your C:\GISEd10\Results folder and double click on Marlborough 
Zoning.pdf to open it in Adobe Reader.  

 
- When the PDF opens, click on the Layers tab on the left side of the window. This will 

expand the Layers window. 
 

- Click on the > sign (arrow) next to Marlborough to expand the contents of the data 
frame. 

 
- You should now be able to see all of the datasets that were in your Marlborough 

Data Frame listed in the Layers tab in Abode Reader. 
 

- Click the eye icon to the left of each layer name to toggle the layer on/off in the PDF 
display window.  

Layers 
Tab 

Click on Eye 
to turn on/off 

Expand 
Folder 
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- Take a minute or two 

to turn each layer on 
and off. Every layer or 
group layer as well as 
any text or graphics 
present in your Data 
Frame at the time you 
exported your data will 
appear as a layer in 
your PDF and can be 
toggled on and off.  

 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 

Æ Advanced PDF Functions 

In ArcGIS 9.3 and ArcGIS10, ESRI added the ability to export coordinate information 
and feature attributes. In this step, you will explore these features.  
 
- In Adobe Reader, click on the Edit dropdown menu and select Manage Tools, then 

chose the Measure Tool. The Measure toolbar will appear at the top of the screen, 
click on the Geospatial Location Tool. This will add a tool that can display 
coordinate locations on your PDF map.  

 

 
 
 
 

 
 

 

Click on  
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- Move your cursor over the map. Notice the tool reports the Latitude and Longitude 

in a grey box in the lower right corner of your map. The values represent the current 
location of your mouse.  

 
 

- You can also right-click on the map and select Mark a Location or Find a Location. 
This will allow you to click on a location or enter a specific Latitude and Longitude 
and the tool will add a placemark in that location. Give it a try! 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

- Next, click on the Model Tree tab on the left side of the window. This will expand the 
Model Tree window. Click once on the Marlborough data frame. 

 
- Notice many of the layers are outlined in red on your map. This is a first order 

selection. Basically Adobe selected all of the features in the Marlborough data frame 
that were selectable.  

 
- Click on Public Water Supply Wells layer to create a second order selection. Notice 

that the Public Water Supply Wells layer is now highlighted in bold in the Model 
Tree. This tells you that Adobe has narrowed in on this dataset…we’re getting 
closer! 

 
- Click on one of the wells under the Public Water Supply Wells layer to create a 

third order selection. Since Adobe knows which layer to look in, this click will narrow 
it down to the exact feature you clicked on. Notice that the feature attributes for the 
well are displayed in the bottom of the Model Tree window. Pretty cool! Try it again 
for another well feature. Remember…three clicks! 

 
- Play around and experiment with the different layers and tools in Adobe Reader. 

When you are finished, close the PDF.  
 
 
 
 

Enter a value for Latitude and Longitude 
and Press the Enter key 
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First Order Selection 

 
 
Second Order Selection 

 
 

Third Order Selection 
 
 
       
 
 
 
 
 
 
 
 

All features are selected 

Only wells are 
selected 
 

Individual well is 
selected 
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Printing & Sharing a Map 

Æ Print Your Map 

Whew – done!   
Now you’re ready to print the Layout in ArcMap.  Return to your map in ArcMap. Click the File 
drop-down menu and select Print Preview… to review the layout as it will print.  If all appears in 
order, then click the Print button.  A Print window will open where you can set some printer 
parameters.  This is just like printing from most other Windows programs.  Click OK and send 
the layout to the printer. 

 
 
 

 
 
 
 

 

Æ Creating a Map Package 

Map packages (.mpk) make it easy to share complete map documents with others. A map 
package contains a map document (.mxd) and the data referenced by the layers it contains, 

Tip:  It is easy to print a map at a specific scale.  Just type the desired scale into 

the Map Scale  field.  However, be sure the printer and paper 
size are adequate for the scale specified.  
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packaged into one convenient, portable file. Map packages can be used for easy sharing of 
maps between colleagues, across organizations and with other ArcGIS users of ArcGIS Online. 
 

- In ArcMap, click on File > Map Document 
Properties. Type a short description of the 
map into the Description window. It can be 
brief, but it should describe a brief overview 
of what the map contains. 
 

- Add your name to the Author field.  
 

- Click OK.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

- You should get a message that your Map Package file has been successfully created. 
You can check your C:\GISEd10\Projects folder to verify that the file exists.  

 
 

- From the Main Menu, click on File > 
ShareAs> Map Package. 
 

- Save the Map Package to 
C:\GISEd10\Projects\Exercise3.mpk. 

 
- Uncheck “Include Enterprise 

Geodatabase data instead of 
referenceing the data”  

 
- Click on Item Description in the left 

column. Add a few keyword tags under the 
Tags heading. 

 
- In the upper right corner of the window, 

click Analyze and then Share.  
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Let’s Review! 
This exercise taught you how to create maps for printing and display. A number of techniques 
for creating good layouts were covered including: 

✓ Using the layout view: Layout view is where you set up the structure of how you 
map printout will appear. The Layout Toolbar provides a number of tools that 
help you navigate around the layout view.  

✓ Adding map elements: A number of map elements can be added to a layout 
from the Insert dropdown menu on the main menu. Elements such as a title, 
scale bar, north arrow, and legend are key map elements for any layout. The 
legend wizard, which can be opened from the Insert menu, provides step-by-step 
instructions for creating a legend for your map. 

✓ Adding text and graphics: The drawing toolbar is useful for adding additional 
elements to your layout. 

✓ Repositioning features: The graphics toolbar allows you to align, distribute, 
rotates and in other ways manipulate any selected elements in the layout. 

✓ Exporting to a PDF: When you export your map to a PDF, the resulting file 
contains PDF layer information for each of your layers in your Table of Contents. 
When you view the PDF in Adobe Reader 6 or higher, you can turn each layer 
on/off in the document. If you are working with ArcGIS 9.3 and Adobe 9, PDF 
functionality is furthered with the ability to find coordinates on your map and view 
feature attribute data. This makes sharing GIS data even easier! 

✓ Printing your layout: When you create a layout in ArcMap, you can set the 
page properties to the size printer or plotter you are using. This makes it easy to 
create prints that look exactly like they do on screen.  

✓ Map Packages: A map package contains a map document (.mxd) and the data 
referenced by the layers it contains, packaged into one convenient, portable file. 
Map packages can be used for easy sharing of maps between colleagues, 
across organizations and with other ArcGIS users of ArcGIS Online. 

 
 

This concludes Exercise 4c. 
Save your ArcMap session in your 

C:\GISEd10\Projects folder as Exercise4c.mxd 
Close ArcMap. 
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Exercise 5a: Digitizing Basics 
This exercise is designed to introduce you to the very basics of digitizing within ArcMap. You will 
open a premade map document (.mxd), start an editing session, and create some points, lines, 
and polygon features.  Again, this is just the basics to familiarize yourself with editing tools. Do 
not get bogged down trying to be too accurate or creating too many features.   
 
Getting Started: 
 

- Open ArcMap.  For detailed instructions, refer to Exercise 1a.   
- Open the Digitizing.mxd which is in the C:\GISEd10\Projects\ folder. 

 
Editing Tools 
 
Once open, the ArcMap GUI will look something like what you see below. If it looks slightly 
different, it’s because additional functionality (toolbars, etc.) may have been turned on or 
enabled by a previous user. When ArcMap is closed, it “remembers” these settings and restores 
them when it is reopened.  

Æ Preparing the View for Editing 

To start an editing session you will need the Editor Toolbar and for this exercise the Snapping 
Toolbar.   
 

- To add the toolbars, right-click on a blank section above the map view and select  
o Editor from the list.   
o Repeat to add the Snapping toolbar.   
o Repeat once more and add the Effects toolbar.   
o Once checked they will be visible.  Dock the toolbars if they appear as 

“floating” windows. 
-  
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Æ Starting an Edit Session  

 
The risk of crashes increase with editing, so first save the project in your own file, then save 
periodically as you go along.  
  

- From the menu click File>Save As… and save your project as 
C:\GISEd10\Projects\Exercise5a.mxd 

 
There are at least two ways to start an Edit Session.  The first way you will try is easier, but 
does not provide as much information about the layers and folders within an editing session.  
Because all layers within the workspace or folder you are editing can be modified (on purpose 
or by accident), knowing more can be useful.  The second procedure for starting an edit session 
is more complex, but provides more control.  It will be up to you to choose the first or second 
technique in the future, but for now, try both methods. 
 
First, the quick way: 
 

- Because it is the layer you want to edit, right-Click on the layer called SamplePoint in 
the Table of Contents.  

 
- Select Edit Features>Start Editing. This starts an edit session.  You will see a Create 

Features window open in a pop-up or docked on the right side of the ArcMap interface. 
We’ll get to that in a minute. 

 

 
 

- For now, let’s close this edit session so you can try the second approach.  Stop the 
editing session by selecting Editor>Stop Editing from the Editor toolbar. If no edits 
were made it should close without a prompt. 

Tip:  Hover your mouse 
over any menu item or 
icon on a toolbar (like 
the Editor toolbar!) for a 
helpful explanation.    
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The second technique is a more controlled approach for starting an edit session.  
 

- On the Editor toolbar, select the Editor menu and then 
Start Editing.  A Start Editing window opens because 
layers in the Table of Contents have different source 
folders and/or geodatabases. 

 
- Click on a layer from the list at the top of the Start Editing window and notice how the 

icons change from  to  in both the top and bottom windows.   
 

Those with the pencil icon  are part of the same editing “space.”  You can choose either the 
feature (top list) or the folder (bottom list) to open the session. 

 
- Choose the SamplePoint feature and click OK at the bottom to open the session. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

Note:  It does not matter 
which of the features you 
select in a particular folder, 
all those that share the 
folder will be editable.  You 
will pick which one to focus 
on in the next step  

Layers, or Features, in 
your map document. 

Folders or geodatabases that 
contain features (or layers) in 
your map document. 
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Æ The Editing Environment 

With Editing started you should now see the Create Features window on the right side of your 
ArcMap window.   
 

- Locate the Create Features window.  If it is not open, click the Create Features icon on 
the Editor toolbar to open it.   

 

 
 

- If you don’t like the symbology of the SamplePoint layer (or SampleLine or 
SamplePolygon for that matter), click on the symbol in the Table of Contents to 
change it before you start digitizing.   
 

 

 
 
At this point you could start editing; anything within the edit folder can be modified at this time.  
However, before you start you will check to make sure Snapping is set properly. 
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- Click on Snapping from Snapping Toolbar to open the 

droplist and make sure Use Snapping is checked. 
 

- Make sure each of the buttons to the right of the word 
Snapping is depressed.  This can be hard to tell at first.  
To check, click on one of them, then move the mouse 
cursor off of it.  It will display as either “off” (up) or “on” 
(down).  You want them “on” (down). 

 
 
 
 

 
 

Æ Digitizing Points 

First we will add some points.  This is the simplest form of digitizing.  Once several points are 
added, you will update some of their attributes. 
 

- In the Create Features window, select SamplePoint.  
This means that new points created will be part of the 
SamplePoint layer when saved.  

 
- Make sure “Point” is selected in the Constructions 

Tools box at the bottom.  
 

 
 

- On the Editor Toolbar, be sure that the “Point” method is selected. 
 

 
 

- To set up your map: 
 

o Maximize ArcMap so that it fills your screen by clicking on the square button 

in the upper right corner .   
 

o Use the stored bookmark to zoom to the 
correct area.  On the Bookmarks menu, 
choose Marlborough Subdivision. 

NOTE : If an “ArcMap Drawing Errors” window pops up 
at any time to indicate that one or more layers have failed 
to draw, just close it for now. 
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o Un-pin the Create Features window by selecting the Auto Hide 

button (pin icon  in the upper right corner).  When it shows a 
horizontal pin, the window should disappear and more of the map will 
show.  To bring it back, simply put your mouse cursor over the Create 
Features tab on the right.  

 

Pinned =        Un-Pinned =   
 

 
o Modify the Selectable layers so that ONLY the 

SamplePoint, SampleLine and 
SamplePolygon layers can be selected. If you 
forget how to do this, go to the List by Selection 
icon in the Table of Contents.  Click on the icon 
next to Parcel Zoning to change it from 
Selectable to Not Selectable.   

 
- The map should be an image of the Marlborough 

subdivision.  Practice using the mouse to zoom while in 
the editing session: 

o To Zoom In, roll back the Scroll Wheel on the 
mouse.   

o To Zoom Out roll it forward.  
o To PAN, press down the Scroll Wheel and move the mouse or hold down 

the “C” key on your keyboard. 
 

- Zoom in so that you can see several 
houses with swimming pools. 

 
- Left-click on several of the pools to add 

them as points.   
 

- Once added, the newest point will be 
highlighted because it is selected (cyan).  
The prior points are drawn with the feature 
symbol (in this case a blue circle).  Notice 
that when you hover over a previous point, 
the snapping symbol activates.   

 
 

- After adding a few points, on the Editor toolbar, select the Editor menu and Save 
Edits.  Do this whenever you feel you have a lot to lose.   
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- Now pan around and add more swimming pools.   
 
- When you have had your fun clicking, try deleting some points.  Select the Edit Tool 

from the Editor Toolbar   and then select a point by clicking on it.  Once the point is 
selected (highlighted), press the Delete key OR right-click and select Delete from the 
droplist.    

 

 
 
 

 
. 

- Save your edits (Editor menu on the Editor toolbar, Save Edits).  Now you will edit 
some data attributes for the new points. 

Æ Adding Attributes 

- Select the Attributes Icon on the Editor Toolbar to open the 
Attributes window. 

 
- If the top dialog window is empty (no features are shown), select the Edit Tool  from 

the Editor Toolbar, then click on a pool point on your map.  Notice that the 3 attributes 
that exist in the SamplePoint table are visible (OBJECTID, pointType and 
Description).   

 
- Click in the box next to pointType and type in pool.  In the 

Description field type either above or below to indicate if it is an 
above ground pool or an in ground pool.   

NOTE:  You won’t be able to use Edit>Undo Create once the changes are saved, so 
saving edits can be a trade-off.  Also, saving the entire project (which is also wise), 
does not automatically save your edits (it will, however, prompt you to save them if you 
Close the project). 

TIP:  Remember the Clear Selected Features Tool  in the Tools toolbar if 
you accidently select the wrong thing while using the Edit Tool.   
 
To begin digitizing (adding points) after using the Edit Tool, click back on the 

SamplePoint layer in the Create Features window.   

OPTIONAL: To delete more than one point at a time  
- Select multiple points with the Edit Tool  (drag a box around 

them or hold down the SHIFT key while clicking on the points)  
- Open the attribute table by right-clicking on the layer in the Table 

of Contents and choosing Open Attribute Table.   
- With the table open and active, press the Delete key or right-click 

over the row box and select Delete Selected from the menu. -All 
of the selected records will be deleted.   

- Close the table. 
 

NOTE:  You can select Edit>Undo if deleting was not your intention.  
If you try this, keep some points behind for the next step. 
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- Select another pool point with the Edit Tool  and add the attribute information.   

 
Later, when you save edits, what you add to the attributes here will be saved in the table.  
OBJECTID is light gray, meaning that it can’t be edited.   
 

 
 

- Next, select multiple pools.  Be sure that your mouse is the Edit Tool , then drag a 
box to surround multiple points that are over the roof.  
Alternatively, while your mouse is the Edit Tool, hold down 
the SHIFT key while clicking on several points.   

 
- Next, click on the layer name (the word SamplePoint) in the 

Attributes window.   
 

- To the right of the field pointType type in pool.  All of the 
selected points will now have a pointType attribute of pool.  
Clicking on the layer name means that the attribute will 
change for all selected features below it.  
 
 

 
 

TIP: It is possible to edit the attribute data for each individual point or multiple points by 
selecting just one feature or several features listed below the layer name (use CTRL-Click 
to pick more than one).  Only those selected will be updated.  For additional details on how 
to edit multiple attributes, search the ESRI help for “Applying the same attribute values 
to multiple features in a layer.” 
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- When you are satisfied with adding points, save your edits (Editor toolbar, Editor menu, 
Save Edits), then move on to the next section. 

 
 
 
 
 
 
 
 
 
 
 

 
 

Æ Digitizing Lines 

Adding line features requires thinking about the starting point, the vertices along the line, and 
closing the line feature.  In this section you will digitize the centerline of the main road and 
several driveways.  No need to be too precise - this is just to give you a feel for sketching line 
features with the ArcGIS tools.    
 

- To begin, make sure the Create Feature window is open.   
o If it was un-pinned from the right side of the ArcMap interface, you can open it 

again by clicking on the Create Feature tab on the side.  
 

o If you had the attributes window open, the Create Features tab may be at the 

bottom of that window.   
 

o If you don’t see any tabs, select the Editor menu 
on the Editor toolbar, then Editing Windows, 
Create Features.   
 

- Select SampleLine from the features list. 
 
- Select Line in the Construction Tools window and 

Straight Segment on the Editor Toolbar. 
 

 
 

- Use Pan and Zoom so that you can see the main rode in 
the image.   

 
- To create a line segment down the middle of the main 

road: 
 

o Start with a left-click at or near the beginning of the subdivision on the south 
side (bottom) of the image.  Because snapping is on and the parcel layer is 
visible, your mouse will likely snap to the parcel boundary which is fine. 

The Feature Construction Toolbar:  You will notice 
while you are editing features there may be a semi-
transparent Feature Construction Toolbar floating around 
near your cursor.  This can be annoying at first, but as 
you begin to understand the functions of the tools it will 
prove very handy.  If you are an advanced user, try some 
of the tools as you add features in this exercise. 
  
If the floating toolbar covers and area you plan to add a feature, press the TAB key to 
move it.  Or if you don’t plan to use it you can close it. 
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o Left-click a few times as you work your way 

up the center of the road, then double-left-
click when you reach the middle of the cul-
de-sac.  A line segment will be drawn down 
the middle of the road. 

 
- If you place a point in the wrong spot or by 

accident, right-click and select Delete Sketch 
and create it again.   

 
- Repeat this for several driveways.  Remember 

to use the mouse scroll for zooming and 
panning.  
 

 
 
 

 
 
Your map may look something like the image below.  In the image, the Create Features 
window is “pinned” to show how the tabs look at the bottom. 
 

 
 
 
  

TIP: While digitizing, press and hold the 
spacebar to see how this temporarily 
disables snapping.  This is useful when you 
want to be close to, but not snap to, an 
existing feature. 
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- Save your edits by clicking on the Editor heading on the Editor Toolbar and selecting 
Save Edits from the drop down menu. 

 
Now you will update the attributes for a few of the line segments (just enough to get a feel for it). 
 

- Select your road line segment or segments using the Edit tool .  Click on the 
Attributes icon  on the Editor Toolbar or the Attributes tab if it is visible. 
 

- Click on the layer named SampleLine in the Attributes 
window, and then update the lineType field by typing road 
or driveway.   

 
- Repeat for several lines.   

 
- Save your edits by clicking on the Editor menu on the 

Editor Toolbar and selecting Save Edits from the drop 
down menu. 

 
 
 
 
 
 
 

Æ Digitizing Polygons 

Polygons require thinking about the start point, the vertices, and an ending point that closes the 
polygon.  For this portion of the exercise, you will digitize house roofs as polygons. 
 

- To start, make sure the Create Features window is open, then select SamplePolygon 
from the feature list. 
 

- Zoom in to a level where you can see the roof of a house.   
 

- Select Polygon from the Construction Tools window and the 
Straight Segment button on the Editor Toolbar.  

 

 
 

- Start your polygon by left-clicking on a corner of the roof.  
 

- Work your way around the roof by left-clicking at the corners along 
the way.  Note: It is a good habit to work in a clockwise direction 
because of how the software handles geometry behind the scenes. 

 
- When you get to the last building corner just before your starting 

point, double-click.  The last segment will be tied, completing the 
polygon.   

 
- Repeat for several more houses.    

NOTE:  Notice how the attribute entries for lines apply to the entire segment from the 
starting to the ending point.  This is very useful in certain scenarios. For example, if 
you were creating a trail network and wanted to have different information about 
portions of the same trail you could break the line into multiple segments. 
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Æ Edit a Vertex 

- With your mouse as the Edit tool , double-click on a roof polygon OR click on the 
Edit Vertices button on the Editor toolbar.   

 

 
 
- The sketch geometry is revealed and is 

evident by the green squares that represent 
vertices.  The Edit Vertices toolbar will also be 
visible.   

 

Move a Vertex 
- Place your mouse over a green square (vertex) 

and notice that the mouse changes to this symbol 

.  When this symbol is visible, left-click and 
drag the vertex.  Do this for several vertices to re-
shape the roof.   

 
- The temporary sketch is visible until you Finish 

the Sketch.  Click on the Finish Sketch button on 
the Edit Vertices toolbar.  OR right-click and 
choose Finish Sketch on the menu. 
 

 

Add a Vertex 
There are several ways to add a vertex, but perhaps the easiest is to use the Edit Vertices 
toolbar.   
 

- Be sure you can see the sketch geometry (green squares of the polygon) which means 
the Edit Vertices toolbar is visible.  

- Click on the Add Vertex button.   
 

- Click anywhere on the polygon border to add a vertex.  Drag the new vertex to a new 
location. 

 
- The temporary sketch will be visible until you Finish the Sketch.  Click on the Finish 

Sketch button on the Edit Vertices toolbar.   
 

Delete a Vertex 
- Be sure you can see the sketch geometry (green squares of the polygon) which means 

the Edit Vertices toolbar is visible.  

- Click on the Delete Vertex button.   
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- Click on any vertex to delete it.  You can also drag a box which will delete all vertices 

contained.   
 

- Another way is to mouse-over a vertex until the mouse changes to this .  Right-click 
and select Delete Vertex from the menu.   

 
- The temporary sketch will be visible until you Finish the Sketch.  Click on the Finish 

Sketch button on the Edit Vertices toolbar.   
 

- On the Editor menu on the Editor toolbar, choose Stop Editing and save your edits.   
 

Advanced Editing 
This section will provide a taste of one editing tool, the Cut tool.  It will also demonstrate the 
advantage of editing when a geodatabase has been prepared with domains and sub-types.   
 
In this section, you will add the new parcels of the subdivision to the town-wide parcels layer.  
Conceptually, you will be cutting one polygon into pieces.   
 

    
 

Æ Prepare Your Map 

 
- Using List By Selection in the Table of Contents, make the 

ParcelZoning layer Selectable. 
 
- Turn OFF (uncheck) the SamplePoint, SampleLine and 

SamplePolygon layers in the Table of Contents so they are 
not visible.   

 
- Turn ON (check) the Sub_Division_sp.jpg. 
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- On the Effects toolbar that you added at the beginning, be sure Sub_Division_sp.jpg is 
selected in the drop-down menu and use the Transparency icon to change the 
transparency to about 30.   
 

 
 

Æ The Cut Polygons Tool 

 
- On the Editor menu of the Editor toolbar, choose Start Editing.   

 
- Choose to edit Parcel Zoning.   

 
- Using the Edit Tool (from the Editor toolbar), select the 

subdivision polygon.   
 

- Select the Cut Polygons tool from the Editor Toolbar.  

 
 

- Use the scroll wheel to zoom in so that you can see the 
road right-of-way polygon (which looks like a lollipop).   
 

- Left-click just below and OUTSIDE the subdvision polygon where the new road meets 
the existing cul-de-sac.  
 

- Continue clicking along the road right-of-way until you get to the corner of the cul-de-
sac. To make a perfect curved line around the feature, click on the End Point Arc 
Segment tool on the Editor toolbar. Next, click half way across the cul-de-sac. ArcMap 
will create a semi-circle path along the arc of the feature. Click again at the opposite 
corner of the cul-de-sac to complete the curve.  
 

 

 
 

- Before going on, switch back to the Straight Segment tool and continue digitizing the 
roadway using straight lines.  
 

Second click First click 

End Point Arc 
Segment Tool  
(for cul-de-sac) 

Straight 
Segment Tool 
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- When you get back to where the road meets the parcel again and double-click OUTSIDE 
of the selected polygon parcel.  Notice how the polygons flash and the new polygon has 
been “cut” out of the bigger one.   

 

 
 
- Use the Cut tool again to cut along a parcel line.  Remember to start AND end outside 

of the polygon.   
 

      
 
- Repeat a few times.   
 

You will now give attributes to the new parcels.  The zone_code attribute has been created with 
sub-types so you can pick from a pre-created list as opposed to typing.  This speeds up the 
process and reduce error.  
 

- Use the Edit Tool  on the Editor Toolbar to select the right-of-way that you first cut 
(the lollipop).   
 

- Open the Attributes window by clicking on the tab at the bottom of the Create Features 
window OR by clicking on the Attributes icon on the Editor toolbar.   
 

- In the zone_code attribute, choose Right of Way.   
 

- If this warning appears, select YES.   
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- Select one of the new parcels with the Edit Tool. 
 

- Change the zone_code to Residential.   
 

 
Isn’t it nice to have the choices ready and waiting?  
 

Save 

 
Excellent! Let’s save the edits and close the editing session.  
  

- Save your edits from the Editor toolbar by clicking Editor > Save Edits.  
 

- End your Edit Session from the Editor toolbar by clicking Editor>Stop Editing.  
 

- Save your ArcMap project. 
 

Extra Credit 

 
- Continue working on your parcel layer by using the cut tool and adding attributes.   

 
- Continue adding pools to the SamplePoint layer and roof polygons to the 

SamplePolygon layer.   
 
 
- Save your edits and end your edit session using the Editor toolbar.  

 
- Save and Close your project. 
 
 
 

 
Hurray! This concludes Exercise 5a.  
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Let’s Review! 
Congratulations on completing Exercise 5a! This exercise was designed to introduce you to 
basic desktop editing tools in ArcGIS10.  
 
You learned a number of important concepts were covered including: 
 

✓ The Editor Toolbar:  The Editor toolbar provides basic and advanced tools for 
adding and updating vector features in an ArcMap session.  

✓ Edit Sessions: During an edit session, you can create or modify vector features 
or tabular attribute information. When you want to edit, you need to start an edit 
session. When you are done editing, the edit session must be closed and save or 
discard any changes to your map features. 

✓ Digitizing Points, Lines and Polygons: Vector data can be created in ArcMap 
using the edit tools on the Editor toolbar and the Create Features window. 
Attributes can also be added using the Attributes window accessible from the 
Editor toolbar.  

✓ Cutting a polygon and using subtypes to populate an attribute.  Advanced 
editing tools can be extremely useful to change, add to or edit existing vector 
data.   
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Exercise 5b: ArcToolbox 
 
Exercise 5b is designed to introduce you to some common tools in ArcToolbox including data 
management tools and spatial analysis tools.  Often times the spatial extent of your datasets is 
either too large for your needs or your area of interest is so large that multiple datasets are 
needed to cover it.  In this exercise you will learn how to clip a dataset to the extent of another 
and generalize data with the dissolve operation. 
 
Spatial analyses allow us to go beyond asking questions about what something is or creating a 
subset of data.  With spatial overlay analyses, it becomes possible to evaluate the spatial 
relationships among features in different layers and to create new geospatial data sets based on 
relationships between and among features.  In this exercise you will use a variety of ArcToolbox 
tools to create some new datasets and perform basic spatial analyses. You will learn how to: 
 

- Open tools using the Geoprocessing menu, Search, ArcToolbox and ArcCatalog 
- Clip a dataset 
- Use the Dissolve tool 
- Create buffers 
- Use the Union overlay tool 
- Use the Union results with table functions 
- Use the Intersect overlay tool 
 

Getting Started: Opening ArcMap 
- Open ArcMap.  For detailed instructions, refer to Exercise 1a.   
- Open a New Map. 

 

Æ Save Your Map 

- On the File menu, select Save As OR click the Save icon .   
- Name the file Exercise5b and save it in the Projects folder.   
- Click Save. 

 

Exercise Overview 
In this exercise, you will use a series of tools to answer the questions: 
How much of a subdivision as a whole is covered by wetlands? 
How many parcels in the subdivision have wetlands? 
What percentage of each parcel in the subdivision is covered by wetlands?  
How many parcels are covered with more than 50% wetlands? 
How many buildings are partially or fully inside the 100 foot buffer zone? 
 
Often, GIS analyses require a number of steps to get to the desired output and answer the 
original question.  Here, you will take the following steps: 

- Clip the Marlborough soils data by the subdivision boundary. 
- Dissolve the soils so that the wetland soils all belong to one class.  In Connecticut, 

wetlands are determined solely by soil type. 
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- Export the wetland polygons to a new layer.  This is one way to get rid of the non-
wetland areas.   

- Buffer the wetlands to create and determine the 100 foot buffer zone.   
- Use the Union tool with wetlands and parcels in order to determine how much of 

each parcel is covered by wetlands.  This requires several table functions also. 
- Use the Intersect tool to determine how many buildings are partially or fully inside 

the 100 foot buffer zone.   
 

Æ Set up Your Map Document 

- Click on the Add Data button  on the Standard Toolbar. This will open the Add 
Data window. 

- Navigate to C:\GISEd10\ and double-click on the Marlbourough.gdb geodatabase.   
- While holding down the CTRL key, click on: 

▪ buildings 
▪ soils 
▪ subdiv_bndry 
▪ subdiv_parcels  

 
so that all four are selected. 

 
- Click Add.  All four data layers 

will be added to the ArcMap 
Table of Contents and will 
remain selected (highlighted in 
blue).  
 

- Click anywhere on the white 
space in the Table of Contents 
to unselect the layers.  
 

 
 

Basic Geoprocessing Tools 

Æ Using the Clip Tool  

 
 
In this step you will clip the soils dataset to the subdivision boundary. Make sure the 
subdiv_bndry layer is above the soils layer in your Table of Contents (TOC).  If necessary, 
drag subdivision_bndry to the top in the TOC.  Notice that the subdivision you will be working 
with is in the northeast (upper right) corner of the town.   

 

CLIP Tool Review:  Extract input features that 
overlay the clip features.  Use this tool to cut 
out a piece of one feature class using one or 
more features in another feature class as a 
"cookie cutter." 
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The first step in any spatial analysis is to prepare the data.  Here, we 
need to clip the townwide soils by the subdivision boundary. 
 

- Click on the Geoprocessing menu item from the Main 
Menu in ArcMap and choose Clip from the dropdown list.   
 

- Fill out the Clip box as follows:  
 

- Click and drag the soils layer from 
the ArcMap Table of Contents to the 
Input Features field in the Clip 
dialogue box. 

 
- Click on the small, black down arrow 

next under Clip Features and click 
on subdiv_bndry.  

 
- Click on the folder icon  next to 

Output Feature Class and navigate 
to C:\GISEd10\Results.  Double-
click on the CT_Results.gbd.  Name 
the output feature class 
subdiv_soils.  Click Save. 

 
- Click OK to run the Clip tool.   

 
 
 
Check the bottom bar of ArcMap to see if the tool is 
running.  Blue text will scroll letting you know that ArcMap 
is working.  Depending on the complexity of the input data and the tool, some processes take a 
long time to run.  
 
 
When the tool is finished, a notification will pop up in the corner of 
your screen.  Depending on your settings, ArcMap may also ask if 
you want the new layer added to ArcMap.  Say Yes.  

 
- You will see a new layer added to the Table of Contents called 

subdiv_soils. Right-click on the layer name and select Zoom to 
Layer. This will zoom to the full extent of the subdiv_soils layer.  
 

- To make your map easier to view, let’s change the symbology a 
bit. In the Table of Contents, change the order of your layers so 
that the layers are listed in this order from top to bottom: 
subdiv_parcels, subdiv_bndry, buildings, subdiv_soils and 
finally, soils.  

 
 

TIP: Use the tool Help if you 
unsure about a setting or if 
the tool is the right one for the 
job.    
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- Change the symbology of the parcels layer so that it has 

a hollow fill and a black thin outline. Change the 
subdivision boundary layer so that it also has a hollow 
fill with a red outline. After you make the changes your 
map should look like the image to the right. Notice how the 
new subdiv_soils layer contains soils only for the area of 
the subdivision.   

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

Æ Using the Dissolve Tool 

The next step is to use the Dissolve tool to aggregate the 
wetland soils and create a wetland map.  
 

- Right-click over subdiv_soils in the Table of 
Contents and Open Attribute Table. Scroll 
through the table and study the attribute fields. 

 
 
 
 
 
To create a layer where all wetland soils are grouped, which attribute would you use? Why? 

 
The HYDRIC field is the right choice because it only has two values: No and Yes.  Although 
CTWET may be tempting, it includes two classes for wetlands (1. Poorly drained and very 
poorly drained soils and 2. Alluvial and floodplain soils) so the output would have two wetland 
classes instead of the desired one wetland class.   
 

- Close the Attribute table.   
 

DISSOLVE Tool Review:  Aggregates 
features based on specified attributes. 

 

TIP: There are three ways to add layers to ArcToolbox tools. 
1. Drag a layer from the ArcMap Table of Contents to the field (such as Input Features below) 

in the tool dialogue box. 
2. Click on the down arrow next to the field and choose one of the available layers in your map 

document. 
3. Click the folder icon and navigate to the shapefile or feature class that is on your hard drive or 

network drive.  Use this option if the Input layer is not in your ArcMap document.   
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Æ Search for ArcToolbox Tools 

- From  the Geoprocessing Main Menu, choose Search for Tools.  Search is useful 
when you can’t remember which category and toolbox a particular tool belongs to.  
 

             
 
The search returns a list of possible tools and lots of  
associated information. 
 
 
 

 
 

 
- Take a minute to explore the search results.  

- Click on the Tools link 
(last on the list after All, 
Maps, and Data). 
 

- Type dissolve into the 

box and click to 
search.   

A brief 
description. 

The toolbox 
where it lives. A direct link 

to the tool. 

A mouseover with 
more information 
and a link to the full 
description. 

The full path 
to the tool 
including in 
the tbx. 
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Æ The Dissolve Tool Interface 

- In the Search window, click on the first 
item Dissolve (Data Management). 
 

Setup the Dissolve window as follows: 
 

- Set the Input Features to subdiv_soils. 
 
- Save the Output Feature Class in 

C:\GISEd10\Results in the 
CT_results.gdb called subdiv_hydric.   

 
- Choose HYDRIC as the Dissolve 

Field(s). You may need to expand the 
Dissolve window to see all of the tool 
settings.  

 
- Under Statistics Field(s) click the 

small black arrow and choose the 
ACREAGE attribute. 

 
- ACREAGE is added to the box below and 

a red x appears indicating that something 
more is needed. 

 
 

- Click the box to the right of ACREAGE 
and below Statistic Type and select 
SUM. See the Tip box below. 

 
- Check to Create multipart features. 
 
- Click OK to run the Dissolve tool.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

TIP: The optional Statistics Field(s) for the Dissolve tool provides the choices of which field(s) and 
statistic(s) can be summarized with a dissolve.  Text attribute fields may be summarized using FIRST 
or LAST.  Numeric attribute fields may be summarized using any statistic. 
 
FIRST - Finds the first record in the Input Features and adds its value.  
LAST - Finds the last record in the Input Features and adds its value.  
SUM - Adds the total value for the specified field.  
MEAN - Calculates the average for the specified field.  
MIN - Finds the smallest value for all records of the specified field.  
MAX - Finds the largest value for all records of the specified field.  
RANGE - Finds the range of values (MAX–MIN) for the specified field.  
STD - Finds the standard deviation on values in the specified field.  
COUNT - Finds the number of values included in statistical calculations. This counts each value 
except null values.  
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Look for the blue text indicating that ArcMap is working.  
Depending on the complexity of the input data and the tool, 
some processes take a long time to run.  

 
 

 
Look for the notification telling you that the operation is finished.  
Depending on your settings, ArcMap may also ask if you want 
the new layer added to ArcMap.  Say Yes.  
 

- Take a look at your new subdiv_hydric layer. You should notice there are two 
unique classes in the layer that represent hydric or non-hydric soils. You can change 
the layer’s symbology if you would like so you can visualize the two classes. You will 
also want to drag the new layer down below the buildings layer in the Table of 
Contents.   
 

How is the subdiv_soils layer different from the 
subdiv_hydric layer? 

 
 
We are after a layer of only wetlands. What do we have to do 
next? 

 
 

Æ Export a Subset of a Data Layer 

The next step is to remove all non-wetland soils so we are left with a layer of just 
wetlands.  The easiest way is to select all the wetland areas and export them as a 
new feature class or shapefile.   
 

- Select all wetland areas. See the review box below for methods for 
selecting features. You may find it helpful to turn off all layers except 
subdiv_hydric before making your selection.  

 

 
 
How do you know that this is a multipart layer?  What would be different if this was a single part 
layer? 

 

REVIEW: There are many ways to select. Here are a few. 

- Select tool.  
- Selection menu > Select By Attributes. 
- Attribute Table > highlight by clicking on the records (use shift or control keys) 
- Attribute Table > Select By Attributes  

TIP: Use the tool Help if you 
unsure about a setting or if 
the tool is the right one for the 
job.    



 Ex. 5b: Page 216 
 

 
 

- You should now have your hydric soils selected. In the ArcMap Table of Contents, 
right-click over subdiv_hydric, select Data and Export Data.   

- Fill out the Export Data box.  Be sure to choose Selected Features.  Save the file in 
C:\GISEd10\Results in the CT_Results.gdb called subdiv_wetlands.   

- Click OK.   
 

  
 

- Say Yes if ArcMap asks if you want to add the exported layer to your map.   
- Turn off the subdiv_hydric layer in the Table of Contents. Turn the subdiv_bndry 

layer back on so you can see the boundary of the subdivision and the wetland areas 
within it. Also, take a minute to Save your project.  

 
Your wetlands layer should look something like this.  If it doesn’t, ask an instructor for help.  
Optional: symbolize the wetlands in your map.   

 
  

REVIEW: How do you change a multipart layer to a single part layer? Or a single part layer to a 
multipart layer? 
In ArcToolbox, Data Management Tools, Features, there is a Multipart to Singlepart tool.  To 
create a multipart layer from a singlepart layer, simply run the Dissolve tool but don’t dissolve by 
anything.  Be sure Create multipart features is checked.  

TIP of CAUTION: ALWAYS evaluate the 
output of any spatial analysis.  Does it make 
sense? Is it what you expected? Did I use 
the right tool with the right inputs and 
settings?  
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ANAYSIS QUESTION: How much of the subdivision is covered by wetlands? 

 
 
SOLUTION: How much of the subdivision is covered by wetlands? 
Use the attribute table to determine the area of the single wetland polygon (because it is a 
multipart polygon).  Open the attribute table.  You may be tempted to use the 
SUM_ACREAGE field but this would be incorrect.  If you trace back the SUM_ACREAGE field, 
you will find that it was a sum of the acreage of the wetland polygons BEFORE they were 
clipped.  Remember, attributes are not recalculated or changed even if the polygons change 
(with the exception of Shape_Area and Shape_Length fields which are maintained if the data 
is in a geodatabase).  
 
Area needs to be calculated.  There are two ways to do this: 
1) Add a new float field to the table and use Calculate Geometry to calculate area in acres. 
2) Use the Shape_Area field to calculate area in acres.  Recall that the Shape_Area field is 

updated because the data is a feature class inside a geodatabase.  The Shape_Area field 
uses the unit of the projection of  the feature class – in this case, feet.  To calculate acres 
from feet, divide the area in feet by 43,560.   

 

More Advanced Geoprocessing Tools 

Æ The Buffer Tool 

In this step you will buffer the new wetlands layer to create a buffer zone around the features. 
This area will represent a wetland review area.  
 

 
 
The next step is to buffer the wetlands by 100ft to create polygons of the buffer zones.   
 

- Open ArcToolbox by clicking on the ArcToolbox icon on the Standard Toolbar. 
 

 

TIP: Use the tool Help if you 
unsure about a setting or if 
the tool is the right one for the 
job.    

BUFFER Tool Review:  Creates buffer 
polygons around input features to a specified 
distance.  An optional dissolve can be 
performed to combine overlapping buffers. 
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- Locate the Analysis Tools toolbox and click the  to expand it.  
- Locate the Proximity toolset and click the plus to expand it.   
- Double-click on Buffer to open the tool.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fill out the Buffer box as follows: 
 

- The Input Features should 
be subdiv_wetlands. 

 
- Save the Output Feature 

Class in the 
CT_Results.gdb and call it 
subdiv_zone100ft.   

 
- Use a Linear unit of 100 

Feet.   
 

Because none of our buffer areas will 
overlap, it is not necessary to set a 
dissolve type.  However, in the case 
that they did overlap, we would likely 
use dissolve.   
 

- Click OK. Your 
subdiv_some100ft buffer 
layer should look like the 
graphic below.  

REMEMBER: ArcToolbox with an ArcInfo 
license has many more tools than 
ArcToolbox with an ArcView License.   

TIP of CAUTION: ALWAYS evaluate the 
output of any spatial analysis.  Does it 
make sense? Is it what you expected? Did 
I use the right tool with the right inputs and 
settings?  
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Æ The Union Tool 

- In this step you will union the wetland areas and the parcels. First, get your layers in 
order and set symbology.  The parcel layer (subdiv_parcels) should be on top and 
should be drawn using only outlines (no fill).  The next layer should be 
subdiv_wetlands with subdiv_zone100ft under that.   

    
 

 
 

- Open ArcCatalog by clicking on the Catalog 
Window icon on the Standard Toolbar.    
 

 
 

- In ArcCatalog, scroll down and open:   
o the Toolboxes folder 
o System Toolboxes  
o Analysis Tools.tbx toolbox 
o Overlay toolset 

 
- Double-click on Union to open the tool.  

 
  

UNION Tool Review:  Computes a geometric intersection of the Input Features. All features 
will be written to the Output Feature Class.  All features will be “burned” together. 

 

TIP: Use the tool Help if 
you unsure about a setting 
or if the tool is the right 
one for the job.    
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- Add subdiv_parcels to Input Features by either dragging and dropping from the 
ArcMap TOC or selecting it from the drop-down menu.  The layer, subdiv_parcels, 
should be added to the list of 
Features that will be used in 
the Union.  
 

- Add subdiv_wetlands to Input 
Features by either dragging 
and dropping for the ArcMap 
TOC or selecting it from the 
drop-down menu. It should be 
added to the list of Features. 

 
- In the Output Feature Class, 

use the folder icon to navigate 
to C:\GISEd10\Results\ and 
double-click on 
CT_Results.gbd.  Name the 
layer 
union_parcels_wetlands. 

 
- Choose to Join ALL 

Attributes.  This means that 
attributes from both the 
subdiv_parcels layer and the 
subdiv_wetlands layer will be 
present in the newly created attribute table for union_parcels_wetlands. 

 
- Click OK.   

 
- Look for the blue ticking text indicating that ArcMap is working.  You know it is 

finished when the notification shows in the 
corner of your screen.   

 
- Take a minute to explore union_parcels_wetlands.  Use the Identify tool to explore 

how the wetland boundaries are “burned” into the parcel boundaries.   
 

Wetlands  Union with Parcels    Equals   
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ANAYSIS QUESTION: How many parcels have wetlands? 

 
 
SOLUTION: How many parcels have any wetlands? 
Open the Attribute table and select any records (parcel or parcel piece) where hydric=yes.  At 
the bottom of the table, notice how many records are selected.   
 

Æ Analyzing the Results 

Next you will use the Attribute Table of the Union results to answer questions.   
 
Which parcels have what percent covered by wetlands? 
 

- In the ArcMap TOC, right-click over union_parcels_wetlands and Open Attribute 
Table.  Notice that the table contains fields from parcels (PARCEL_ID, MAP, 
BLOCK, LOT, STREET_ADD, acres_parcel, etc.) and fields from soils (HYDRIC, 
SUM_ACREAGE, etc.).   
 

The acres_parc field contains parcel area before the union.  Now you 
need area of the parcel pieces after the union so you can create a 
percentage.   
 

- In the table, click on the Table Options menu  and 
choose Add Field.   

- Name the field union_acres and choose Float for the type. 
- Click OK to add the field. 

 

 
 

- Right-click over the new union_acres field and select 
Calculate Geometry.   

 
- If a warning pops up about calculating 

outside of an edit session, click Yes. 
 
- Choose Property: Area and Units: 

Acres US [ac]. Click OK. 
 
Now it is time to create a percentage ONLY for parts of parcels that are wetland.    
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- On the Table Options menu, choose to Add 
Field.   

- Name the field wetlandsPC with Type: Float.   
 
So that the percentage calculation is only performed on 
areas with wetlands, it is necessary to first select polygons 
where HYDRIC=Yes. 
 

- Select polygons where HYDRIC=YES.  You could 
use the Select by Attributes dialogue as 
shown.  Or you could sort the HYDRIC field 
and select the records by highlighting.   

 
- With the records selected, right-click over the 

wetlandsPC field and select Field Calculator.   
o In the Fields: box, double-click on 

union_acres. 
o Click the  / button. 
o In the Fields: box, double-click 

acres_parc. 
- Click OK.  Scroll to the selected records to see 

the updated calculations.  

 
  
 
 
 
 
 
 
 
 
 

 
ANAYSIS QUESTION: Which parcels have what percent covered by wetlands?  

 
 
SOLUTION: Which parcels have what percent covered by wetlands? 
 
Look at the wetlandsPC attribute in the table.   
 
  

Don’t bother actually writing out the answers, but can you find the answers? 
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ANAYSIS QUESTION: How many parcels have more than 50% wetlands? 

 
 
SOLUTION: How many parcels have more than 50% wetlands? 
Open the Attribute table and sort the wetlandsPC field.  Count how many records are 0.5 or 

greater.  Or, do a Select by Attributes .   
 

Æ The Intersect Tool 

 
 
How many buildings are partially or fully inside the 100 foot buffer zone?  
 

- Clear any selected features on your map. You can do this with the Clear Selection 
 tool on the Tools Toolbar.   

 
- Open the Intersect tool.  Use the 

Geoprocessing menu shortcut or 
Search for Tools on the 
Geoprocessing menu, or navigate to 
Anaysis Tools > Overlay in 
ArcToolbox or ArcCatalog.   
 

- Add buildings to the Input Features.  
It should appear on the Features list.   

 
- Add subdiv_zone100ft to the Input 

Features.  It should appear on the 
Features list.   

 
- Save the layer in the CT_Results.gdb 

called buildings_in100zone. Click OK.   
 

 

  

INTERSECT Tool Review:  Computes a geometric intersection of the input features. 
Features or portions of features which overlap in all layers and/or feature classes will be 
written to the output feature class.  

 

TIP: Use the tool Help if 
you unsure about a setting 
or if the tool is the right 
one for the job.    
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ANAYSIS QUESTION: How many buildings are in the 100 foot wetland buffer zone? 

 
 
SOLUTION: How many buildings are in the 100 foot wetland buffer zone? 
 
Open the Attribute table and determine how many records are in the table.  
 

Save Your Work!  

Æ Save Your Map Project (.mxd) 

 
Any time you make a significant change to your Map Document, you should save it. 
Unfortunately, ArcMap does not “auto save” and while it has improved greatly over previous 
releases of the software, it has been known to crash without warning. So, you’d be wise to 
follow the mantra “save early and often” when working on important projects!  
 

- To save the changes you have made, click on File on the Main Menu and select 
Save from the menu that appears.  Name it Exercise5b.mxd and be sure to save it 
in the Projects folder.    
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Let’s Review! 
Congratulations on completing Exercise 5b! This exercise was designed to introduce you to 
basic geoprocessing tools in ArcGIS.  
 
In this exercise you learned two more methods for making your datasets more manageable.  
You already know about some methods, such as Definition Queries and Layer files.  

- Dissolve: Aggregates features in a layer based on specified attributes. 
- Clip: Extracts input features that overlay the designated clip features.  Use the clip 

tool when you want to cut out a piece of one layer using one or more features in 
another layer as a “cookie cutter.”  This is useful for creating geographic subsets of 
features when your area of interest is much smaller than the extent of the source 
data. 

 
You also explored many of the spatial analysis tools that are available with the ArcView license.  
The tools can be used alone or in combination with one another to produce a wide variety of 
new datasets.  Creatively combining the results of these tools with selection sets based on 
attributes and/or locations can produce all sorts of powerful analyses.  Experiment, test out 
ideas, think about how you might string together a series of analyses to produce some results 
that are not directly available.  Remember, every time you run an analysis and produce new 
data, you can further analyze it using other tools you have learned – Statistics, Summarize, 
Select by Attribute or Location, Export data, Calculate Geometry, etc.  
 
To summarize, this exercise introduced you to the following spatial analysis functions:  
 

- Buffer: Use Buffer to create areas of interest surrounding points, line or polygons.  
The output can then be used in a Clip, a Union or an Intersect to help evaluate 
other layers of data.  A good example would be to create a buffer around a stream 
and then use it to clip land cover and assess possible land cover impacts with the 
riparian zone and their potential impacts on water quality.  
 

- Union: Use Union when you want to combine two or more polygon layers.  
Remember that it combines geographic features by calculating where polygon edges 
intersect each other and then building new polygons.  All attributes from the input 
layers are combined.  Area fields MUST be updated using the Calculate Geometry. 

 
- Intersect: Use Intersect to overlay two polygon layers and preserve only areas 

common to both.  This tool combines geographic features by calculating where 
polygon edges intersect each other and then building new polygons for the 
overlapping areas.  All attributes from the input layers are combined.  Area fields 
MUST be updated using the Calculate Geometry.  Intersect can also overlay a 
polygon layer with point or line layers. 

 
 

This concludes Exercise 5b. 
 
If you have finished and the class is still working on the exercise, move 
on to the extra credit below.  
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Extra Credit 
Be sure your Exercise5b.mxd is still open.  If not, open it. 

Pick one or more of the following: 

 

Use Tools and Spatial Analysis to Answer a Question 
 
➢ How much of the subdivision is covered by the 100ft review zone?  
Hint: Clip the review zone (subdiv_zone100ft) by the subdivision boundary (subdiv_bndry).  
Calculate area in the table.   
 
➢ How many parcels would be touched by the 100ft review zone?  
Hint: Use Select By Location.  Select Features from the subdivision parcels (subdiv_parcels) 
that intersect the review zone (subdiv_zone100ft).   
 
➢ What is another way to determine how many buildings are inside the buffer zone? Try it.  
Hint: Select By Location. 
 

Do a Spatial Join 
Pick a point layer (such as APAWELLS or buildings) and a polygon layer (such as surficial 
materials or land use).  Right-click over one of the layers in the TOC and choose Join.  In the 
Join box, under What do you want to join to this layer? choose the second choice – Join 
data from another layer based on spatial location.  Fill out the Join Data box (read the 
choices) and review the output.   
 

Make a Map 
Make a map of the impact of the 100ft review zone 
on the subdivision. Think about what layers may 
help show the impact.  Consider adding and 
symbolizing the wetland areas, the review zone area, 
buildings inside the review zone.  
 
It may be necessary to show parcels colored based 
on the percent wetland.  Here are the suggested 
steps.  Select from union_parcels_wetlands where 
hyrdric=yes or wetlandPC>0.  Export to a new file.  
Join the new file to subdiv_parcels based on the 
parcel ID attribute.  Symbolize the wetlandsPC 
field.  Because all parcels without wetlands are null, 
they will not draw in this scenario.  Copy the 
subdiv_parcels layer (right-click over it in the TOC 
and select Copy).  On the Edit menu, choose Paste.  
Drag the copy below the original subdiv_parcels.  
Although two separate copies, they will appear to be 
the same file.   
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Exercise 5b Answers 
How is the subdiv_soils layer different from the subdiv_hydric layer? 
The soils layer had many more polygons and classes.  The hydric layer contains only two types 
of soil polygons – hydric and non-hydric.   
 
We are after a layer of only wetlands. What do we have to do next? 
At this point, the soils_hydric layer contains both wetlands AND non-wetland areas.  The next 
step is to get rid of the non-wetland areas.  We suggest selecting the wetland areas and then 
exporting them as a new file.   
 
How do you know that this is a multipart layer?  What would be different if this was a single part 
layer? 
You know it is a multipart layer because there is only one record to select.  This is true whether 
you use the select tool or the table.  If this was a single part layer, there would be five or so 
records in the table and the select tool would require clicking on each polygon.   
 
ANAYSIS QUESTION: How much of the subdivision is covered by wetlands? 

 
 
ANAYSIS QUESTION: How many parcels have wetlands? 

 
 
ANAYSIS QUESTION: How many parcels have more than 50% wetlands? 
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ANAYSIS QUESTION: How many buildings are in the 100 foot wetland buffer zone? 

 
 
Extra Credit: How much of the subdivision is covered by the 100ft review zone?  

 
 
Extra Credit: How many parcels would be touched by the 100ft review zone? Select by 
Location 

 
 
Extra Credit: What is another way to determine how many buildings are inside review zone? 
Select By Location.  Right-click over one of the layers in the TOC and choose Join.  In the 
Join box, under What do you want to join to this layer? choose the second choice – Join 
data from another layer based on spatial location.  Fill out the Join Data box (read the 
choices) and review the output.   
 
This method selects the entire building.  Using intersect will cut the building in two if the 
buildings falls on the line.  Sometimes this is beneficial, sometimes not.   
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Reference Exercise 6a: Mad About Metadata 
Metadata, or data about data, is a critically important component of digital geospatial datasets.  
It helps document datasets, describe their history, quality and content and increasingly will be 
used by organizations to find datasets based on keywords and geographic coverage. 
 
ArcGIS has a number of tools to create, edit, import and use metadata which are accessed 
through ArcCatalog. 
 
In this exercise, you will use ArcCatalog to look at some examples of metadata and you’ll create 
some metadata for a USGS streamflow gages point layer.    
 

Getting Started: Metadata in ArcCatalog 
 

- Open ArcCatalog.    
 

Æ Explore Existing Metadata 

In this step you will look at several datasets with varying amounts of metadata.  Some will have 
just the basic metadata that ArcGIS creates automatically while the others will have extensive 
metadata created by the CT Department of Environmental Protection. 
 

- In ArcCatalog, expand the connection to the folder C:\GISEd10\CT_Data.gdb in the 
Catalog Tree. 

- Click on the shapefile HYDRO feature class and then click the Description tab. 
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- A data description for HYDRO will be displayed in the window beneath the 
Description tab.   
 

- Take a minute to skim through the information provided in the Summary, 
Description, Credits and Access and use limitations.  
 

 
 
- Scroll farther down the Description window. You should see two expandable 
headings, one titled ArcGIS Metadata and one titled FGDC Metadata. Expand each 
to view the contents. These are the full metadata records for the HYDRO layer.  
Click through each one. Note, if you do not see this option you can change your 
metatdata style in the Customize>ArcCatalog Options window. 
 

How are the ArcGIS Metadata and FGDC Metadata records different? 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 

 

FGDC Metadata: Federal Geographic Data Committee is 
tasked by Executive Orders to develop procedures and assist in 
the implementation of a distributed discovery mechanism for 
national digital geospatial data. They are also responsible for 
creating a content standard for metadata. A fully compliant 
FGDC metadata record must meet all of the criteria established 
in these standards.  
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Æ No Metadata? 

- In the Catalog Tree, locate the USGSGAGES feature class in the 
C:\GISEd10\CT_Data.gdb. Click on the feature class in the Catalog Tree and  view 
its description and metadata from the Description tab.  

 
Does the USGSGAGE feature class have metadata? Can you think of a scenario where it could 
be a problem that a dataset is missing metadata? 

 
 

Editing Metadata 
The metadata that ArcGIS automatically creates is valuable information that will help you make 
effective use of various geospatial datasets.  However, it is important that whenever possible 
you create complete metadata for the geospatial datasets that you create.  This is especially 
true for “core” or “framework” datasets created by or for your organization and to a lesser 
degree for derived datasets generated as part of a project.  In this step you will explore editing 
metadata for the USGSGAGES feature class. 
ArcCatalog includes several metadata style options. These determine how the metatdata is 
viewed, exported and validated and which page appears when editing metadata. When you edit 
metadata, ArcCatalog uses the metadata style that is specified in ArcCatalog Options.   
 

Æ Metadata Style Options 

- To specify a metadata style, click on the Customize drop-down menu and select 
ArcCatalog Options… 

- Click on the Metadata tab and take a minute to review the contents of the page. 
- Click on the down arrow under 

Metadata Style and view the 
options available. Make sure the 
Style is set to FGDC CSDGM 
Metadata. 

- Under Metadata Updates, make 
sure the box is checked next to 
Automatically update when 
metadata is viewed.  

- Click OK to close the 
ArcCatalog Options window.  
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Æ Editing Metadata 

- Under the Description tab, click on the Edit button.  
 

 
 

- The editor will open in the Description tab. For the purposes of this exercise, you 
will only fill out a few of the fields required for a fully compliant metadata record. If 
this was a “real world” dataset, you would want to create a complete metadata 
record.  
 

- Under Item Description, add text to the Title, Tags, Summary, Description, 
Credits and Use Limitations fields. Because this is only an exercise to show you 
how to create metadata, it doesn’t matter what you type in. Make it up, be creative, 
have fun. If you need guidance, use the text shown below.  

 
o Title: USGS Streamflow Gages 
o Tags: USGS Stream Gage, water resources, water surface elevation, 

streamflow discharge 
o Summary: This dataset shows the locations of Connecticut's USGS 

streamflow gages. The dataset is intended to show these locations and link to 
realtime streamflow information published by the USGS. 

o Description: This dataset shows the locations of Connecticut's USGS 
streamflow gages. The dataset is intended to show these locations and link to 
realtime streamflow information published by the USGS. Approximately 5,000 
of the 6,900 U.S. Geological Survey sampling stations nationwide are 
equipped with telemetry to transmit data on streamflow, temperature, and 
other parameters. 

o Credits: U.S. Geological Survey 
 
 

- Click through some of the other headings under Overview, 
Metadata and Resource. Take a minute to read through these 
and take note of some of the additional metadata topics that you 
would need to include in a fully compliant metadata record. If you 
have the time or inclination, add some additional content to the 
metadata.  
 

- When you are done, click the Save button under the Description 
heading to save your updates.  
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- OK – now you have the idea of what’s involved in creating metadata. And now you 
probably have a good idea why it’s everyone’s least favorite thing to do! 

- Once you save your metadata, you should see your changes reflected in the 
metadata for the USGSGAGE feature class. Take a minute to check out the updates.  

 
 

 
- Congratulations! You have successfully created your first metadata record!  
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Let’s Review! 
Metadata is an integral component of GIS data which includes spatial, attribute and metadata.  
It shouldn’t be something that gets created only when time permits.  Such an attitude results in 
metadata not being created and that important information ultimately gets “lost.”   
 
In the exercise you worked in ArcCatalog and: 
 

✓ Explored some examples of complete metadata produced by the Connecticut 
Department of Environmental Protection to document the DEP’s framework 
datasets. 

✓ Learned what an incomplete metadata record looked like in ArcCatalog. 
✓ Created partial metadata for the USGS feature class using the Metadata 

Editor 
 
 
 

  Exercise Answers  
How are the ArcGIS Metadata and FGDC Metadata records different? 
 
The ESRI metadata includes ArcGIS specific information such as thumbnails, geoprocessing 
history and enclosures and as a general observation is easier to read.  
 
 
Does the USGSGAGE feature class have metadata? Can you think of a scenario where it could 
be a problem that a dataset is missing metadata? 
 
No. the USGSGAGE feature class does not have any metadata. This could be a problem 
because a user doesn’t know key information about the dataset including who created it and 
when, how it was created and what standards were used and who to contact for questions.  

 
 
 
 

This concludes this Exercise. 
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Lightning Round: Getting Coordinate Data into ArcMap 
In this exercise, you will create a point layer by having ArcMap “read” X,Y coordinate locations 
directly from a text file.  For the exercise you will use a fictitious database of archaeological sites 
discovered in Marlborough. The data points are stored in a geographic coordinate system 
(degrees of longitude and latitude), similar to how a handheld GPS receiver records data. 
 
This type of data creation is particularly valuable if you have coordinate data in an electronic 
format from a GPS or an existing database.  The technique, albeit more laborious, also can be 
used to “import” data from maps, surveys, reports and files that are not in an electronic format.  
In this case, the coordinates would first have to be determined, recorded in a file or database 
and then entered into ArcMap. 
 

Getting Started: Opening ArcMap 
- Open ArcMap.  For detailed instructions, refer to Exercise 1a.   
- Open a New Map. 

 

Æ Add Data 

Click the Add Data button on the Standard Toolbar and navigate to the 
C:\GISEd10\Marlborough.gdb and add the following data layers: streets, hydro, hydroz and 
town.   
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Æ Symbolize Your Data 

If you care to, change the symbology and names for the data layers to something more 
appropriate.  

 

  Æ XY Data Formats 

ArcMap can read XY coordinate data from a variety of formats.  If you have data in a dBase® 
file you can add it as a table to ArcMap.  In ArcGIS 9.2 and higher, you can add and use 
Microsoft Excel files in their .xls format – however you cannot edit data in these files, therefore it 
may make sense to save your Excel documents as a dBase® file before working with it in 
ArcMap. Comma separated text files also can be used by ArcMap which is what you will use in 
the next step.  (Note:  Text files can use symbols other than commas as the separation 
character, search the Help Index for “delimited text files” to learn about this.) 
 

- To examine the native comma separated text file format, let’s first look at the file 
outside of ArcMap. Right-click on the Windows Start button on the toolbar in the 
bottom left-hand corner of your computer and click Explore (or Computer on newer 
operating systems).  
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- In the Explore window, 

navigate to your C: drive 
and find your 
C:\GISEd10\Tables 
folder. You should see a 
file in the folder titled 
archdata_WGS84.txt. 
Double click on it to open. 

 
 
 
 
 
 

- The file will open in Notepad. Notice that the first line the file includes four text items. 
These will become the field names when the textfile is added to ArcMap. The 
remaining lines each contain four items separated by commas. These will become 
the data values in ArcMap.  

 

  
 

- Close Notepad. If you are interested, you can also preview the text file in 
ArcCatalog. The information in the text file will be displayed on the Preview tab in an 
organized table format.  
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  Æ Add the XY Table to ArcMap 

- In ArcMap, click on the File drop-down menu and hover your mouse over Add Data. 
From the Add Data menu, select Add XY Data. 

 

 
 

- The Add XY Data window will open allowing you to enter parameters to instruct 
ArcMap where to find and how to use XY coordinates sotred in a table in the map or 
on disk.  
 

- Click the open folder button next to the field named Choose a table from the map 
or browse for another table: and navigate to C:\GISEd10\Tables.  Double click on 
the file archdata_WGS84.txt 
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- ArcMap will automatically add Long and Lat to the X and Y Fields. It is “smart” 
enough to recognized the X and Y in the field name and since these are numeric 
fields, it automatically plugs them in.  

 

 
 
The last step is to specify the coordinate system that the data are in.  These data are in 
geographic coordinates of longitude and latitude. You will have to tell ArcMap what coordinate 
system definition to assign to the dataset. The coordinate system definition for longitude, 
latitude is WGS84 (World Geodetic System, 1984).  
 

- Click the Edit… button to open the Spatial Reference Properties form and click the 
Select… button.   

- In the Spatial Reference Properties window, click the small search icon . 
- In the folder below, expand the Geographic Coordinate Systems. Scroll to the 

bottom of the list and double click on the folder next to World.  
- Finally, scroll to the end of the list of coordinate systems in the World folder and 

select WGS 1984.prj. Click Add.  
- Click OK in the Spatial Reference Properties window. 
- The Add XY Data window should look like the one below.  Click OK. 
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- After you click OK, you should see a message window pop up telling you the table 
does not have an Object-ID field. Read the message and click OK to continue.  

 

 
 

- A new layer should be added to your Table of Contents titled archdata_WGS84.txt 
Events. This is an Event Layer. Take a minute to explore it. Notice that you can turn 
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it on/off like other layers, you can view the table and you can symbolize features. 
Because the layer does not have an Object-ID field, you will not be able to select, 
query or edit the features. You must save the layer to a shapefile or feature class to 
enable these functions.  

 

  Æ Save Data Points as a Feature Class 

The point layer (called an “event” layer) that you just made is created “on-the-fly” by ArcMap.  If 
you close ArcMap without saving the map document, the text file will still exist but the layer will 
not.  Recall too that when you created this layer, there was a message that it lacked Object-IDs.  
Without Object-IDs you can’t select or query features, establish joins, etc.  You can make the 
layer permanent by saving the event layer as a shapefile. When saving the data to a shapefile, 
ArcMap will create the Object-IDs, increasing the functionality of the data. In this step, you will 
save the archdata.txt event layer as an ArcMap shapefile.  

- Right click on archdata_WGS84.txt Events, mouse over Data and select Export 
Data… 

- Save the data as Arch_sites in your C:\GISEd10\Results\CT_Results.gdb.   
- If ArcMap asks if you would like to add the layer to your 

map, select Yes.  
- Take a minute or two to explore the feature class. Notice 

that you can now create queries and selections on the 
layer (because it now has Object-IDs). You can also now 
edit the features in the layer.  
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Æ Optional: Create a Layout 

If you have a little extra time or would just like to practice your cartography skills, create a layout 
showing the archeological sites in the town of Marlborough. Use the Descrip field to label each 
point location. You can also symbolize the sites into categories based on the Descrip field. Be 
sure to include a title, scale bar, north arrow, and legend. When you are satisfied with your map 
you may print the layout or simply save it to a PDF. Refer to the Map Production Module if you 
need help remembering how to do any of these tasks. 
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Let’s Review! 
In this exercise you learned how to create a geospatial dataset from a text file containing X,Y 
coordinate locations. This technique is often used when you have coordinate data in an 
electronic format from a global positioning system or an existing database. This exercise 
covered the following:  
 

✓ How to set up a text document so that it can be “read” by ArcMap. 
✓ How to add files containing X,Y coordinate data to ArcMap using the Add XY Data 

tool.  
✓ How to save your resulting ArcMap event layer as a feature class in ArcMap. 
✓ Creating a layout to show the spatial locations of the XY events. 

 
 

 
 
 
 
 
 
 
 
 
 
 

This concludes this Exercise. 
 
If you have finished and the class is still working on the exercise, go back and try of the tasks 
you just learned on your own or go on to another exercise.  
 
Save your project in the C:\GISEd10\Projects folder. When you are done, close ArcMap by 
clicking on the red X in the top right corner of ArcMap. 
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Lightning Round: Data Driven Pages 
Data Driven Pages is new at ArcGIS10. Thy allow you to create multi-page map series from a 
single map document. This can be very helpful when you need to “mass produce” a number of 
maps that look similar.  
 

Data Driven Pages – Set Up 

Æ Prepare Your Map Document 

- Open a new, blank map.  
 

- In the new map, add the following layers to your map from your C:/GISEd10/Layers 
folder: Connecticut Roads.lyr, Connecticut Towns.lyr, and Connecticut 
Waterbodies.lyr. Make sure the roads layer is above waterbodies which is above 
towns in your Table of Contents. Be patient while your layers draw.  

 
 
You will use the Data Driven Pages toolbar to create a PDF “map book” that includes a page 
and layout for each town in the state displaying these three basemap layers. That’s 169 
maps…all from one Map Document! 
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Æ Prepare Your Layout 

- Click on the Layout View icon to launch Layout View .  
 

- Add the following elements to your map:  
o Title: “Base Map” 
o Scale Bar (units of miles) 
o North Arrow 
o Legend (include Connecticut Roads, Waterbodies) 

 
- Stretch the Data Frame so that it fills the Layout.  

 

 
 

Æ Data Driven Pages Setup 

- Click on the Data Driven Pages  tool on the Layout toolbar.  
- This will open the Data Driven Pages toolbar.  
- Click on the Data Driven Pages Setup  icon on the toolbar.  
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- The Data Driven Pages Setup window will open. Specify the following settings in 

the window. When you are done, it should look like the graphic below. 
 

o Check the box next to Enable Data Driven Pages 
o Under Index Layer, specify Layers as the Data Frame; Connecticut Towns 

as the Layer; TOWN as the Name Field, TOWN as the Sort Field and 
check the box next to Sort Ascending.  

o Leave all of the Optional Fields set to their default setting.  
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- Click OK.  

 
- It will take a minute for ArcMap to create the 

pages. Be patient.  
 
 
 
 
 
 
 
 
 

- When it is done, your Data Frame extent will change. You should be seeing the town 
of Andover centered on your map. 
 

- On the Data Driven Pages toolbar, click the Next Page   icon. You should now be 
looking at Ansonia. If you continue clicking the Next Page  icon, you will eventually 
page through all 169 Connecticut Towns, in aphabetic order.  
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Æ Dynamic Text 

- Notice how the “Base Map” title doesn’t change. Let’s fix that! Double click on the 
“Base Map” text box to open its Properties window.  
 

- In the window, replace the dynamic text tag to <dyn type=”page” 
property=”NAME”/>. You should only have to change the text within the two sets of 
quotation marks.  

 
 
 
 
 
 
 
 
 

- The text in the Title box should now be the town name. As you advance to a different 
page, the text string in the Title box should also change. Cool! 
 

- You can change the Properties for the Title text box to make it more legible on the 
page by double click on the town name and selecting Properties>Change Symbol. 
Same goes for the Legend, Scale Bar and North Arrow.  

 

 
 

Æ Generating a PDF Mapbook 

- You are ready to export your maps to PDF. Click on the File dropdown menu from 
the main menu and select Export Map.  
 

- In the Export Map window, navigate to your Results folder. Name your file  
CTBasemaps.pdf. Be sure you change the Save as type to PDF (.pdf). 
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- Click on the Pages 

Tab at the bottom of 
the window. Click the 
radio button next to All 
(169 pages) – this 
means ArcMap will 
generate one PDF with 
169 pages – that could 
take a long time! If you 
don’t want to wait, you 
can choose the 
Current option or 
Page Range option.  

 
- Click on the Advanced 

Tab at the bottom of 
the window. Select 
Export PDF Layers 
Only.  

 
- You should be ready to 

go! Click Save. 
ArcMap will begin to 
generate your PDF.  

 
 

 
 

- If you chose the All (169 pages) option, it may take several minutes for ArcMap to 
generate your Mapbook. Remember, it is essentially creating a PDF for each town. 
Be patient.  

 
 

 
-  
-  
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- When the process is 

complete, browse to 
your 
C:/GISEd10/Results 
folder from your Start 
menu. Locate your new 
CTBasemaps.pdf and 
double click on it. This 
will open the PDF in 
Adobe Reader. 

 
- Click on the Pages tab 

on the sidebar. Notice 
you can sort through all 
169 PDFs.  

 
- Also notice you have 

access to the Layers 
tab and can turn data 
layers on and off for 
each layout. 

 
 
 
 
 
 
 

The Data Driven Pages tool is a great way to mass produce PDFs for a large geographic area. 
It is particularly helpful if you wish to create a cohesive “look and feel” to the layout outputs or if 
you are looking to create a map book that includes multiple ArcGIS layouts.  
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Lightning Round: ArcGIS Online 
A useful tool for creating, editing and sharing web maps is Esri’s ArcGIS Online. It requires a 
free user account to store data and maps online. You can connect to your user account from 
ArcGIS Desktop as well. The following exercise outlines steps to introduce you to the basics of 
ArcGIS Online.  

Create a Public ArcGIS Online Account:  

- Open an Internet browser (Firefox or Chrome). Go to 
https://www.arcgis.com/home/createaccount.html and complete the form to create an 
account. It may be necessary to authorize your account before using it.  

- In an Internet browser, go to https://www.arcgis.com/home/ and click on Sign In in 
the upper right. Sign in with your new credentials.  

Create a New Map: 

- Click on MAP at the top of the web page. This will open the ArcGIS Online web map.  
- Click on the Add button (upper left) and select Search for Layers. 
- Type in “Connecticut” in the Find box. Click Go, All data layers tagged with 

Connecticut in their keywords (tags) or description will appear in the window below. 
Click on the word ADD next to a layer to add it to your map. When done, click on 
DONE ADDING LAYERS.  

Add a Layer From File: 

- Click on the Add button again. This time select Add Layer from File.  
- Browse to your C:/GISEd10/Tables folder and click on archdata_WGS84 text file. 

Select Import Layer. The text file will be added to your map (ArcGIS Online will 
recognize the lat/long values in the table and place the points on the map).  

Change Symbology: 

- The Change Style side window will automatically open when you import your data.  
- Click on the down arrow next to the number 1 and select the Descrip attribute to 

show. Under step 2, use the Options under Types (unique symbols) to change the 
symbol, color and size used to represent the points on your map. Click Done when 
you are finished changing the symbols.  

Customize Pop-Up Windows: 

- Click on a point on the map. Notice the pop up information window. This can be 
customized to include additional text and photographs.  

- Click on the down arrow next to arch data layer name. Select Configure Pop up 
Window. 

- There are several settings that can be configured within the pop up window. You can 
add a title, display a list of attributes or create a custom display, and add media such 
as a photograph or chart. Explore these settings. Click Save Pop-up to exit.  

  

https://www.arcgis.com/home/createaccount.html
https://www.arcgis.com/home/
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Using the ArcGIS Online Map Viewer: 

- Click on waypoints to view field information.  
- Use the Measure tool to measure distance and area in various units.  
- Change the basemap (imagery, topo maps, street maps, etc) 
- Add data from various sources (search for data, upload data, create map notes) 

Save and Share Your Map: 

- Click Save at the top of the map. Provide a Title, Tags and short Summary. Click 
Save map. The map will be stored in your user profile. You can view and open your 
maps from the My Content section of ArcGIS Online.  

- Click Share. Check box next to Everyone (public). You can now link to the map using 
the URL provided in the “Link to this map” window. Send it to a friend, post to social 
media. Have fun. Notice you can also embed the map in a website using HTML or 
create a web application on ArcGIS Online. This option will create a template around 
the web map to make sharing and displaying your data easy and fun.  
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Lightning Round: Converting to Google KML 
Just about everyone has spent a little (maybe a lot!) of time playing with Google Earth or Google 
Maps. Did you know you can convert GIS data into Google data? Google’s mapping programs, 
along with many other web and 3D earth viewers, use a data format called KML (stands for 
Keyhole Markup Language). KML is an XML-based format for storing geographic data and 
associated content. KML files have either a .kml extension, or a .kmz extension for compressed 
KML files. Review the lightning talk slides or Google, “What is KML” for a review of this. The 
steps below show you how to convert shapefiles to KML using ArcToolbox.  
 

The To KML Tool  

- Start ArcMap. 
- Add a shapefile or feature class to 

your map.  
- Symbolize features.  

 
- Click the Geoprocessing tab, and click 

ArcToolbox to open the ArcToolbox 
window.  
 
 

- Expand Conversion Tools. 
- Expand To KML.  
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- To open the conversion tool window, double-click Layer To KML for an individual 
shapefile, or double-click Map To KML for compressed KML files. 
 

- Under the Layer drop-down box, select the desired shapefile, or drag and drop the 
desired shapefile into the box.  

 

 

- Specify the location to store the KML file. 
- Click OK.  

View KML in Google Earth  

- If you do not have Google Earth 
installed on your computer, 
download the latest version at 
https://www.google.com/earth/.  
 

- Install the program. 
 

- Open Google Earth. From the drop 
down menu at the top, select File > 
Open.  

 
- Browse to the location where you 

stored your KML file output. Select 
and open it.  

  

https://www.google.com/earth/
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Behold! GIS Data in Google Earth! 
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Lightning Round: Georeferencing 
 
Georeferencing is the process of assigning coordinates from a known reference system, such 
as latitude/longitude, UTM, or State Plane, to a raster (image) or a planar map. Georeferencing 
raster data allows it to be viewed, queried, and analyzed with other geographic data. 
 
This exercise provides you with two commonly used georeferencing tasks.  The first is to 
georeference a scanned subdivision map so that it fits inside an existing parcel.  The new parcel 
lines could then be digitized and added to the town’s parcel data.  The second task is to 
georeference an aerial image so that it can overlay with other vector and raster data.   
 
The general steps to georeferencing are: 
• Step 1: Add Data 
• Step 2: Roughly line-up the datasets 
• Step 3: Add Ground Control Points 
• Step 4: Evaluation 
• Step 5: Iterations 
• Step 6: Acceptance 

Getting Started 
- Open ArcMap. 
- Open a New Map. 
- Save the map in the Results folder called Georef.mxd.   

Open the Georeferencing Toolbar 
- On the Customize menu, choose Toolbars and click 

on Georeferencing so that it is checked.  The 
Georeferencing toolbar should open.  Dock it if you 
wish. 

 

 
 
READ THIS! Choose your own adventure: 
You have two options in this exercise.  The first option is to georeference a scanned 
subdivion map to match a parcel layer. The second option is to georeference an aerial 
image to match another aerial image.   
 
First option: Keep going to Option 1: Georeference a Scanned Subdivision Map, skip the 
Option 2 section and proceed to Evaluate Ground Control Points.   
Second option: skip the Option 1 section below, and go right to Option 2: Georeference an 
Aerial Image.   
  



 

 Georeferencing – Page 260 
 

Option 1: Georeference a Scanned Subdivision Map to Match a Parcel Layer 

Step1: Add Layers to ArcMap 

- Add the following layers to your ArcMap document: 
▪ C:\GISEd10\Layers\Marl Parcels.lyr 
▪ C:\GISEd10\Images\Sub_DivPlan.jpg 

 
An Unknown Spatial Reference box may open when you add the Sub_DivPlan.jpg.  This 
should not be a surprise as the point of the exercise is to give this image spatial reference! 
 
Explore the Layers 
Be sure all three layers in your map document are turned on (box is checked).   

- Right-click over Parcels and select Zoom to Layer.  The parcels for Marlborough 
should look familiar. 

- Right-click over Sub_DivPlan.jpg and choose Zoom to Layer.  This is a proposed 
subdivision of a parcel in Marlborough.  It 
was scanned and needs to be georeferenced 
so that the new parcel boundaries can be 
added to the town parcel layer.  

- Click on the view Full Extent icon .    
 

Why does it make the Marlborough parcels so small? 
Can you find the scanned image?  
 
 

 
 
ANSWER: The Sub_DivPlan.jpg doesn’t have 
coordinate information so the GIS doesn’t know where to 
put it.  Now you will give the aerial coordinate information so it will line up.   

Step 2: Rough Line Up – Fit to Display 

- Turn on the Georeferencing Toolbar if you haven’t already.  
- On the Georeferencing toolbar, BE SURE that Sub_DivPlan.jpg is listed as the 

Layer.  BE EXTRA sure that the Parcels layer is NOT listed as the Layer.  This is 
very important because you will be moving the Sub_DivPlan.jpg and you do NOT 
want to move the Parcels layer as it is your reference.   
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- In the Table of Contents, right-click over 

Sub_DivPlan.jpg and choose Zoom to Layer. 
- Look closely at the subdivision and make mental notes 

about its size and shape. 
- In the Table of Contents, right-click over Parcels and 

choose Zoom to Layer.   
- Open the Attribute Table for Parcels and locate the 

parcel with Parcel ID 9/27/5-7 and DEED_ID 120 526.  
Notice how, when rotated, the subdivision will fit inside 
this parcel.   

- Zoom in on the parcel so that it nearly fills the map display.   
 

  
 

- On the Georeferencing toolbar on the 
Georeferencing menu, choose Fit to Display.  
This moves the Sub_DivPlan.jpg (because it is 
the designated Layer on the Georefencing toolbar) 
to the display extent.   
 

- Three tools on the Georeferencing toolbar are 
helpful when roughly lining up Sub_DivPlan.jpg 
with the parcels.  These tools work on the layer 
that is listed on the georeferencing toolbar (in this 
case, Sub_DivPlan.jpg image).  They are: 

▪ Rotate – interactively rotate the dataset 
▪ Shift  - interactively drag the dataset (similar to the pan tool) 
▪ Scale – rescales (zooms in or out) the dataset.  After selecting the scale tool, 

hold the mouse and move it down (towards you) to zoom out and move it up 
(away from you) to zoom in.   
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- Use these tools, in combination, to roughly match 
the scanned subdivision plan with the parcel.  A 
typical workflow would be to first rotate the 
image, then shift it into place, then use the scale 
tool to get it to be about the right size. 

 
Notice that the datasets are much closer than they were, but 
do not perfectly match.  If necessary, repeat the zoom and 
Fit to Display steps to get the images close.  They will not 
be exact – that is what the next step is for. 

Step 3: Add Ground Control Points 

Control points “tie” the to-be-referenced data (the scanned subdivision) to the already-
referenced data (the Parcels layer).  It is important that you use multiple points and that they are 
spread across the image.  Start with the corners and then do a few in the middle of the image.   
 

- Zoom far in to the bottom right corner of the subdivision.   

- Click on the Add Control Points icon  on the Geoereferencing toolbar.  Notice 
that your mouse changes to a + sign.   

- Add a Control Point: 
▪ Click on the corner of the subdivision as shown on the source (to be 

referenced, or scanned subdivision).  A green + is drawn and a line is now 
connected to your mouse.  You can still use your zoom tools and turn on and 
off layers in the Table of Contents.   

▪ Locate the same corner of the parcel on the target (Parcel layer).  Click on 
the corner.  A red + is drawn and that control point is complete. 
 

    
 

- Add another Control Point, this time in the opposite corner of the subdivision.   
▪ Zoom out and find an opposite corner.   

▪ Click on the Add Control Points icon . 
▪ Click on your desired location on the source (scanned subdivision).  A green 

+ is shown. 
▪ Click the same location on the target (Parcels).  A red + is shown. 
▪ You now have two control points.   
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- Continue the process until you have at least seven points and they are spread 
across the subdivision.  Ideally, the points should be in all corners and the center.  In 
this case, the center is difficult (okay, impossible).  As you add points, the line 
connecting the two points will get longer.  This occurs as ArcMap uses the Control 
Points to guess how the image should be transformed 
so it best lines up.   

 

 
 
Skip the next section, Option 2, and proceed to Evaluate 
Ground Control Points.  

TIP: Use the ESC button to get out of a point if you 
clicked by accident or in the wrong spot.    
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Option 2: Georeference an Aerial Image 

Step 1: Add Layers to ArcMap 

- Add the following layers to your ArcMap document: 
- C:\GISEd10\Layers\Connecticut Towns.lyr 
- C:\GISEd10\Images\CT2012_georef.sid 
- C:\GISEd10\Images\CRCOG_RawImage.tif 

 
An Unknown Spatial Reference box may open when you 
add the CRCOG_Rawimage.tif.  This should not be a 
surprise as the point of the exercise is to give this image 
spatial reference! 
 

- Change the symbology of Connecticut Towns so that it has a hollow fill.   
 

 
 
Explore the Images 
Be sure all three layers in your map document are turned on (box is checked).   

- Right-click over CT2012_georef.sid and select Zoom to Layer.   
- Use the Identify tool or Zoom Out to determine which town in Connecticut the 

image is showing.   
- Right-click over CRCOG_RawImage.tif and choose Zoom to Layer.    
- Click on the view Full Extent icon .   
 

Why didn’t the CRCOG_RawImage.tif belong to a town? Why does the Full Extent View look 
odd? 

 
 
ANSWER: The CRCOG_RawImage.tif doesn’t have coordinate information so the GIS doesn’t 
know where to put it so that it will overlay with the other layers in the map.  Now you will give the 
aerial coordinate information so it will line up.   

Step 2: Rough Line Up – Fit to Display 

- Turn on the Georeferencing Toolbar if you haven’t already. 

What is CRCOG? 
CRCOG is the Capital Region Council of Governments that represents 30 municipalities in 
the greater Hartford Area.  CRCOG received a grant from the Office of Policy and Management 
to purchase high resolution imagery.  It is leaf off, 0.25 feet pixel resolution and is fantastic.  
Follow the link to CT ECO for more information about the CRCOG imagery.  
https://cteco.uconn.edu/guides/Ortho_2009_Color_CRCOG.htm 
 
What is NAIP? 
NAIP is the National Agriculture Imagery Program which is administered by the USDA's 
Farm Service Agency (FSA).  It is summer, leaf on, 4 color bands (includes Near-IR), with 
3.39ft pixel resolution.  It covers all of Connecticut and is collected every two years so imagery 
from 2008 and 2010 is also available for Connecticut.   
https://cteco.uconn.edu/guides/Ortho_2012_Color_NAIP.htm 
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- On the georeferencing toolbar, BE SURE that CRCOG_RawImage.tif is listed as the 
Layer.  BE EXTRA sure that CT2012_georef.sid is NOT listed as the Layer.  This 
is very important because you will be moving the CRCOG_RawImage.tif and you do 
NOT want to move the CT2012_georef.sid as it is your reference.   
 

 
 

- In the Table of Contents, right-click over 
CRCOG_RawImage.tif and choose Zoom to 
Layer. 

- Look closely at the image and make mental 
notes about what is covered by this image and 
what is in the corners.  Notice some of the 
parking lot in the upper left and a portion of a 
building in the lower right. 

 
- Now, in the Table of Contents, right-click over 

CT2012_georef.sid and choose 
Zoom to Layer.   

- Use your zoom tools to zoom in so 
that your map display window in 
ArcMap is showing a similar extent 
to that covered by the CRCOG 
image.  
 

- On the Georeferencing toolbar on 
the Georeferencing menu, choose 
Fit to Display.  This moves the 
CRCOG image (because it is the 
designated Layer on the 
Georeferencing toolbar) to the 
display extent.   

- Three tools on the Georeferencing 
toolbar are helpful when roughly lining up the datasets.  These tools work on the 
layer that is listed on the georeferencing toolbar (in this case, the CRCOG image).  
They are: 

▪ Rotate – interactively rotate the dataset 
▪ Shift  - interactively drag the dataset (similar to the pan tool) 
▪ Scale – rescales (zooms in or out) the dataset 

 

 
 

- Make the CRCOG image semi-transparent so you can see through it.  To do so, turn 

on the Effects toolbar and Adjust Transparency using the icon .  
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Notice that the images are much closer than they were, but do not perfectly overlap.  If 
necessary, repeat the zoom and Fit to Display steps to get the images close.  They will not be 
exact – that is what the next step is for. 

Step 3: Add Ground Control Points 

Control points “tie” the to-be-referenced image (the CRCOG) to the already-referenced image 
(NAIP).  It is important that you use multiple points and that they are spread across the image.  
Start with the corners and then do a few in the middle of the image.   
 

- Zoom far in to the building in the bottom right of the image.   

- Click on the Add Control Points icon  on the Geoereferencing toolbar.  Notice 
that your mouse changes to a + sign.   

- Add a Control Point: 
▪ Click on the corner of the building as shown on the source (to be referenced, 

or CRCOG image).  A green + is drawn and a line is now connected to your 
mouse.  You can still use your zoom tools and turn on and off layers in the 
Table of Contents.  You may want to turn off the CRCOG image (uncheck it) 
so you can see the NAIP.   

▪ Locate the same corner of the building on the target (NAIP).  Click on the 
corner.  A red + is drawn and that control point is complete. 
 

    
 

- Add another Control Point, this time in the opposite corner of the CRCOG image.   
▪ Zoom out to find the opposite corner.  Find a location that you can clearly see 

on both images.  This could be the corner of the parking lot.   

▪ Click on the Add Control Points icon . 
▪ Click on your desired location on the source (CRCOG image).  A green + is 

shown. 
▪ Click the same location on the target (NAIP) image.  A red + is shown. 
▪ You now have two control points.   

 

      
 

- Continue the process until you have at least seven points 
and they are spread across the image (in all corners and 
the center).  As you add points, the line connecting the 
two points will get longer.  This occurs as ArcMap uses 
the Control Points to guess how the image should be 
transformed so it best lines up.   
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Step 4: Evaluate Ground Control Points 

- Open the Link Table by clicking on the View Link Table icon .  The Link Table 
lists all of your points (called links).  If you have 6 or more points, you can choose 
between 1st order polynomial and 2nd order polynomial in the Transformation 
dropdown menu.   
 

 
 
Select 2nd order polynomial and view the image.  Do you think this is a better fit? Keep reading.   
 

 
 
The residual error, or Root Mean Square (RMS) error is also a measure of the accuracy of the 
transformation.  See the box below for an explanation of RMS error.   
 
On the image, the length of the line between the first + (the to-be-referenced target) and second 
+ (the already referenced source) for each point correlates with the size of the RMS error.  For 
example, if the point has a low RMS error, both crosses will be in nearly the same location.   

TIP: Use the ESC button to 
get out of a point if you 
clicked by accident or in the 
wrong spot.    

1st Order vs. 2nd Order Transformations 
- In general, use a first-order transformation if your raster dataset needs to be stretched, 

scaled, and rotated.  
- Use a second- or third-order transformation if the raster dataset must be bent or curved.  
- The higher the transformation order, the more complex the distortion that can be corrected.  

Higher-order transformations require more links and thus will involve progressively more 
processing time. 
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The same points on the map are listed in the table.  To determine which is which, click on the 
link in the table.  The line connecting the two crosses on the map will be highlighted with a 
yellow line.   
 

 

Step 5: Iterations 

- If any of the links in the table have an exceptionally high RMS error compared to the 
others, take a look at the point in the map.  Did you make a mistake when adding the 
point? To remove the point, highlight it in the Links table and hit the Delete key on 
the keyboard.  You may want to add at least one more new point.   

 

 
 

- Continue tweaking the points and their locations until you are satisfied with the 
residual error for each point and the total RMS error. 

- Click OK to close the Link Table. 

Step 6: Acceptance  

Save the Georeferencing Information 

Once you are satisfied with the registration, click Update Georeferencing on the 
Georeferencing toolbar to save the transformation information with the raster dataset.  For most 
rasters, the georeferencing information is stored in a separate file with the same name as the 
raster but with an .aux file extension.  

Rectify the Raster Image 

You can permanently transform your raster dataset after georeferencing it by using the Rectify 
command on the Georeferencing toolbar.  Rectify creates a new raster dataset that is 
georeferenced to map coordinates.  You can save this in GRID, TIFF, or IMAGINE format.  
ArcMap doesn’t require you to rectify your raster dataset to display it with other spatial data in 
ArcMap.  You might choose to rectify your raster dataset if you plan to perform analysis with it or 
want to use it with another software package that doesn’t recognize the external georeferencing 
information created by ArcMap. 

Root Mean Square (RMS) Error 
The degree to which the transformation can accurately map all control points can be measured 
mathematically by comparing the actual location of the map coordinate to the transformed 
position in the raster. The distance between these two points is known as the residual error.  
The total error is computed by taking the root mean square (RMS) sum of all the residuals to 
compute the RMS error.  This value describes how consistent the transformation is between 
the different control points (links). Links can be removed if the error is particularly large, and 
more points can be added.  

IMPORTANT: A high RMS error does not necessarily mean a point is bad.  It is common for 
one part of an image to have more distortion than other areas.  That point may be accounting 
for this and the end result will be far better WITH the point than without.  If a point has a high 
RMS error, carefully review the location and its quality.  If it is a reliable spot and is the best 
you can do, keep it. 
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Congratulations! You have completed ALL of the 
Introduction to GIS Exercises. You may now put on your 

super hero cape! 
 
 

  


